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Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 
 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 
When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 
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Review Patch Documentation 
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example, 13.3) or a later patch release (for example, 13.3.2). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
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 It is used to display examples of code 
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1 
Fixture Studio Components 

Overview of Components 
The Fixture Studio Window has a number of parts. 

 

The Menu Bar gives access to a number of pull down menus. 

The Toolbar allows the selection of a number of options relative to fixture and gondola 
creation. 

The Block Browser has a hierarchical tree of fixtures or gondolas depending on which 
tab is selected. 

The Preview Window in the Object Browser gives a simplified image of the selected 
object. 

The Status Bar at the bottom of the screen gives information on the number objects 
selected, status of current action, and so on. 

The Gondola Definitions Window contains a list of all gondolas held in the central 
database. 

The Block Definitions Window contains a list of all blocks (fixtures, fittings, and so on) 
held in the central database. 
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Fixture Studio Components 

Note: Whether blocks are automatically loaded into Fixture 
Studio depends in setting in the Options dialog box (View 
menu). If blocks are not set to automatically load, they must 
be imported using the Read Blocks option on the File menu. 
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2 
General Menu Options 

Overview of Menu Bar 
The Menu Bar contains five options. 

 

The File Pull down menu allows blocks to be read and saved. It also allows blocks to be 
loaded to and saved from the drawing. Finally, it allows the blocks themselves to be 
subjected to operations such as normalizing or producing 3DS files. 

The Edit pull down menu allows block definitions to added, edited and deleted. 
The View pull down menu allows the way block definitions display in Fixture Studio to 
be defined. 

The Window pull down menu allows the user to specify the way the various windows 
and dialogue boxes display in Fixture Studio. 

The Help pull down menu calls this Help Module and also allows the user to see system 
information for the computer the software is running on. 

Window Pull Down Menu 
The Window Pull Down Menu has two groups of options. 

 

The first set of options arranges the active windows within Fixture Studio. 
Cascade arranges them so they are stacked sequentially across the diagonal of the screen. 

 

Tile Horizontal arranges then so they all share the available space horizontally. 
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Tile Vertical arranges then so they all share the available space vertically. 

 

The second set of options allows switching between those windows. Clicking on either 
Gondola Definitions or Block Definitions will cause that window to become active 
within Fixture Studio. 

Help Pull Down Menu 
The Help Pull Down Menu has two options. 

 

Clicking on Fixture Studio Help (or pressing the F1 function key) will call this help 
module. 

Clicking on About Fixture Studio will bring up a dialogue box with information on the 
version of Fixture Studio the user has. 

 
 
 
 

4 



 

3 
File Menu 

Overview of File Pull Down Menu 
The File Menu has varying options concerned with reading and saving blocks, AutoCAD 
operations and connection to AutoCAD. 

 

Note: The Load Blocks into Drawing, Load Blocks From 
Disc, Laying Out Blocks, Normalize Blocks, Create 3DS Files 
and Redefine blocks from disc will be greyed out unless the 
Connect to AutoCAD option has been checked. 

Read Blocks reads the details of all blocks from the central Macro Space Planning 
database or the drawing into Fixture studio. 

Save Blocks saves the details of all blocks back to the central Macro Space Management 
Planning from Fixture studio. 

Save Gondolas saves the details of any newly created gondolas back to the central Macro 
Space Planning database from Fixture studio. 
Load Blocks into Drawing, Load Blocks From Disc, Laying Out Blocks, Normalize blocks, 
 Create 3DS Files and Redefine blocks from disc are discussed in more detail here 

Block Factory is a wizard intended to assist in block creation. Clicking on Block Factory 
will bring up the Block Factory dialogue box. 
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Configure brings up the Configuration Module. This can be used to change fundamental 
settings in Macro Space Management. 

 

Connect to AutoCAD opens the AutoCAD environment (if not already open) and 
enables a number of block editing commands that cannot otherwise be used. 

Reading Blocks 
Information on blocks is held within the central Macro Space Planning database. When 
Fixture Studio is started, the information is loaded into local memory. This can be done 
in one of two ways: 

1. Automatically by setting the 'Load Blocks Automatically on Start' option from the 
Options dialog box accessed from the View Menu. 

2. Manually by means of the Read Blocks option on the File menu. 

Once the information is loaded into local memory, all changes and edits are saved into 
that local memory. The updated information is only written back to the database when 
the Save Blocks option is selected from the file menu. 

Note: Gondola information is read into Fixture Studio on 
start-up. Again, it is held in local memory and is only 
written back to the central Macro Space Planning database 
when the Save Gondolas option is invoked from the file 
menu. 

Reading Blocks 
Blocks are read from the database, from the drawing or both. The options are invoked 
from the File menu. To have the option of reading in blocks from the drawing (or 
merging results) the Connect to AutoCAD option must also have been selected. 
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Read Blocks Option 
On selecting this option the user has two check boxes: 'Clear existing Block definitions' 
and 'Overwrite Existing Block definitions. 

 

1. Clear existing Block definitions 

If checked, this option deletes all information currently held in local memory and 
refreshes it with that held in the central Macro Space Planning database. 

2. Overwrite existing Block definitions 

This check box is only available if the 'clear existing Block definition' check box is not 
selected. On selecting 'Overwrite existing Block definitions', the Apply Data filters 
check box also becomes available. If checked, the button to the right can be used to 
bring up the Copy Options dialog box. Options checked within this dialog box will 
result in data from the central Macro Space Planning database overwriting what is 
held in local memory when the OK button is clicked in the Read Block Definitions 
dialog box. 

Note: If neither check box is checked, data held in local 
memory will be overwritten without any filtering. 
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Drawing Option 

Note: The usual purpose of reading in from the drawing is 
to bring in blocks from an earlier version of the application. 
It is normally used by expert users. 

This option is only available if the Connect to AutoCAD option has been selected from 
the File menu. On selecting the Drawing option the user has two check boxes: 'Clear 
existing Block definitions' and 'Overwrite Existing Block definitions. 

 

1. Clear existing Block definitions 

If checked, this option deletes all information currently held in local memory and 
refreshes it with a list of the blocks in the drawing. 

2. Overwrite existing Block definitions 

This check box is only available if the 'clear existing Block definition' check box is not 
selected. On selecting 'Overwrite existing Block definitions', the Apply Data filters 
check box also becomes available. If checked, the button to the right can be used to 
bring up the Copy Options dialog box. Options checked within this dialog box will 
result information read from the list of blocks in the drawing overwriting what is 
held in local memory when the OK button is clicked in the Read Block Definitions 
dialog box. 

Merge Option 
The merge option is a combination of reading from the database and reading from the 
drawing. It is only available if the Connect to AutoCAD option has been selected from 
the File menu. 
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If Merge is selected, the blocks in the currently selected drawing will be compared to 
those held in local memory. Data from any blocks in the drawing but not in the database 
will be read into local memory. If blocks in the drawing are also in local memory and 
they contain information different to local memory, some of this information (typically 
size data, block description [not block name] and connection point information) will be 
read into Fixture Studio and overwrite the information in local memory. 

Note: The Load Blocks into Drawing is not currently 
functional. 

Saving Blocks 
Information on blocks is held within the central Macro Space Planning database. When 
Fixture Studio is started, the information is loaded into local memory. When data has 
been added, changed, or deleted, that data needs to be written back to the central Macro 
Space Planning database to be made permanent. 
This is done by selecting the Save Blocks option on the File menu. 

Note: Gondola information is read into Fixture Studio on 
start-up. Again, it is held in local memory and is only 
written back to the central Macro Space Planning database 
when the Save Gondolas option is invoked from the file 
menu. 

Saving Blocks 
Block information can be saved to the database, to the drawing or both. The options are 
invoked from the File menu. To have the option of saving block information to the 
currently active drawing (and variation of the block held in the directory specified in the 
configuration module) the Connect to AutoCAD option must also have been selected. 
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Before saving any blocks, it is helpful to understand how the process works. 

It is important to understand how this process works. (The example below is for when 
Fixture Studio is connected to an active drawing in Planner). 
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On clicking OK in the Save Block Definitions dialog box, the following actions take place. 

1. The information held in local memory is permanently written to the database. 

2. XData (MSM specific data) is written to the instance of the block in the currently 
active drawing. (An instance of every block being saved must be in the currently 
active drawing). 

3. A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

Note: If Fixture Studio is not connected to Planner, the 
fixture in the active drawing will not have its XData 
updated, nor will a copy of the block be written to the 
directory specified in the Category tab of the block Details 
dialog box. 

Save Blocks - Not Connected to Planner Drawing 

 
If Fixture Studio is not connected to the Planner drawing, the options to write to the 
drawing and write block files will be grayed out and unavailable. It will only be possible 
to save the current version of the local data held in Fixture Studio to the database. The 
available options are: 

1. Add New Definitions: This option writes back all new block definitions in the locally 
stored data that are not presently held that in the database. 

2. Enforce Save: This option will write back information from any blocks that have been 
changed but not selected for saving if the 'Only Save Selected Blocks' option has been 
selected. 

3. Only Save Selected Blocks: This option will only save blocks that have been 
highlighted. It allows a subset of data to be saved back; not the entire contents of 
Fixture Studio. 

4. Update Database with Drawing: this option is not currently functional 
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Save Blocks - Connected to Planner Drawing 

 
If Fixture Studio is connected to the Planner drawing, the options to write to the drawing 
and write block files will be available. The additional options are: 

1. Database: Data held locally in Fixture Studio will be written back to the database. 

2. Drawing: XData will be written to the block in the drawing as a minimum. 

3. Write Block Files: A copy of the block in the drawing (including XData) will be 
written to the directory specified in the Category tab of the Block Details dialog box. 

Note: The block written to the specified directory is the 
'definition' block. Instances of this block are then placed in 
floor plans - it is the 'template' for all blocks being placed by 
store planners. 

Deleting Blocks 
Deleting blocks from Fixture Studio takes place in multiple stages. 

Marking blocks for deletion within Fixture Studio 
Blocks are marked for deletion in Fixture Studio by highlighting the block then using the 
Delete option on the right click menu. 
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The block name will then be grayed out in the Fixture hierarchy and the icon will turn 
black in the Block details list. 

 

Marking blocks for deletion in the Database 
At present the block has a delete flag set against it in the information held locally within 
Fixture Studio. The next stage is to write that information back to the central Macro Space 
Planning database so the delete flag is set there as well. This is done by highlighting the 
entry in the Fixture Hierarchy and then using the Save Block definitions dialog box from 
the File menu. 

 

The Destination should be set to Database and the Enforce Save/Only Save Selected 
blocks options check. On clicking OK, the delete flag will be written to the database. 

Permanently Deleting the blocks in the Administration Module 
The blocks can be permanently deleted from the database by selecting the Purge option 
from the Tools menu in the Admin module. 
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If there are problems, an error message will result. 

 

Typical reasons preventing blocks from being deleted include: 

 Fixtures present in floor plan (blocks cannot be deleted from the database if 
instances still exist in other tables in the database). 

 Fixture information may be present in other tables in the database, causing 
referential integrity problems. 

AutoCAD Operations from Fixture Studio 

Connecting to AutoCAD 
Before the AutoCAD functionality can be used from within Fixture Studio, users must 
first connect to the Planner module. Until this is done, the AutoCAD options on the file 
menu will remain grayed out and unavailable. 

 

The Connect to AutoCAD option on the File Pull down Menu must be selected. If the 
AutoCAD environment is not open, AutoCAD will be activated. If it is open, Fixture 
Studio will link to AutoCAD. When fixture Studio has connected to Planner, the 
AutoCAD based options will change from being grayed out to available and the Connect 
to AutoCAD option will have a tick by it. 
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Load Blocks Into Drawing 
The Load Blocks into Drawing command is used to take copies of the DWG files from 
the Macro Space Planning directories currently specified in Fixture Studio and transfer 
them to the currently active drawing in AutoCAD. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are three stages to this. 

 Select the required blocks in Fixture Studio 
 Select the Load Blocks into Drawing option 

 Select the Insert option in AutoCAD 

Selecting the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 
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Using the Load Blocks into Drawing option 
Using the Load Blocks into Drawing will load the block definitions into the AutoCAD 
drawing. They will be loaded to the AutoCAD database associated with drawing and 
will not become visible until the insert command is used to put instances into the visible 
part of the drawing. 

 

Using the Insert Option 
The Insert option can be invoked by typing INSERT into the command line. 
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This will bring up the Insert dialogue box. 

 

Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing. 

Load Blocks From Disc 
Load Blocks from Disc enables the user to select blocks from a source outside of the 
Macro Space Management database and load them into the currently active AutoCAD 
drawing. (This is in contrast to the Load Blocks into Drawing option which selects copies 
of the DWG files from the Macro Space Planning directories currently specified in Fixture 
Studio). 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are two stages to this. 

 Select the Load Blocks from Disk option 

 Select the Insert option in AutoCAD 

Using the Load Blocks From Disc option 
Using the Load Blocks from Disc option will transfer the block definitions into the 
AutoCAD drawing. They will not become visible until instances have been placed in the 
drawing. 
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This will bring up Select blocks to Load dialogue box. Navigate to the required directory 
and highlight the required blocks. Click on Open to transfer the block definitions to the 
active AutoCAD drawing. They will not become visible until the insert command is used 
to put instances into the visible part of the drawing. 

 

Using the Insert option in AutoCAD 
When the block definitions have been transferred into the drawing, instances of that 
definition can be inserted into the drawing by typing Insert into the command line. 

 

This will bring up the Insert dialogue box. 
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Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing. 

Laying Out Blocks 
The Laying Out Blocks is similar to the Load Blocks into Drawing option, except that it 
bypasses the AutoCAD Insert command and lays out the selected blocks in a grid pattern 
in the currently active drawing in the AutoCAD environment. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are two stages to this. 
 Select the required blocks in Fixture Studio 

 Select the Layout Blocks in Drawing option 

Select the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 
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Select the Laying Out Blocks Option 
Click on the Laying Out Blocks in Drawing option in the File pull down menu. 

 

This will bring up the Layout Options dialogue box. 
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The spacing between blocks can be specified by the X, Y and Z spacing. Ticking the 
appropriate check boxes will add the block name and/or description to each block when 
it is drawn the active drawing. Ticking the Clear Drawing check box will clear all 
previous blocks from the drawing. 

Normalize Blocks 
The Normalize Blocks command is used to modify the AutoCAD properties of blocks 
selected in Fixture Studio. It is the equivalent of the AutoCAD Object Properties dialog 
box, but can be used to perform bulk operations. This is particularly useful when 
working with blocks that have been created outside of Macro Space Planning as they 
may require their properties changed to work within the application. 

1. For KPIs to work within Planner, the blocks color must be set to 'By Block' 

2. For the 'thicken' form of highlighting to work within Planner, the line weight must be 
set to 'By Block'. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

Normalize Blocks is accessed from the File pull down menu. 

 

The Normalize Blocks dialogue box enables any currently selected blocks to have their 
AutoCAD Layer, Color, Line Type and Line Weight changed. 
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Layer 
If set to Ignore, layers will be unchanged. 

If set to Ignore 2D/3D layers they will not be affected by any changes to other layers 

If set to Reset to 0, all selected blocks will have their parent layer set to the default of 0. 

Color 
If set to Ignore, line weights will be unchanged. 

If set to By Layer, then the selected blocks will adopt the default color for the layer they 
are inserted on. 

If set to By Block, the selected blocks will adopt the default color for the layer they 
inserted are on except where the Planner functionality changes the color to a alternative 
one - for example for a KPI. 

If set to Custom, then the modified color for the selected blocks can be set by means of 
the spin control. These blocks will not then adopt the parent color of the layer they are 
inserted on; nor can their color be changed to display KPIs.   

Note: Color should normally be set to By Block. This enables 
blocks to have their colors changed in Planner when KPIs 
are applied. 

Line type 
If set to Ignore, line types will be unchanged. 

If set by ByLayer, the selected blocks will adopt the default line type for the layer they 
inserted are on. 

If set to ByBlock the selected blocks will adopt the default liner type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative one. 

If set to Custom, then the line type for the selected blocks can be set by means of the drop 
down list. 

Line Weight 
If set to Ignore, line weights will be unchanged. 

If set By Layer, the selected blocks will adopt the default weight type for the layer they 
inserted are on. 

If set ByBlock, he selected blocks will adopt the default liner type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative one. 

If set to a Custom level all selected blocks will be set to the line weight selected from the 
drop down list. These blocks will not then adopt the parent line weight of the layer they 
are inserted on; nor can their line weight be changed by the Planner functionality.   
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Note: Line weight should normally be set to By Block. This 
enables blocks to have the thicknesses of their lines changes 
for highlighting purposes in Planner. 

 

Create 3DS Files 
DWG files are used in the Planner module. A different sort of file (3DS file) is used to 
represent products and merchandise in the Merchandiser module. 3DS files are created 
using the DWG file as a template. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are two stages to this. 
 Select the required blocks in Fixture Studio 

 Select the Crease 3DS Files option 

Select the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 
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Select the Create 3DS Option 
Click on the Create 3DS Files option in the File pull down menu. 

 

The required 3DS files will then be created in the same directory as the original DWG 
files. A confirmatory dialog box will appear. 
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Note: 3DS files are also used in the Preview Tab of the Block 
details dialog box. If they are absent a 'graphics not found' 
message will result. 

Redefine Blocks from Disc 
Redefine Blocks from Disc allows the user to overwrite any blocks in the current 
selected floor plan in Planner with the latest versions specified in Fixture Studio. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

It is accessed from the File pull down menu and is only active when Fixture Studio is 
connected to AutoCAD. 

 

On selecting the command, Fixture Studio will identify all blocks in the drawing 
referenced by the Connect to AutoCAD option and replace them with the blocks 
currently referenced in Fixture Studio. A confirmatory dialog box will appear. 
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Note: This task can also be carried out using the Restructure 
Drawing option in the Planner module. 

Block Factory 
The Block Factory option is available from the File menu. 

 

On selecting Block Factory, the Block Factory dialog box will open. 

 

Block Factory will create a list of blocks within the fixture hierarchy. If a Fixture Group 
has been highlighted before Block Factory has been opened, the blocks will be created at 
that point in the hierarchy. If no fixture group has been highlighted, the blocks will be 
created under the fixture hierarchy root. When blocks are created in the hierarchy, they 
will have the name, description and dimensions assigned. All other information will 
have to be entered by editing the within the Block Details dialog box. 
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There are two options; manually enter the information into Block Factory, or use the 
Wizard to automatically create blocks. 

Manual Use of Block Factory 

 

To enter information manually, enter the Name, Description, Length, Depth and Height 
in the top line. To store each line press Return. On clicking OK, the entries will be written 
to the fixture hierarchy. 

Block Factory Wizard 
The Block Factory Wizard is accessed by clicking the Wizard button in the Block Factory 
dialog box. 

 

A Name and Description can be entered followed by the dimensions. The dimensions to 
be included and the separators can be specified, but the resulting name combinations 
must be unique. On clicking OK, this will produce a list of block names followed by 
dimensions in the Block Factory dialog box. 
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On clicking OK, this information will be written to the fixture hierarchy. 

 

The blocks can then be edited using the Block Details dialog box with additional 
information added before the modified block is saved back to the database. 

Note: Using the Block Factory (or the Block Factory Wizard) 
does not create any graphics - the DWG and 3DS files will 
still have to be manually created. 
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Edit Menu 

Edit Pull Down Menu 
The Edit Menu has varying options concerned with editing block descriptions. 

 

Add Block, Edit Block and Delete Block result in a block being added, or the selected 
block being either edited or deleted. 

Copy Data and Paste Data allow information to be copied from one block to another, or 
copied into a block being added. 
If data is going to be overwritten, a confirmatory warning will appear. 

 

Copy brings up a dialogue box allowing the data being copied to be filtered. 

 

Clear all Blocks removes all blocks from the list of blocks currently loaded into Fixture 
Studio. 

Filter Data brings up the Filter Listed blocks dialogue box. 
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Edit Sizes brings up the Edit Sizes dialogue box. This is used to configure the sizes for 
stretchable blocks. 

 

Edit Categories bring up the Edit Categories dialog box. This is used to configure a list of 
Categories that can be assigned to fixtures on the Categories tab of the Block Details 
dialog box. Categories are often used as filters for reporting purposes. 

 

Edit Attribute Variables brings up the dialog box used to configure the Attributes that 
can be assigned to fixtures in the Planner and Merchandiser Modules, and in In-Store 
Space Collaboration. 
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Copying Data 
The Copy Data and Paste Data options on the view menu (and on the toolbar) allow 
users to copy and paste data from one block to another. This is typically used when 
creating large numbers of blocks. One block is fully configured, and then the required 
data is copied and pasted to other blocks. Examples of this would be copying lists of 
associated parts or styles from one block to another. 

The first stage is to specify the data that is to be copied from one block to another. This is 
done by selecting Copy Options from the Edit menu. 

 

This will bring up the Copy Options dialog box. 
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The data to be copied can be specified by the check boxes. 

The next stage is to highlight the block from which data is to be copied. On selecting 
Copy, the specified data will be written to the clipboard. 

The next stage is to highlight the block to which data is to be copied (only one block can 
be selected at a time). On selecting paste, a confirmatory warning will appear. If Yes is 
clicked, the data held locally in Fixture Studio will be overwritten. 

 

This process can be repeated by selecting further blocks and pasting the information to 
those. 

Finally, the information must be saved back to the central Macro Space Planning 
database. This is done by identifying all changed blocks (red icons) and using the Save 
Blocks option from the File Menu. 

Note: This functionality works best if the block from which 
data is to be copied has first been saved back to the central 
Macro Space Planning database. Problems with the copy and 
paste functionality may result if it has not. 

Categories and Variable Attributes 
Categories and variable attributes are both used for reporting purposes. 

Categories 
Selecting Edit Categories from the Edit menu brings up the Edit Categories dialog box. 
This is used to configure a list of Categories that can be assigned to fixtures on the 
Categories tab of the Block Details dialog box. 
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Once entered, these categories can be assigned to fixtures using the Categories drop 
down list on the Category Tab of the Block Details dialog box. 

 

When generating reports (for example in BI Publisher), Categories can then be used as a 
filter. 

Variable Attributes 
Variable attributes are also used for reporting purposes - particularly for compliance 
purposes. Selecting Edit Attribute Definitions from the Edit menu brings up the Edit 
Categories dialog box. This is used to configure a list of variable attributes that can be 
assigned to fixtures on the UDA tab of the Block Details dialog box. 

Edit Attribute Variables brings up the dialog box used to configure the Attributes that 
can be assigned to fixtures in the Planner and Merchandiser Modules, and in In-Store 
Space Collaboration. 
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Once attributes are set up, they are assigned to individual blocks in the UDA tab of the 
block details dialog box. 

 

Once the Variable attributes have been assigned and saved, they can then be used to set 
'instance' data for fixtures placed in floor plans. This is done by selecting one or more 
fixtures in the Planner or Merchandiser modules or in In-store Space collaboration, then 
clicking the attributes icon on the toolbar. This will bring up the Attributes dialog box. 
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Information can then be entered and saved on a fixture by fixture basis. This can then be 
used for reporting purposes. For example, a KPI could be created to show all fixtures 
with incorrect planograms. This would mean an In-Store Space Collaboration user in an 
individual store could mark up planograms on site and a Macro Space Management user 
at headquarters could then see where reality in the store differed from what was in the 
floor plan. 

Editing Sizes 

Overview of Editing Sizes 
Sizes are used to collect together a set of size rules. 

When a block is associated with a size, it is associated with all the size rules. This allows 
multiple sizes to be assigned to a block. 

 

Note: If a Size is changed, all the blocks that reference that 
size will have their associated size rules changed. 

Setting Up Size Groups 
Size Group Classes are used to organize Size Groups into sub-divisions that make it 
easier to find the required Size Groups. 
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Size Group Classes thus have an administrative function, but do not directly affect the 
data stored in Size Groups. 

 

Adding a Size Group 
This is a function that allows a hierarchical tree to be built. To add a Size Group highlight 
the node in the hierarchical tree to which the new Size Group is to be added and click on 
the Add a Size Group icon. The Size Group dialogue box will appear. 

 

Type in the name of the required Size Group then click OK. The Size Group will be 
added to the hierarchical tree. 

Editing a Size Group 
Size Group names can be edited. To do this, highlight the required Size Group and click 
on the edit a Size Group icon. The Size Group dialogue box will appear. 

 

Change the name of the Size Group then click on OK. The Size Group will be amended in 
the hierarchical tree. 

Deleting a Size Group 
To delete a Size Group, highlight the group and click on the Delete a Size Group icon on 
the toolbar. 

Adding A Size 
To Add a Size click on the Add a Size icon in the section of the toolbar concerned with 
Adding, Editing and Deleting Sizes. 
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When adding a Size, first select the Size Group it is to be added to by clicking on it. If this 
is not done, an error message will result. 

 

If a Size Group has been selected, the Size dialogue box will appear. 

 

1. While in the Details tab, type in the Size name, an expanded Description and a Title. 

2. Also select the correct units for the Size. 

3. In the Sizes tab, enter the details of the sizes. 

4. Click on OK to confirm and the Size will be added to the hierarchy. 

Size Types 
There are a number of options for setting size rules. These are selected from the Type 
drop down list in the Types tab. 
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Edit Menu 

 

The options are: 

 Fixed 

 Variable 

 Choice 
 Match 

 Delta 

 Ratio 

 Locked 

Fixed Sizes 

 

When setting fixed sizes, only a single dimension can be input for length, depth and 
height. All other options are grayed out. 
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Variable Sizes 

 

Variable Size allows the user to set a number of discrete sizes that can be selected when 
the block is inserted into the AutoCAD or Virtual Reality environments. 

Prompt enables the user to type in a brief description of that dimension; for example 
length, Depth or Height. 

The Maximum and Minimum dimensions can then be set: in the above example, the 
length has been defined as having a minimum of 500 mm and a maximum of 1000 mm. 
The Increment can then be set to specify the change from one permissible dimension to 
another. 

For the above example, the length has a minimum value of 500 mm and a maximum 
value of 1000 mm. Because the increment has been set to 100 mm, the user will be 
presented with options to set the length to 500, 600, 700, 800, 900 or 1000 mm when the 
block is inserted. 
Choice allows the user to set in a number of predefined size options. 

 

When this option is selected from the Type drop down menu an additional Size Choices 
Tab will appear. 
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Edit Menu 

The names entered in the prompt fields in the Types tab will appear in the Size Choices 
tab as the names of the dimensions. 

 

The actual dimensions can be added in the Size Choices Tab. 

Icon Option 

 

  

Add New Choice 

 

  

Delete Selected Choice 

 

  

Move Choice Up 

 

  

Move Choice Down 

  

The toolbar allows the user to add, delete and re-order the list of dimensions. 

Match Sizes 
Match Sizes enables the user to link one dimension to another. 
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At least one dimension must be defined using another size option, for example Fixed. 

The other dimensions can be slaved to that specified dimension. For example if the 
length has been fixed at 36 inches, then the depth can be specified as matching the length. 
This will result in a block where the length and depth match. 

 

Delta 
Delta will allow a user to select another dimension and specify the current dimension to 
match that plus/minus a specified increment. 
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Edit Menu 

 

This functionality is not implemented in this release of Macro Space Management. 

Ratio 
Ratio will allow a user to select another dimension and specify the current dimension to 
be multiplied by a specific ratio. 

 

 

This functionality is not implemented in this release of Macro Space Management. 

Locked 
Locked sizes enable the choices visible to the user to be restricted to only one or two 
dimensions when the dialogue appears during insertion. 
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For this option to work, lists of dimensions must first have been input into the Size 
Choices tab. 
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5 
View Menu 

View Pull Down Menu 
The View Menu has varying options concerned with filtering and viewing blocks. 

 

Filter Listed Blocks brings up the Block Filter. This can be used to select specific classes 
of blocks. 

 

Options brings up the Options dialogue box. This can be used to set some options 
determining how Fixture Studio Functions 

 

 Show Tooltips enables tool tips. 
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View Menu 

 Show Warnings enables warnings. 

 Automatically read blocks on start loads the block information into Fixture 
Studio when the module is started. If this option is not checked, the blocks have 
to be manually read in using the Read Blocks option on the File menu. 

 Set OSnaps for picking turns on OSnaps in the Planner module if they are off and 
if the Pick button is used in the Size tab of the Block Details dialog box. 

 Only pick 1 point for heights assumes the base of the block is at zero elevation, 
allowing only the top of the block to be selected if Pick button is used in the Size 
tab of the Block Details dialog box. 

Note: 'Set OSnaps for Picking' and 'Only pick 1 point for 
heights' are not currently functional. 

Block Browser toggles the Block Browser (Object Browser) on and off. 

Checking or unchecking Preview toggles the preview window in the object browser on 
and off. 

The remaining three options allow blocks or gondolas to be grouped. 

Grouping Operations - Edit Menu 
The Group By option on the View Pull Down Menu allows blocks with a common 
criterion to be grouped together, then the list expanded or collapsed. 

 

Show Group By (<Ctrl> + G) brings up a box above the table of blocks descriptions 
titled ‘Drag a column header here to group by that column’. 

 

When this is done the list of blocks is sorted into groups specified by the header dragged 
into the box. 
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Clicking on the dragged column header will change the direction the data is sorted. 
The grouped data can be expanded or collapsed using the options on the View pull 
down menu. 

A collapsed view is as below. 

 

Any individual section of grouped blocks can be expanded or collapsed by clicking on 
the ‘+’ or ‘-’ signs to the left of the section. 
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6 
Toolbar 

Options on the Toolbar 
The Toolbar gives access to a series of Fixture Studio options (some of which are also 
available from the menu bar). 

 

Reading Block Definitions 

 

There are three possible ways of reading Block Definitions into Fixture Studio: 

 Reading from the database. 

 Reading from the drawing. (This option is only available if Fixture studio is 
linked to AutoCAD). 

 Merging data from the database and active drawing. (This option is only 
available if Fixture studio is linked to AutoCAD). 

Note: the setting in the Options dialog box (View Menu) 
determines whether blocks are automatically read into 
Fixture Studio on start up, or whether they are manually 
read in. 

Each of these ways has a number of options that can be set. 

Read from the Database 
Reading from the database allows the user to read in information on blocks stored in the 
database. This may be filtered in different ways depending on selections made in the 
Options frame. 

Note: this option will be the only option available if Fixture 
studio is not linked to AutoCAD (Planner). 
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Toolbar 

 

Read from the Drawing 

Note: this option is only available if the Connect to 
AutoCAD option has been selected from the file menu. 

Reading from the drawing allows users to read in any AutoCAD blocks from the 
drawing into Fixture Studio. When reading from the drawing, only the AutoCAD based 
information is imported. 

 

Merge 

Note: this option is only available if the Connect to 
AutoCAD option has been selected from the file menu. 

Merge compares the blocks in the database to those in the drawing. Any blocks in the 
drawing but not in the database are imported into Fixture Studio. Data read from the 
drawing is AutoCAD based and does not contain any Macro Space Management 
information. 
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Options 

Note: which of these options are available depends on both 
the source of the data and which other options have been 
selected. 

Clear existing Block definitions 

 

If this option is selected, all existing Block Definitions held in Fixture Studio are deleted 
and new definitions read in from drawing or database. The changes will not be made 
permanent in the database until they are saved back. 

Reading Block Definitions 51 



Toolbar 

Overwrite existing Block definitions 

 

If this option is selected, any block definitions imported from the drawing or database 
will overwrite the corresponding data in Fixture Studio with similar names in Fixture 
Studio. 

Overwrite existing Block definitions with Data Filters 

 

If the Apply Data Filters option is selected, the filtered data from any block definitions 
imported from the central database will overwrite the corresponding data in the Block 
definitions with similar names in Fixture Studio. 
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All data options from the central database can be filtered (unlike Block definitions 
imported from a drawing, where options are more limited). 

Load Blocks into Drawing 
This option is not currently implemented. It has been replaced by the Load Blocks into 
Drawing option on the file menu. 

Saving Block Definitions 
Clicking on the Save Changes Icon brings up the Save Block Definitions dialogue box. 

 

Destination Frame 
The Destination Frame enables the user to specify whether data is saved to the drawing 
or to the database. 

Note: the drawing option will only be active if the Connect 
to AutoCAD option has been selected on the file menu. 

 If Database is selected, information will be written to the database. 

Saving Block Definitions 53 



Toolbar 

 If Drawing is selected (and Write block files is also selected), XData will be 
written to the blocks in the drawing currently linked to in the Connect to 
AutoCAD option. 

Options Frame 
 Add New Definitions adds all new definitions to the specified destination. This 

command should be used with caution as any block (including badly defined 
ones) will be saved to either the drawing or database. 

 Enforce Save saves all Block definitions currently loaded into Fixture Studio and 
which have had changes made to the central database. 

 Save Dumb Blocks saves blocks without full information (for example insertion 
points) to the specified destination. 

 Only Save Selected Blocks saves only the Block definitions currently selected in 
Fixture Studio to the specified destination. 

 Write Block Files is only available when the Connect to AutoCAD option has 
been selected. If this option is selected, Fixture studio will: 

– Write a copy of the block file from the currently active drawing in Planner to 
the directory specified in the Categories tab of the Block Definition dialog 
box. 

– Write XData to the block in the directory specified in the Categories tab of 
the Block Definition dialog box if the Database option has been selected in 
the Destination Frame. 

– Write XData to the block in the currently active drawing in Planner. 

 Update Database with Drawing is only available when the database is selected as 
the only destination. It will identify all blocks in the drawing identified by the 
Connect to AutoCAD option and write the latest version of information in 
Fixture Studio to the database. 

Adding, Editing and Deleting Groups 
Groups are used to arrange fixture definitions into logical sub-sets. The resulting 
hierarchy is used in Fixture Studio for maintaining information on the equipment used in 
Macro Space Planning. The hierarchy also appears in the Object Browser in the Planner 
and Merchandiser modules and in In-Store Space Collaboration. 
Groups can be Added, Edited and Deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu). 

 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click the 
Add Group Icon. The Group dialogue box will appear. 
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Enter a description and select an icon from the drop down list. Click on OK to conform. 
The group to be added is a child of its selected parent group. 

Edit Group 
To add a group, highlight the group which is to be edited. Click the Edit Group Icon. The 
Group dialogue box will appear. 

 

Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details will now be updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click on the Delete Group Icon. If 
the Group to be deleted has child groups or block definitions, a warning dialogue will 
appear. 

 

If there are no child objects, the group will be deleted without any requirement for 
confirmation. 

Filtering Blocks 
The list of blocks showing in the Block Details dialogue box may be filtered using the 
filtering option on the toolbar. 
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Toolbar 

 

Filtering by name uses implied wild cards, although ‘*’ and ‘?’ are also allowed. 

 

Search String Result 

Leg All examples of blocks containing Leg 

I_BR_T-Leg_1x48x72 Find that exact file name 

I_BR_T-Leg_1* Find all examples of blocks beginning I_BR_T-Leg_1 

  
To show all blocks again, clear the text box and press Return. 

Filtering by Block Status 
The Block Status can be seen to the left of the Block Definitions Window. 

 

By using the Block Status frame it is possible to select blocks meeting specific stages of 
being registered in Fixture Studio. 
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Icon Description Comments 

 

Show Valid 
Blocks 

These are blocks that have just been updated by having the XData 
written to the blocks stored in the directory specified in the Categories 
tab of the Block Details dialog box. 

 

Show New 
Blocks 

These are blocks just imported into fixture studio. 

 

Show 
Changed 
Blocks 

These are blocks where the data has been changed in Fixture Studio 
but not yet written back to the database. 

 

Show 
Database 
Blocks 

These are blocks where the information in Fixture studio matches that 
held in the database. 

 

Show 
Drawing 
Blocks 

These are blocks in the drawing containing XData, but where that 
information has not yet been written back to the database. This is 
achieved by assigning data in the Block Details dialog box and then 
writing that data back to the drawing, but not the database. 

 

Show Dumb 
Blocks 

These are blocks where no Macro Space Planning information has 
been assigned: they are pure AutoCAD blocks. 

Filtering by Block Type 
By using the Block Type Frame, the blocks displayed in the Block Definitions window 
can be restricted to those of specific types. 

 

These types are set in the Retail Type drop down list in the Category Tab of the block 
Details dialog box. 
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Find Block Definitions 
Clicking on the Find Icon on the toolbar will bring up the Find Block dialogue box. 

 

 

To use the Find Option, type in the required search string into the Find box and press 
<Return>. A list of block definitions matching the search string will appear in the box 
below. 

To display a block definition in the hierarchical tree in the Object Browser, highlight it in 
the list of block definitions and click on the OK button. The block definition in the Object 
Browser will be highlighted and the Find Block dialogue box will close. 

Note: The search string will not allow wild cards such as ‘?’ 
and ‘*’. The search string will match any block description 
with a comparable string in the ID, Name or Description 
fields. In the above example the search string rack has 
matched instances of the name Leg. 

Setting Columns 
The columns that display in the Block Definitions window can be configured by clicking 
on the Set Columns in Grid Icon in the toolbar. 
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Note: The columns displayed in the Gondola Definitions 
window cannot be configured. 

 

This will bring up the Columns dialogue box. 

 

The Columns frame on the left contains a list of the columns that are currently displayed. 
The Available Frame on the right contains a list of columns that are not being currently 
displayed. The list of columns to be displayed can be modified by making use of the 
selection arrow in the middle of the dialogue box. 

When the selection has been made, clicking on OK will result in the Block Definition 
table being rearranged accordingly. 
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7 
Relationships with Other Modules 

Overview of Relationships to other Modules 
The settings made within Fixture Studio are affected by and interact with settings made 
within other modules within Macro Space Management 

 

Admin Module 
The following can be configured within the Admin Module: 

 List of Manufacturers. 

 List of Ranges. 

 Available status’s 

 List of possible Styles 
 List of default units 

 User Defined Attributes 

Configuration Module 
The following can be configured within the Configuration Module: 

 Directory for graphics (dwg and 3DS) files 

Layers 
 List of aliased layers a block can be inserted on, and which connections are valid 

on. These can only be configured within Planner. 
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Relationships with Other Modules 

Levels 
 List of available levels to insert an block on – only configurable within database 

Product Studio 
 List of available materials – this affects the appearance of the graphics. 
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8 
The Admin Module 

Configuring the List of Manufacturers 
The List of Manufacturers is used in the General Frame of the Categories tab in Block 
Definitions. 

 

The List of Manufacturers can be configured using the Manufacturers option on the 
General menu in the Admin Module. 

 

This brings up the Manufacturers dialogue box. 
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The Admin Module 

 

This enables a list of manufacturers to be built up and edited. The list is primarily used 
for reporting purposes. 

Note: For more information, consult the Admin Module 
Help File - please be aware that access to the Admin Module 
is only available to users with Administrator's privileges. 

Configuring the List of Ranges 
The List of Ranges is used in the General Frame of the Categories tab in Block 
Definitions. 

 

The List of Ranges can be configured using the Ranges option on the Edit Pull down 
menu in the Admin Module. 

64 



Fixture Studio User Guide 13.3.2 

 

This brings up the Ranges and Range Groups dialogue box. 

 

This functionality is not implemented in this release of Macro Space Management. 

Note: For more information, consult the Admin Module 
Help File - be aware that access to the Admin Module is only 
available to users with Administrator's privileges. 

Configuring the Available Status's 
The List of Statuses is used in the General Frame of the Categories tab in Block 
Definitions. 
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The Admin Module 

The List of Statuses can be configured using the Status option on the General menu in the 
Admin Module. 

 

This brings up the Status dialogue box. 

 

The Statuses available for blocks can be added, edited and deleted. Their order can also 
be configured. Changes can be defined as reversible or irreversible and files can be set to 
read only status when that status is reached. Finally, statuses can be set to be selectable or 
not selectable. Selectable statuses can be selected manually. Non-selectable statuses 
change automatically when other actions are carried out. 

Note: For more information consult the Administration 
Module Help File - please be aware that access to the 
Administration Module is only available to users with 
Administrator's privileges. 

Configuring the List of Styles 
The List of Styles is used in the Available Styles Frame of the Styles/Ranges tab in Block 
Definitions. 
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The List of Styles can be configured using the Styles option on the Edit Pull down menu 
of the Admin Module. 

 

This brings up the Styles dialogue box. 
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The Admin Module 

Styles can be added, edited and deleted in the Styles tab. The relationships between the 
varying types of styles can be defined in the Style Relationships Tab. The Test Tab allows 
users to conform the requisite Style Relationships have been defined. 

Note: For more information consult the Admin Module Help 
File - please be aware that access to the Admin Module is 
only available to users with Administrator's privileges. 

Configuring the Default Units 
The List of Units is used in the General Frame of the Categories tab in Block Definitions. 

 

The List of Units can be configured using the Units option on the General Pull down 
menu in the Administration Module. 

 

This brings up the Units Admin Tool dialogue box. 
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This allows units to be added, edited or deleted. 

It also allows other settings to be specified; for example whether use of that unit is 
mandatory. 

Note: For more information consult the Admin Module Help 
File - be aware that access to the Admin Module is only 
available to users with Administrator's privileges. 

Configuring User Defined Attributes 
The List of User Defined Attributes is used in the UDA’s tab in Block Definitions. 
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The Admin Module 

The List of User Defined Attributes (UDA’s) can be configured using the User Defined 
Attribute option on the Edit Pull down menu of the Admin Module. 

 

This brings up the User Defined Attributes dialogue box. 

 

This allows User Defined attributes to be added, edited and deleted. 

Note: For more information consult the Admin Module Help 
File - please be aware that access to the Admin Module is 
only available to users with Administrator's privileges. 

System Variables 
System Variables can be configured within the Administration Module. 

There are presently no System Variables that affect the operation of Fixture Studio. 

Note: For more information consult the Administration 
Module Help File - access to the Administration Module is 
only available to users with Administrator's privileges. 
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9 
The Configuration Module 

Configuring Directories 
The Directory used is in the General Frame of the Categories tab in Block Definitions. 

 

This determines the directory where Macro Space Management looks for the graphics 
associated with the corresponding block definitions. 

The Directories Tab can be accessed when the Configuration Module is accessed from the 
Administration module. Directory paths can then be set in the Directories Tab. 
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10 
Layers 

Configuring Layers 
The List of Layers is used in the Layers frame of the Insertion tab in Block Definitions. 

 

It is also used in the Layer Alias frame of the Connections tab in Block Definitions. 

 

The List of Layer Aliases can be configured using the Layers > Layers option on the 
Format pull down menu of the CAD environment. 
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Layers 

 

This brings up the Layers and aliases dialogue box. 

 

This can be used to configure Layers and Layer Aliases. 

Note: If users are unsure of the effects of modifying the 
Layers and Layer Aliases, they are advised to contact 
Oracle’s Technical Support Team. 

 
 
 
 
 
 

74 



 

11 
Levels 

Configuring Levels 
The List of Levels is used in the Insertion tab in Block Definitions. 

 

The list of levels is configured directly in the central Macro Space Planning database. If 
additional levels are required, this must be done by an administrator with access rights to 
the database. 
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12 
Product Studio 

Configuring the List of Materials 
The List of Materials is used in the General Frame of the Category tab in Block 
Definitions. 

 

The List of Materials can be configured using the Materials option on the View Pull down 
menu of Product Studio. 

 

This brings up the Materials dialogue box. 
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Product Studio 

 

This can be used to add edit and delete options determining the surface appearance of 
graphics blocks inserted into the Merchandiser environment. It has no effect on how 
graphics display in the Planner environment. 
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13 
Getting the Basics Right 

About Fixture Studio Basics 
Note: Time to consider how Fixture Studio should be set up 
before starting to implement it. The way it is configured may 
have a significant effect on the efficiency with which Macro 
Space Management operates.   

Once Fixture Studio is set up, it is difficult to make changes to its configuration. 

Time spent considering the optimum way to set up Fixture Studio will be repaid many 
times over when fixtures and gondolas are used in the Planner and Merchandiser 
environments. 

Factors to Consider 
 There are a number of things to consider before beginning to set up Fixture Studio. 
These are: 

Use of Directory Structure   
Depending on the size of the retail organization there may be hundred, thousands or 
even tens of thousands of fixtures. 
The graphics for these fixtures are stored in directories. Consider carefully the number of 
directories you need. With only a limited number of fixtures, one directory may be 
sufficient. With tens of thousands of fixtures, it may be more logical to create a number of 
directories.  

Use of Naming Conventions 
Naming conventions have two purposes. Firstly, it can make it easier to identify the 
required block from a long list of available blocks. Secondly, and more importantly, it 
will affect the ease of defining gondolas. Without a good naming convention, you may 
need to define hundreds of gondolas. 
With a good naming convention you may only need to define ten or twenty gondolas.  

Setting up Logical Hierarchies 
Fixtures and Gondolas are stored in hierarchies (a bit like the windows folders system). 
Setting up logical hierarchies will make it easier to maintain the Fixtures and Gondolas 
within Fixture Studio. It will also make it easier for users to select fixtures and gondolas 
in Planner and Merchandiser.  

Using Stretchable Fixtures 
Stretchable Fixtures are fixtures that can be placed in the drawing and then configured to 
a range of preset sizes. Using stretchable fixtures reduces the number of fixtures 
required. However, if stretchable fixtures are used, it will not be possible to produce 
accurate reports on what fixtures and fittings are present in stores.   
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About Connections 
Connections determine which items of equipment can be connected to which other items 
of equipment. Having a simple and consistent scheme for connections will make it easier 
to define those connections.  

Note: Styles also influence what items of equipment can be 
attached to what. 

About Styles 
Styles determine which items of equipment can be placed on each other, and which styles 
of product can be placed on what items of equipment. 

Note: Connections also influence what items of equipment 
can be attached to what. 

Having a logical list of styles and style relationships aids placement.  

Summary of Fixture Studio Basics 
The general flow for deciding on how Fixture Studio can be set up is as follows: 
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About Categories for Fixtures 
For a large retail organization, there may be many thousands of fixtures and fittings. 
These could be assembled into many hundreds of types of gondola. 
Before any start is made setting up fixtures and gondolas within Fixture Studio, some 
thought must be given to how all this information is organized. 

Unless it is arranged in a simple and logical manner, considerable time will be wasted 
later trying to find specific fixtures or gondolas, or trying to attach one pieces of 
equipment to another when the styles are incompatible. 

It is recommended that a table on the lines of the following be produced as a basis for 
deciding how Fixture Studio is to be configured. 

Equipment 
Category 

Equipment Sub-
Division 

Connections to Style Relationships with 

Hussmann Primary 

• Legs (6) 

• Backpanels (20) 

• Slatwalls (12) 

  

  

• Other Primary 
Hussmann 
Equipment 

• Secondary 
Hussmann 
Equipment 

• Some items of 
Primary 
Generic 
Equipment 

  

• Other Primary 
Hussmann 
Equipment 

• Secondary 
Hussmann 
Equipment 

• Product Display 
Styles 

  

Secondary 

• Open Shelves 
(30) 

• Wire Shelves 
(16) 

• Hanging Bars 
(6) 

• Lateral Rods 
(4) 

  

  

• Primary 
Hussmann 
Equipment 

• Other 
Secondary 
Hussmann 
Equipment 

• Tertiary 
Hussmann 
Equipment 

  

• Primary 
Hussmann 
Equipment 

• Other Secondary 
Hussmann 
Equipment 

• Product Display 
Styles 

Tertiary 

• Dividers  (2) 

• Grilles (4) 

  

  

• Secondary 
Hussmann 
Equipment 

  

N/A 

Lozier Primary           etc N/A N/A 

Secondary       etc N/A N/A 

Tertiary            etc N/A N/A 

Generic Primary           etc N/A N/A 

  Secondary       etc N/A N/A 

  Tertiary            etc N/A N/A 

About Categories for Fixtures 81 



Getting the Basics Right 

Overview of Directory Structures 
Note: Directories will mainly be used by people within 
Fixture Studio to store graphics and to select the graphics for 
editing or deletion. Too few directories will result in each 
directory containing hundreds of graphics files. Too many 
directories will make it difficult to remember which 
directories the graphics are in. It is recommended users list 
out the total number of graphics that are expected to be used 
within Macro Space Management, together with suggested 
classes they fall into. The number of fixtures that fall into 
each suggested class can then be estimated.  This can be seen 
as the bracketed figures in the suggested table.  

 

Note: When classes have been selected that contain a 
sensible number of fixtures, the directory structure can then 
be set up accordingly. 

Depending on the size of the retail organization there may be hundred, thousands or 
even tens of thousands of fixtures. 

The graphics for these fixtures are stored in directories. Consider carefully the number of 
directories you need. With only a limited number of fixtures, one directory may be 
sufficient. With tens of thousands of fixtures, it may be more logical to create a number of 
directories. In this example some sub directories have been set up in the folder where the 
Macro Space Management directories are stored. 

 

Client data serves as a parent directory and then three sub-directories called 
Miscellaneous, Racking and Shelves serve to hold the graphics for those classes of 
fixtures. 

Note: Each fixture will normally have two classes of 
graphics associated: .dwf files for display in the Planner 
environment and .3DS files for display in Merchandiser. 

The directories that the graphics have been assigned to need to have to have their paths 
specified in the Directories Tab in the Configuration Module.  

Setting up Directory Structures 
Directory Structures need to be set up before fixtures can be imported into them. 

This is done in two stages: 

 Create the required directories using Windows Explorer. 

 Set up the required links in the Configuration Module. 
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Create the required directories using Windows Explorer 
Using Windows Explorer, navigate to where the Macro Space Management data files are 
held. Create the required directories. 

 

Note: You may require the appropriate permissions from 
your Systems Administrator to carry this out. 

Set up the required links in the Configuration Module 
The Directories tab configuration module can only be accessed from the Administration 
Module. 

 

Using the Add button will allow paths to the directories made using Windows Explorer 
to be added. 
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Overview of Naming Conventions 
Note: Naming conventions are important to the efficient 
operation of Macro Space Management. They must be 
decided upon before any blocks are imported into Fixture 
Studio. Lack of a naming convention will make it more 
difficult to locate the require fixture blocks. It will result in 
users spending large amounts of time creating dozens of 
gondolas that could have been defined far more efficiently 
using a naming convention. 

A naming convention is a pre-thought out and logical way of assigning block names. 
If we give blocks names like Widget-187567 and Gizmo-ADRTYN, it is not obvious what 
the blocks or, or what their dimensions are. 

With a well thought out naming convention, things are far simpler. 

 

In the above example, we can see we have three types of block; Back Panels, L shaped 
uprights and T shaped uprights. 

We can also see that the back panels have widths of 600 and 900 mm, and that they have 
heights of 1400, 1600, 2500 and 2900 mm. 
Similarly we can see that both the L and T shaped uprights come in four heights; 1400, 
1600, 2500 and 2900 mm. 

Widget-187567 might well be a back panel of width 600 mm and height 2500 mm, but we 
cannot tell this from the block name. 

Naming Conventions 
 Naming conventions are of the general form: 
Prefix-parameter-parameter-parameter-suffix 

These can be any combination of numbers and letters, together with several separating 
characters. 

The separating characters can be either a ‘–’, ‘_’ or an ‘x’, so each of the naming 
conventions below are equally valid: 

 Prefix-Parameter-Parameter-Parameter-Suffix 

84 



Fixture Studio User Guide 13.3.2 

 Prefix-ParameterxParameterxParameter-Suffix 

 Prefix_ParameterxParameterxParameterxSuffix 

However, the use of naming conventions must be consistent. 

Naming blocks with a mixture of ‘–’, ‘_’ or ‘x’ will lead to errors. 
For example we will have problems if we name blocks as in the example below: 

 Backpanel-600-1400 

 Backpanel-600x1600 

This is because Macro Space Management expects to find the same separating character 
for blocks within a naming convention. 

When the program draws a gondola, if it expects to see: 
Prefix-Width-Height 

And some of the blocks are named: 

Prefix-WidthxHeight 

It will find blocks with name like Backpanel-600-1400 because these are in the expected 
form. 

It will fail to find blocks with names like Prefix-widthxheight because there is an ‘x’ 
present where Macro Space Management expected to find a ‘–’. 

Similarly users must avoid misspellings: 

If we name a block Backpanal-600-1400 rather than Backpanel-600-1400, Macro Space 
Management will fail to find the block because we have misspelt Backpanel. 

Note: Always check naming conventions for errors. If you have made an error when 
naming the block, Macro Space Management will not find it when drawing the gondola.  

Gondolas and Naming Conventions 
If naming conventions are assigned to Fixture blocks, then these blocks can be 
automatically be selected by including the correct options during Gondola definition. 
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When the gondola is placed in Planner or Merchandiser, a list of dimensions (and 
sometimes options) will be available in the Add Gondola dialogue box.   

 

In the above example a gondola can be placed with any combination of two widths and 
four heights (eight combinations in all). 

Note: In the above example, a width of 600 mm and a height 
of 2500 mm have been selected. When the gondola is created 
in the drawing, it will be done using by reconstructing the 
required block name based on information in the gondola 
definition. For example, the software would use a backpanel 
with a name of Backpanel-600-2500. If we had chosen 
dimensions of 900 mm and 1400 mm, the software would 
use a backpanel with a name of Backpanel-900-1400. 

If naming conventions were not used when defining this gondola, eight separate 
gondolas would have to have been designed in Fixture Studio. 

Note: Using gondola definitions in this way only works if a 
consistent naming convention has been used for the blocks 
that will be used to draw the gondolas. This means that 
blocks must be imported into Fixture Studio using a good 
naming convention from the start. If a good naming 
convention is not used, then users will end up with an 
inefficient way of defining gondolas, and consequent loss of 
time when placing gondolas in store plans 

Overview of Stretchable Fixtures 
Note: Use stretchable fixtures if you do not want accurate 
reports on what equipment is present in stores. Do not use 
stretchable fixtures if you want accurate reports on 
equipment. 
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Stretchable Fixtures 
Stretchable fixtures are a special feature of Macro Space Management that allows those 
fixtures to take up a range of permitted sizes. Placing stretchable fixtures reduces the 
number of fixtures required as the same fixture could be placed in (for example) 600 mm, 
700 mm and 800 mm widths. 

Reporting 
It is possible to generate reports on what equipment is present in one or more stores. If a 
stretchable backpanel has been used in 600, 700 and 800 mm widths, the report will only 
show the present of the stretchable backpanel. If 600 mm, 700 mm and 800 mm wide 
backpanels have been individually placed, it is possible to generate an accurate report on 
how many of each width of backpanel is present in a store.   

Overview of Connections 
Note: Connection set-ups should be kept as simple as 
possible with regard to connecting together equipment in 
the correct alignment and Ensuring non compatible 
equipment cannot be connected. Connections should also be 
used in conjunction with styles. 

Connections are used to determine what items of equipment can connect to what items of 
equipment. 

For one item of equipment to connect to another the following must be true. 

  

  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be disabled in the 
Configuration Module 

  

If any of these criteria are not true, then a connection cannot be made. In addition, if the 
details of the connections are not correctly specified relative to each other, equipment 
may connect together in unintended alignments. It is suggested the use of connection 
parameters is planned beforehand. 

Note: Connections can be made easier to use by means of 
well planned hierarchies. For example, all equipment in the 
Lozier group would be expected to have connections 
designed to be compatible. 

Planning the use of Connections 
The following guidelines are recommended for planning the systematic use of 
connections. 
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Connection Names 
Connections should be assigned logical names such as Peg or Slatwall. This enables their 
purpose to be seen at a glance.   

Gender 

Permissible Values Comment 

Male, Female, Neutral. Male connects with female. 

Neutral connects with itself and both male and female. 

  

Specify conventions such as male and female connections always point in opposite 
directions when defined. This means when two items of equipment are inserted in 
Merchandiser next to each other and facing the same way, the male and female 
connections will always mate when selected for joining.  Also use logical conventions 
such as pegs, hanging rods, etc, always have male connection gender and the holes or 
slots they fit into have female gender. 

Shape 

Permissible Values Comment 

None, Rectangle, Circle, Oval, 
Triangle, Hexagonal. 

Specific shapes will only connect with themselves and 
None. 

  
Assign the shapes to equipment by function - for example assign connections of shape 
Rectangle to Legs, Slatwalls and Back Panels and connections of shape Circle to Pegs, 
Hanging Rods, etc.  This will mean that Slatwalls and Back Panels can only connect to 
Legs and not (say) Pallets. Similarly, it means that Pegs can only connect to the 
appropriate connections on the Back Panel.  (Equipment that has to connect to multiple 
types of equipment can be assigned shape None.) 

Size 

Permissible Values Comment 

Minimum size 0, maximum 
size 1000. 

Two items of equipment must have overlapping 
connection sizes to connect. 

  

Connection sizes can be assigned according to purpose. An example of such a scheme is: 

Size Purpose 

11 - 15 Floor mounted (primary) equipment 

6 - 10 Shelves and other secondary equipment 

0 - 5 Dividers, grilles and other tertiary equipment 
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That means connection types intended to let floor mounted equipment only join to each 
other can be assigned one size range. Shelves can be assigned another size range of 
connection types that will only let them connect to the equivalently sized connections on 
primary fixtures such as backpanels and slatwalls. Dividers and grilles can be assigned 
another size range of connection types that will only let them connect to the equivalently 
sized connections on secondary fixtures such as shelves. 

If the size ranges are correctly assigned then although the gender and shape of a 
connection might be compatible, equipment will be prevented from joining 
inappropriately - for example a divider will only place on a shelf. 

Note: These connection requirements can always be 
overridden by turning off the filters in the Fixtures Tab of 
the Configuration Module. 

Note: As well as Connections, Styles can be used to 
determine what item of equipment can be connected to 
what. If it is intended to join one item of equipment to 
another, both the Styles and the Connections must be 
compatible with that aim. 

Overview of Styles 
Note: Styles and Style Relationships should be kept as 
simple as possible with regard to making sure equipment 
connects together in a compatible manner and Ensuring the 
correct display style goes onto shelves, pegs, etc. Styles 
should also be used in conjunction with connections. 

Styles are used to determine what is compatible with what. 

For example, the assigned fixture and shelf styles determine whether a shelf object can be 
placed on a specific item of equipment or not. 

For example styles will allow pegs to be placed in pegboards, but not on open shelves. 

Similarly the assigned product style determines whether the product can be placed on for 
example a shelf. 
Product of Pegged style can be constrained to only place on pegs, while products of 
Boxed Style can be constrained to only place on wire, open and heavy duty shelves. 

Note: Styles can be made easier to use by means of well 
planned hierarchies. For example, all equipment in the 
Lozier group would be expected to have styles designed to 
be compatible. 

Planning the use of Styles 
In planning the use of Fixture and Shelf Styles, an effort must be made to keep the 
number of styles to the minimum possible. 

This is because for Style Relationships: 

 Each shelf object that goes onto a fixture has to have a compatible style 
relationship with that fixture. 

 Each product that goes onto a fixture has to have a compatible style relationship 
with that fixture. 
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 Each product that goes onto a shelf object has to have a compatible style 
relationship with that shelf object. 

If there are large numbers of Fixture, Shelf and Product Styles, it will make it difficult to 
set up and maintain the list of style relationships. 
For example, it is best to avoid manufacturer specific shelf styles unless there are actual 
reasons for doing so. 

Thus it is better to have a 'General Shelf' style rather than 'Hussman Shelf', 'Lozier Shelf' 
 and 'Franklin Shelf' as having three separate shelf styles means three times as many style 
relationships need to be set up. 

Note: As well as Styles, Connections can be used to 
determine what item of equipment can be connected to 
what. If it is intended to join one item of equipment to 
another, both the Styles and the Connections must be 
compatible with that aim. 
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About Blocks 

Overview of Block Details dialogue box 
The Block Details dialogue box allows the user to give the WBlock (World Block) 
created in Planner the intelligent properties needed by Macro Space Management to 
carry out the full range of its fixturing, merchandising and reporting functions. 
Data added to Block Details is stored in the central Macro Space Management database. 

 

The Block Name at the top of the dialogue box must correspond to that of the AutoCAD 
WBlock it is associated with. 

If they do not correspond, the Macro Space Management block cannot be placed in the 
CAD or Virtual Reality environments. 
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The Block Description allows the user to enter a more comprehensive description of the 
block. 

The Tabs allow the user to switch between various categories of Macro Space 
Management Block information. There are eleven tabs in total: 

 Category 

 Insertion 

 Size 

 Connections 

 Parts 

 Fixture 
 UDA’s (User Defined Attributes) 

 Styles/Ranges 

 Merchandisable Areas 

 Shelves 

 Preview 

Each tab is split into a series of frames. Each frame deals with one aspect of the 
information on that tab. 

About Naming conventions 
Gondola creation relies on a convention for block naming. Accordingly blocks should be 
named in a systematic manner. 

 

Naming conventions are often of the general form Block Type-dimension-dimension-
dimension. 
In the above example, the convention is Backpanel-width-height. 

 Backpanel-600-1150 is a back panel 600 mm wide x 1150 mm high. 

 Backpanel-600-1500 is a back panel 600 mm wide x 1500 mm high. 
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Note: Components for gondolas will be selected using these 
name conventions, so it is important that a consistent 
scheme is used when creating blocks. If this scheme is not 
consistent, it may not be possible to select the required 
blocks for creating gondolas. Block names can also include 
suffixes, for example -HD and -HD-Foot. 

 

Suffixes can be used to further restrict the list of available blocks for a specific gondola. 
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Category Tab 

Overview of the Category Tab 
The Category Tab is used to set general parameters for the block being defined. 

 

The Equipment Type Frame 
The Equipment Type Frame can be used to specify basic parameters for the object. 
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Options 

Retail Type 
Retail Type determines how the block behaves in the floor plan. For example only blocks 
of type 'Fixture' (Planner and Merchandiser) or 'Shelf' (Merchandiser only) will accept 
merchandise. This can be set using either the drop down list or the wizard. 

Can Populate with Display Style 
The Can Populate with Display Style is only available if the Retail Type has been set to 
fixture or shelf. It determines whether the item of equipment can accept products at 
Display Style level in the Merchandiser module. 

Can Populate with Placeholder 
The Can Populate with Product Placeholder is only available if the Retail Type has been 
set to fixture or shelf. It determines whether the item of equipment can accept product 
placeholders in the Merchandiser module. 

Attaches to Primary Equipment 
This determines if the object can attach to primary equipment (fixtures) in the 
Merchandiser module. It will be grayed out for certain Retail Types. 

Attaches to Secondary Equipment 
This determines if the object can attach to secondary equipment (typically shelves) in the 
Merchandiser module. It will be grayed out for certain Retail Types. 

Accepts Secondary Equipment 
This allows the object to accept secondary equipment (for example shelves and rods) in 
the Merchandiser module. It will be grayed out for certain Retail Types. 

Corner Block 
This is a flag to show that the particular item of equipment is designed to go into a 
corner, for example to allow a run of fixtures to continue when it changes direction as a 
wall goes through a right angle. It also restricts options for populating and carrying out 
area calculations. 

96 



Fixture Studio User Guide 13.3.2 

The Equipment Wizard 
The Equipment Wizard allows the user to define the Retail Type by means of the two 
drop down lists in the Equipment Type frame. It also allows the dimensions (Equipment 
Size frame) and the Connection Points (Spacing Frame) to be set. 

 

Options 

Equipment Type Frame 
The Type and Description lists in the Equipment Type frame can be set to appropriate 
values for that block. When the OK button is clicked, the Retail Type and Icon will 
automatically be set in the Categories tab of the Block Details dialog box. 

Equipment Size Frame 
The Equipment Size frame enables the dimensions to be entered. On clicking the OK 
button, these will automatically be set in the Sizes tab of the Block Details dialog box. 

Note: For the Calculate and Pick buttons to be active, the 
Connect to AutoCAD option must have been selected on the 
File menu. 

There are three ways of inputting dimensions: 

 Manually: numbers can be typed into the appropriate text boxes. 
 Calculate: if connected to an AutoCAD with an instance of the block in the 

drawing, clicking the Calculate button will automatically populate the length, 
depth and height. 

 Pick: if connected to an AutoCAD with an instance of the block in the drawing, 
clicking the Pick button will take the user to the drawing where the user can click 
two points (for example by using OSnap) to define that dimension. 
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Spacing Frame 
The spacing frame is used to set the dimensions for a vertical array of connection points. 
This can either be set manually, of by means of the Pick buttons. The option will be 
grayed out if the Retail Type (Equipment Type frame) is not appropriate. 

The General Frame 
The General Frame enables the user to set a series of options concerning the general 
properties of the block. 

 

Options 

Directory 
The Directory the block will be stored in is specified from a drop down list. The list of 
available directories is specified in the directories tab of the Configuration module 
(accessed from the File menu). 

Note: See the Configuration Module help file for more 
information on how to configure directories. 

Manufacturer 
The Manufacturer for the block can be selected from a drop down list. This list is 
configured in the Administration Module (General Menu). 

Note: See the Administration Module help file for more 
information on how to set up a list of manufacturers. 

Units 
Units specify the unit of measurement for the block. This should be set to the appropriate 
metric or imperial units. 

Note: See the Administration Module help file for more 
information on how to configure up a list of units. 
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Material 
The Material can be selected from a drop down list. It determines the color of the 3DS file 
used to represent the item of equipment in the Merchandiser module. The list of material 
is configured in the Product Studio module (View menu). 

Print Material 
The Print Material can be selected from a drop down list. It determines the color of the 
item of equipment will print if a snapshot is taken of the view in the Merchandiser 
module. The list of material is configured in the Product Studio module (View menu). 

Note: See the Product Studio help file for more information 
on how to set up the list of materials. 

Status 
The Status can be selected from a drop down list. It serves as an indication of where the 
block is in its business life cycle; for example in service, or superseded from service. This 
status can be used for a number of purposes. These include: 

 Use as a filter for populating fixtures into the object grid. (This requires changes 
to the Custom SQL). 

 Use as a filter for reporting purposes. 

The list of Statuses is configured in the Administration module (General menu). 

Note: See the Administration Module help file for more 
information on how to configure the list of statuses. 

Effective Date 
The Effective Date can be set using the drop down control. It is the date at which the item 
of equipment is set to come into service. Items of equipment before their Effective Date 
(or with their Effective Date before the Active Date of the Floor Plan) are grayed out and 
unavailable in the Object Browser in the Planner and Merchandiser modules. The 
Effective Date can also be used as a filter for reporting purposes. 

Expiry Date 
The Expiry Date can be set using the drop down control. It is the date at which the item 
of equipment is set to come into service. Items of equipment after their Expiry Date (or 
with their Expiry Date after the Active Date of the Floor Plan) are grayed out and 
unavailable in the Object Browser in the Planner and Merchandiser modules. The Expiry 
Date can also be used as a filter for reporting purposes. 

Product Code 
The code is entered by the user. An example would be a manufacturer’s product code. It 
is used for reporting purposes. 

Icon 
The Icon for the block can be selected from a drop down list. This list can only be 
customized by Oracle. 
The selected Icon will then appear against the Block Definition in the various hierarchical 
trees. 
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The Type Frame 
The Type Frame specifies how the block is to be drawn in the AutoCAD drawing or 
Virtual Reality environment. 

 

Fixed Size blocks are always drawn at a constant scale. This is how most blocks will be 
designated as it means they change in scale as the drawing scale is changed. 

Symbol, Scaled size and Drawn 1:1 do not currently have any effect. 

The Graphics Frame 
The Graphics Frame specifies what sort of graphics is drawn in the AutoCAD 
environment. 

 

No Graphics is an option that can be used for blocks that are not visually displayed - 
such as parts. 

An example would be an associated block (such as a bolt or castor) which doesn’t need to 
have graphics, but can still be included in reports. 

The 3D and 2D checkboxes no longer have any effect. 
The drop down list is used to specify the shape of the merchandisable area for fixture 
type blocks. 
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 Rectangular is the default setting and should be used for all blocks of basically 
rectangular shape. 

 Circular can be used for all blocks with a circular profile. 

 Semi-circular can be used for all blocks with a semi-circular profile 
 Triangular caters for all blocks with an irregular profile. The functionality allows 

the user to draw an outline representing the merchandisable surface for the 
block. 

Note: the method for drawing the extents of the shelf is 
covered in more detail later on in this section. 

The Working/Stacking Axes Frame 
The Working and Stacking Axes determine how products align and stack respectively 
on shelves in the Virtual Reality environment. 

They do not affect product placement in the Planner environment as products are 
represented by placeholders. 

 

Working Axis 
The Working Axis defines the directions products can be aligned on. 

 

 If the X axis is checked, products may be aligned along the length of the block. 
 If the Y axis is checked, products may be aligned over the depth of the block. 

 If the Z axis is checked, products may be aligned relative to the height above the 
block. 

The working axes selected have to be appropriate to the equipment. 

 For pegs the Y working axis has to be enabled, as product has to be aligned along 
the length of the peg. 

 For peg boards the X and Z working axes have to be enabled as products have to 
be aligned in a vertical place. 

 For chest freezers the X and Y working axes have to be enabled as product has to 
be aligned over the bed of the unit. 
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Note: If only some of the working axes are checked, then not 
all the alignment commands will be enabled in 
Merchandiser. 

In the example shelf below, only the X Working Axis has been enabled. Product can 
therefore be aligned along the length of the shelf, but not relative to its depth and height. 

 

Stacking Axis 
The Stacking Axis determines the directions products can be stacked in. 

If only some of the Working Axes have been checked, the Stacking Axes can be used to 
allow product to be stacked in more directions than they can be aligned. 

 

 If the X axis is checked, products may be stacked along the length of the block. 

 If the Y axis is checked, products may be stacked down the depth of the block. 
 If the Z axis is checked, products may be stacked vertically. 

In the example shelf below, stacking has been enabled in the X, Y and Z planes, allowing 
product to be stacked in both horizontal and the vertical directions. 

 

The Area Calculation Directions Frame 
The Area Calculations Direction Frame is used to set the directions that the area 
calculation function uses when establishing the area apportioned to the fixture. (Fixtures 
and shelves are not used in area calculations). 
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Note: Area calculations are initiated from the Calculations 
menu in the Planner and Merchandiser menus. They allow 
users to take into account the amount of aisle apportioned to 
the fixture. For example a fixture 4 feet long by 2 feet deep 
would have a foot print of 8 square feet. Area Calculations 
might assign a total area of 30 square feet to the fixture. 
Using this area for reporting purposes is more representative 
than the footprint, for example reporting on sales per square 
foot would take into account the size of the aisle in front of 
the fixture. 

 

Area calculation works by "feeling" out from the object in the specified directions. The 
starting point is the 'Front' direction of the fixture - this is specified in the Insertion tab. 
The check boxes that are then ticked should be appropriate to the function of the object. 
A wall mounted fixture might have West, South and East ticked - feel out in front and to 
the sides. A freestanding display podium might have all directions checked because 
customers could approach from all points of the compass. 

Reporting Options Frame 
The Reporting Options Frame allows the user to specify whether the Block Definition 
should be excluded from reports or the central database. 

 

Not all blocks need be included in a report, for example Title Blocks and some symbols 
such as directional arrows. It may also be that is no need to store instances of a certain 
type of block in a database, for example Reference blocks, so there will not a record in the 
Fixtures table to represent the block. 

Exclude from Reports is a check box that can be used as a flag. This flag can then be used 
as a filter to exclude items in a report. 
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Exclude Instances in DB is a check box allowing the user to exclude information from 
the drawing being stored in the database during a save. 

Note: If you exclude instances of a block from the database, 
then it will also be ignored when rebuilding the drawing 
from the database. 

Exclude Attributes would allow certain attributes of the Block Definition to be excluded 
from being stored in the central database. 

This option is not enabled in this implementation of Macro Space Management. 

Include in Fixture Annotation turns on annotation in the Planner module. If this option 
is checked, the block will be annotated according to options set in the Text styles option 
(Planning menu) in the Administration module. 

Non-Rectangular Merchandisable Areas 

Overview of Non-Rectangular Merchandisable Areas 
Most fixtures or shelves are rectangular or semi-circular in section. Occasionally 
however, fixtures or shelves are less regular in shape. Fixture Studio provides a way of 
delineating the boundary of an irregularly shaped merchandisable area. 

 

This is achieved by using functionality accessed on the category tab of the Block Details 
dialog box in Fixture Studio. The steps are as follows: 

 Open Fixture Studio and Planner. 

 Select the Connect to AutoCAD option on the file menu. 

 Open the required object for editing in Fixture Studio (Block Details dialog box). 

 Set the shape to Triangular on the Category tab and click the Pick button - this 
will open a raw AutoCAD drawing in with the extents of the object outlined in 
yellow. 

 Use the Load Blocks into Drawing command on the File Menu to load an 
instance of the block into the drawing. 

 Draw the shape of the object in the drawing. 

 Delete the instance of the block in the drawing 

 Close the temporary drawing without saving it. 
 If necessary reset the dimensions of the fixture using the Calculate button. 
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 Save the Block in Fixture Studio. 

The result has associated a boundary with the block that defines the horizontal contours 
of the merchandisable area. The block will then only accept merchandise within that 
defined area. 

 

Note: how to configure Merchandisable Areas for non-
rectangular areas is described in the section for the 
Merchandisable areas tab. 

Creating a Non-Rectangular Area 
In order to create a non-rectangular area, select the Connect To AutoCAD option on the 
file menu. This will connect Fixture studio to the Planner module. Next open the block 
for editing (Block Details dialog box). 

Switching to AutoCAD 
In the Category Tab of the block Details dialog box select Triangular from the drop down 
list. This will make the pick button next to it active. Click the pick button and the user 
will be taken to the Planner module where a 'raw' AutoCAD drawing will open. 

 

The raw AutoCAD drawing will have a yellow rectangle in it. This represents the extents 
of the block. Its origin will be at 0,0 in the drawing. 
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Loading the block into the Raw AutoCAD Drawing 
In Fixture Studio, highlight the block in the fixture hierarchy and select the Load Blocks 
into Drawing option from the File Menu. The block will be drawn with its insertion point 
at 0,0, overlaying the yellow rectangle representing the extents. 

 

Drawing the Shape of the Irregular Area 
Using the fixtures as a guide, draw in a boundary representing the area that can be used 
for merchandising purposes. 

Note: AutoCAD's OSNAP functionality is useful for this. 

 

The boundary should be drawn with a polyline and the Close command should be used 
to ensure that the boundary is a single continuous line. 

Note: The outline here has been drawn in red for clarity - 
normally it would be the same color of the block. 

Next, delete the instance of the block from the drawing, leaving behind the outline of the 
irregular area. 
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Close the AutoCAD drawing without Saving 
The next action is to close the AutoCAD drawing without saving it. This may sound 
counter-intuitive, but Fixture Studio has stored the coordinates for the outline in 
memory. Closing the drawing may be down by clicking the small 'x' at the top right 
corner and then stating you do not wish to save the drawing when a confirmatory dialog 
box appears. After the confirmatory dialog box has gone, the AutoCAD drawing may not 
immediately close. This is because if the boundary of the non-rectangular area has been 
drawn inside the extents of the block (for example for a fixture), Fixture Studio will 
change the extents of the block. This will be confirmed by a dialog box. 

  

Click the OK button and the AutoCAD drawing will close. To reset the extents of the 
block back to the original value, click the Calculate button in the Actual Size frame of the 
Size tab. 

 

Save the Block in Fixture Studio 
The final stage is to save the block in Fixture Studio. This is done by highlighting the 
block in the fixture hierarchy and selecting the Save option from the file menu. 

Note: how to configure Merchandisable Areas for non-
rectangular areas is described in the section for the 
Merchandisable areas tab. 
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Insertion Tab 

Overview of the Insertion Tab 
The Insertion Tab is used to specify a number of details affecting how the block is 
inserted into the drawing. 

 

The Layers Frame 
The Layers Frame specifies the Layer on which the Block will be inserted when placed in 
a floor plan in the Planner or Merchandiser modules or in In-Store Space Collaboration. 
Each block must be assigned to a specific layer. 

Note: Layers are configured in the Layers and Aliases dialog 
box in the Planner module - see the Store Planning User 
guide for more information. 
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In a simple example, Macro Space Planning might be configured to have Zone, Fixture, 
Fitting, Shelf, Product and Annotation layers. Fixtures, fitting and shelves would then be 
configured to be inserted on the appropriate layers. Within the Planner or Merchandiser 
modules or in In-Store Space Collaboration, these layers can then be turned on, turned 
off, locked or unlocked, enabling users to control the use and visibility of those objects. 

The Levels Frame 
The Levels Frame determines what elevation the Block is inserted in the drawing. 

 

These levels are configured directly in the AVTTB_LEVELTYPE table. This can only be 
done by Administrators with access to the database. An example of configured levels is 
given below. 
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Each level represents a physical height at which equipment can be inserted in the 
drawing. These levels are relative to the floor level or to some other level. For example, 
the Ceiling Datum is set to be 240 inches (20 feet) above floor level, while the Banner level 
is 120 inches (10 feet) below ceiling level. 
Items of equipment can then be assigned appropriate levels. For example: 

 Fixtures and major fittings are typically inserted at floor level 

 Posters would be inserted at Post Level, which has been defined as 42" (3.5 feet 
above floor level). 

 Shelves would be inserted at Undefined level as their elevation will vary. 

The Front Direction Frame 
The Front Direction represents the side of the fixture that has been designated as the 
front of the fixture. This can be visualized as the direction the customer will approach the 
fixture from. It also determines the default orientation of any shelves and merchandise 
that might be placed on the fixture. 

 

The Front Direction Frame 111 



Insertion Tab 

 

  

Note: When assigning block details, it is strongly 
recommended that all blocks be initially defined with the 
same Front Direction. If front directions vary from block to 
block, this will lead to confusion when blocks are inserted in 
the drawing or formed into gondolas. 

The Placement Frame 
The Placement Frame enables two forms of mounting options to be specified. 

 

Space Mounted means this block can be inserted into any floor space. 

Wall Mounted means this block can be attached to a wall on insertion. 

The Insertion Position Frame 
The Insertion Position is a position specified within Macro Space Management that 
matches the insertion position created when the associated graphic for the block was 
drawn in AutoCAD. 
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Note: The Insertion Position specified within Macro Space 
Management is passive – changing the Insertion Position 
does not change the position of the graphical insertion 
position created when the graphic was drawn. 

It is important that the fixture Studio insertion point matches the insertion point already 
defined in the graphic. If they do not match, then the graphic will be inserted into the 
AutoCAD and Merchandiser environments at a position that differs from the correct one. 
This in turn will result in problems with adjacency calculations, placing of associated 
equipment and products, etc. 

 

There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (blue circles) and bottom (yellow circles). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. 

Note: A consistent convention should be adopted for the 
position of the insertion point. If all blocks are drawn using 
this convention, then the potential for misalignment is 
sharply reduced. 
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 In the above example, the insertion position (blue square) is bottom-back-left, with the 
radio button in the Insertion position frame set accordingly. 

 

  In the above example, the insertion position (blue square) is top-front-right, with the 
radio button in the Insertion position frame set accordingly. 

The Child Insertion Position Frame 
The Child Insertion Position Frame enables the Child Insertion Position to be specified. 
The Child Insertion Position is the datum point at which an item of merchandise at 
Display Style level is inserted onto a fixture or shelf object in the Merchandiser module. 

 

There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (blue circles) and bottom (yellow circles). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. 
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An item of packaging going onto a shelf would generally have its child insertion position 
set to bottom-back-left. 

 

Each layer contains nine possible insertion points ranging from left rear to front right. 
The required option can be selected by clicking on the appropriate radio button. 
The position the first product will be inserted can be seen in the Preview Tab if the First 
Product Option is checked. 

The Insertion Options Frame 
The Insertion Options Frame specifies how the block will behave on being inserted into 
the AutoCAD environment. 
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Rotate Attribute, when enabled, ensures any non-constant attributes on the block will be 
rotated so they are upright and readable. An example might be a text tag associated with 
a block. If the block is inserted in an orientation where the text would otherwise not be 
readable, the text will be rotated so it becomes visible. 
The Explode Block on Insert option, when enabled, results in the block exploding into its 
constituent parts on insertion, so they can be manipulated separately. 

Adopt Layer is no longer in use and has been included so as to be compatible with earlier 
versions of Macro Space Management. 
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Size Tab 

Overview of the Size Tab 
The Size Tab is used to specify the maximum length, width and height of a fixture. 

 

It contains three frames. 

1. Actual size is the maximum dimensions of the block 

2. Size details contains information on the ranges of permissible sizes. 

3. Nominal Dimensions are the volume the fixture will occupy once all equipment has 
been added to it. 

Overview of Block Sizes 
Blocks fall into two main types when sizes are concerned. 
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Options 

Fixed Size 
These are specified in the Actual Size frame. They have a single, fixed sized that cannot 
be changed by store planners. 

Stretchable Blocks 
These are specified in the Size details frame. Here, a Size Rule can be associated with the 
block, allowing the block to take up a range of sizes in a floor plan. Such blocks are called 
Stretchable blocks. Stretchable blocks can be used: 

 To represent a fixture that exists in a range of sizes. In this instance one block 
could be used to represent a dozen fixtures. 

 To represent obstructions like columns in a floor plan. In this event, one block 
could be used to represent a column of any size. 

Implementation and Reporting 
Representing fixtures using stretchable blocks has advantages and disadvantages. It 
makes it easier to create and maintain the fixture and gondola libraries because fewer 
blocks are required. In addition, it may be possible for store planners to place a fixture in 
a combination of sizes that does not exist in practice. This will lead to problems when 
equipment is ordered in order to put a floor plan into service. In addition, reporting bills 
of materials, etc, becomes more complex if stretchable fixtures are used. This is because 
the report must now identify the fixture sizes and use a 'look up' list to relate that to a 
part number. 

The Actual Size Frame 
The Actual Size Frame specifies the default size for the block. If no details are entered in 
the associated Size Details frame, the Actual Size frame specifies the only permissible set 
of dimensions that can be used. 
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Details may be entered in three ways: 

Entry Methods 

Direct Entry 
If the actual dimensions are known, they can be manually entered into the pertinent text 
boxes. 

Calculate 
For this option to work, Planner must be open, the Connect to AutoCAD option must be 
selected on the File menu and the floor plan in Planner that Fixture Studio is connected to 
must contain an instance of the block for which the sizes are to be calculated. Clicking the 
Calculate button will then return the maximum Length, Depth and Height of the block. 

Pick 
For this option to work, Planner must be open, the Connect to AutoCAD option must be 
selected on the File menu and the floor plan in Planner that Fixture Studio is connected to 
must contain an instance of the block for which the sizes are to be calculated. Clicking the 
Pick button for a specific dimension will take the user to the Planner drawing. The user 
will then be invited to pick two points - for example by using AutoCAD's OSnap option. 
On clicking the second point, the user will be returned to Fixture Studio and the 
dimension automatically entered in the text box. 

Gondolas 
The Actual Sizes are used when placing instances of gondolas. It is important these sizes 
are accurate or the gondola may have parts that overlap or have gaps between them. For 
example, if a fixture has an actual length of 35 inches and a nominal length of 36 inches, it 
is important to use the actual length. 

In-Store Space Collaboration 
Macro Space Management may have a sister application installed: In-Store Space 
Collaboration. In-Store Space Collaboration uses the X, Y and Z dimensions in the Actual 
size frame. It is important these sizes are accurate or fixtures and fittings drawn in ISSC 
will overlap or have gaps between them. For example, if a fixture has an actual length of 
35 inches and a nominal length of 36 inches, it is important to use the actual length. 

The Nominal Dimensions Frame 
The Nominal Dimensions frame is used to associate a set of nominal dimensions to a 
fixture. 

The Nominal Dimensions Frame 119 



Size Tab 

 

Nominal dimensions are primarily used for primary fixtures, where attached secondary 
equipment will substantially increase the volume. 

For example, consider a backpanel 600 mm long, 1900 mm high and 5 mm deep. If this 
backpanel has shelves attached, it will eventually occupy a significantly larger space. 

It could therefore be assigned nominal dimensions of 600 mm long, 1900 mm wide and 
300 mm deep to allow for the eventual shelves. 

Tip: Any product or placeholders put onto a fixture with 
nominal dimensions will occupy a volume that corresponds 
to the larger of the Actual and Nominal Sizes. 

Overview of Size Groups and Size Rules 

Terminology 

Size Group 
A Size Group allows sizes to be collected into similar within a hierarchical tree of sizes. 

Size 
A Size contains definitions of all permissible dimensions that can be assigned to a block. 

Size Rules 
Size rules are the settings or combinations of settings that determine the definitions of 
dimensions permitted when assigned to a block. 

Overview 
Blocks that are assigned multiple possible dimensions conform to size rules. 
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A Size is a set of definitions (size rules) as to what sets of dimensions are allowed for a 
block that has been assigned to that size group. 

When any Block is assigned to a size, it inherits the set of size rules associated with that 
size group. 

When the Block is inserted into the drawing, a dialogue will appear showing the 
dimensions permitted by the size rules. 
A specific set of dimensions can be selected from those available, and the block is 
inserted into the drawing (or Virtual Reality environment) with those dimensions. 

Size Operations 

 

Sizes can be created. This means that a set of size rules is defined and stored within a 
named size group. 
Sizes can be edited. The existing set of size rules is changed to a newly defined set. In the 
process, any blocks that reference the Size Group being edited will have their size rules 
changed to the edited version. 

Sizes can be deleted. When a Size is deleted all blocks that reference that Size will have 
their associated size rules removed and will require assigning to an alternative size 
group so that their size rules can be redefined. 

Overview of Size Groups and Size Rules 121 



Size Tab 

Block Operations 

 

Various operations can be carried out to assign blocks to Sizes. 

Create Size results in a block being associated with a Size. The block may either be 
associated with an existing size group, or a new size group can be defined. 

Edit Size results in the Size associated with that block being edited. 

Note: It is the Size that is being edited, and not the Block 
Definition. Changes made to the Size will affect ALL blocks 
that reference that Size, and not just the block that is having 
its definitions set. 

Delete Size removes the Block Definition it currently references.   

It does not delete the Size itself, but just removes the link between Size and Block 
definition. 

Note: Use of Sizes in this manner is implemented in In-Store 
Space Collaboration, but is not yet fully implemented in 
Macro Space Management. 

The Size Associations Frame 
The Size Associations frame is used to allocate blocks to specific Size Groups. 
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A Size Group contains details of the size rules that govern the dimensions for a Block 
Definition. 

Size Groups can be configured in a number of ways. 

Size Details Frame 

Creating Association to Size Group 
When a block can be assigned multiple dimensions, it needs to be associated with a Size 
Group. The block will then adopt the size rules associated with that Size Group and 
hence will have a range of permissible dimensions assigned to it. 

 

The process is started by clicking on the Create Option. This brings up the Sizes dialogue 
box. 

 

This gives two options, Create new size or Select from existing. These are selected by 
using the appropriate radio button. 
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Note: Size Groups can have varying purposes: Stretchable 
could describe the size rules for fixtures that are to be made 
stretchable and Square or Circular could describe fixtures 
that must preserve that class of dimensions. 

Similarly, Lozier or Hussmann could describe sets of dimensions specific to those 
manufacturers. 

Create New Size 
Selecting this option brings up the Sizes dialogue box. 

 

This can be configured to set the size rules. 

Select from Existing 
Select from Existing associates the block being defined with an existing set of size rules. 

 

124 



Fixture Studio User Guide 13.3.2 

Selected sizes 
When the required Size Group has either been Created or Selected and the OK button 
clicked, the associated size rules will be assigned to the block definition and will appear 
in the Size Associations frame. 

 

Editing Size Group 
Clicking on the Edit button enables the user to Edit the Size Group details. 

 

This brings up the Size dialogue box so that the size rules can be changed. 

 

Note: This operation edits the size rules, not the dimensions 
for the block being defined. 

Editing the size rules will affect ALL blocks currently associated with that set of size 
rules. 
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Removing Size Group Association 
Removing a Size Group association can be achieved by clicking on the Remove button. 

 

This removes the link to the size group (and its associated size rules) but it does not 
delete the Size Group itself. The Size details frame will then show that no Size Group has 
been associated with this particular block. 
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Connections Tab 

Overview of the Connections Tab 
The Connections Tab lets the user specify the connection options for Macro Space 
Management blocks. These are used within the Planner and Merchandiser modules. 

The Planner Module displays basic left/right/rear connection points allowing fixtures 
and fittings to be accurately aligned relative to each other. The Merchandiser model 
allows more complex use of connections, including additions of small items of 
equipment such as grilles to shelf objects. There connection settings also act as the 
defaults in the Add Shelf dialog box in the Merchandiser module. 

Note: Gondolas provide a more efficient way of placing 
large numbers of items of equipment in a fixed alignment. 

 

A small Toolbar at the top lets users Add, Copy and Delete connections, while the 
Wizard on the toolbar allows the user to add three basic connections. The Connections 
List below lists all current connections for the Macro Space Management Block. 
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Highlighting an individual connection enables the lower part of the tab - which allows 
the details of the connection to be configured. 

The Connections Tab and the Configuration Module 
Settings in the Configuration Module (File menu > Configure) can affect how connection 
points appear in the Preview tab the Block Details dialog box of Fixture Studio. They also 
affect how connection points appear and behave in the Merchandiser module. 

 

Gender Filter, Size Filter and Shape Filter determine whether the Genders, Sizes and 
Shapes of two connection points have to be compatible before they can 'snap together'. 

Pointer Size and Line Size affect the appearance of the connection points as displayed.  
Colors for Neutral, Male and Female connection points can also be set. 

These settings have local effect - changing one user's settings will not affect other users. 

The Connections Toolbar 
The Connections Toolbar is found to the upper left of the Connections Tab. 

It allows users to Add, Copy and Delete Connections. It also allows the user to invoke the 
Connections Wizard. 
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Add a Connection 

 

Copy a Connection 

 

Delete a Connection 

 

Connection Point 
Wizard 

Connection Options 

Add a Connection 
Clicking on the Add a Connection icon causes a line to be added to the Connections List 
ready for further details of the connection to be added. 

 

See the information on Connection Lists for how to configure the connection. 

Copy a Connection 
Clicking on the Copy a Connection icon causes an existing connection to be copied to the 
Connections List. This enables users to copy an existing connection configuration and 
then save it with small changes. 

 

Before clicking the Copy icon, highlight the connection to be copied. Clicking on the icon 
will bring up the connection naming dialogue box. 

 

Edit the name to one suitable for the new connection. On clicking OK, a duplicate 
connection will be added, save for the changed name. 
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Delete a Connection 
To delete a connection, highlight the connection to be deleted and click on the Delete 
icon. The User will be asked to confirm deletion. 

 

Connection Wizard 
The Connection Wizard is discussed in its own section.   

The Connections Wizard 
The Connections Wizard can be invoked from the Wizard icon in the toolbar in the 
Connections Tab. It adds a set of basic connection points that allow fixtures to snap to 
each other in the Planner and Merchandiser modules. 

 

This will bring up the Connections Wizard dialogue box. 
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 Checking the Add connection on Left checkbox will add a Connection on the left. 

 Checking the Add connection on Right checkbox will add a Connection on the 
right. 

 Checking the Add connection at Back checkbox will add a Connection at the 
back. 

The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default. 

The Back connection has no gender, so it will attach to any other connection. 

Checking the Clear Existing Blocks checkbox will remove any existing connections. 

On clicking OK on the Wizard, the selected default connections will be added. 

 

The Type Frame 
The type frame allows the user to specify whether the selected item is to be used as a 
physical connection point or as the anchor for instance specific text for the block. This 
option is set by the radio button. In addition, the selected connection can be designated 
as the Default by ticking the check box. 

 

If the Text Reference Point option is chosen, a new version of the Connections Tab 
appears. This can be used to attach text to a block in Planner. 
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Options 

Position Frame 
The position frame is used to specify the position the text will appear. 

Note: The pick button is not fully functional at present. 

Text Justification Frame 
The Text Justification frame allows the user to pick a text style from the drop down list. 
This list is configured using the Planning > Text Styles option in the Administration 
module. The radio buttons enable the user to specify the position of the text relative to 
the coordinates specified in the position frame. 

Horizontal Angle Frame 
This allows the user to specify the angle at which the text will be drawn relative to the 
block. 
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The Filters Frame 
The Filters Frame enables the user to set parameters that can later be used as filters to 
decide whether two connection points are compatible or not. 

Note: Which is these filtering options is active in a floor plan 
in Merchandiser is determined by settings in the Fixturing 
tab of the Configuration module. 

 

Options 

Gender 
The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and neutral. They are selected from by 
means of the radio button. 

  Can connect with 

Male Female Neutral 

Female Male Neutral 

Neutral Any other connection 

Shape 
The Shape of a point connection can be specified from the drop down list. The shape is a 
theoretical concept and can be any convenient name - like connects with like. All shapes 
can connect with the 'None' option.   
The list of shapes available can defined in the AVTTB_CONNECTION_SHAPE table in 
the database - this can only be done by Administrators. In the example below, the 
'Shapes' have been changed to text entries for specific types of connections. 
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Size 
A maximum and minimum size for the connection can be set using the spin controls.  A 
pair of connection points must have compatible sizes to connect together. 

If the Match checkbox is ticked, then the connections must have identical maximum and 
minimum sizes. If they are not identical, the connections will not mate. 
If the Match check box is not ticked, then the connections must have overlapping size 
ranges. If they are not overlapping, the connections will not mate. 

  Connection 1 Connection 2   

Size Range 0 - 50 25 - 75 Compatible 

Size Range 0- 25 50 - 75 Incompatible 

  

The Position Frame 
The Position Frame is used to set the origin of the connection point. 

 

Position Frame 
The position frame is used to specify the position the text will appear. 

Note: The pick button is not fully functional at present. 

The Array Frame 
The Array Frame is used when it is desired to produce a connection line, plane or box. 

 

There are three options: 
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 Setting up spacing in a single dimension results in a line of connection points. 

 Setting up spacing in two dimensions results in a two dimensional array of 
connection points. This would typically be in the X-Z plane which would result 
in an array of points parallel to the back of the fixture. 

 Setting up spacing in three dimensions would result in a cuboid of connection 
points - it is difficult to think of circumstances when this would be required. 

 

The above examples show the three options. 

Options 

Spacing 
This specifies the distance between successive points. 

Tip: If set to 0 a connection line will be drawn. This allows 
attachment at any point along the line, rather than at specific 
connection points. 

Max Extents 
This specifies the dimension in that particular plane. It is drawn relative to the position 
point specified in the Position frame. 

Tip: Once a value has been entered, clicking on the calculate 

icon will give the maximum distance the connection 
points can extend. 

The Horizontal and Vertical Angle Frames 
The Horizontal and Vertical Angles are used to control the direction of connection 
points, irrespective of whether they are assigned as a point, as a line or as a plane. 
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Changing the Horizontal Angle changes the direction the designated connection point 
faces over the floor. 

Setting it to 0 degrees will make them face east; setting to 180 degrees will make them 
face west. 
Setting the Vertical Angle affects whether the connection points are horizontal or face up 
or down. 

Setting to 0 degrees will result in the connections being horizontal, 90 degrees pointing 
vertically up and 270 degrees vertically down. 

Note: Setting to 180 degrees will result in the connection 
point turning upside down and facing in the opposite 
direction. Please use caution when using this option.   

Connections Examples 

Connection Points for a Shelf 
Shelves might be attached to a back panel. This worked example is for a back panel 36 x 1 
x 72 inches in size. 

Settings 
The first example is for a connection line 
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Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Female - this means that the connection point on the 

corresponding shelf will be set to male to make the connection compatible. 

 The shape is set to slot/shelf. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database). 

 The Size has been set to 10 and the Match option selected. 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be on the left edge of the back panel, so the X coordinate is 
set to 0. 

 The connection will be in the front face of the back panel, so the Y coordinate is 
set to -1 (bring it forward by one unit). 

 The shelves will start 6 inches up from floor level, so the Z coordinate is set to 6. 

Array Frame 
This connection line is being configured in the vertical (Z) plane, so we are only 
interested in the Z data. 

 The spacing is set to 0 so this will be a continuous line. 
 The Max extent is set to 60. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection line will start 6 inches from the base 

– The connection line should stop 6 inches from the top. 
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– 72 inches - (6 inches + 6 inches) = 60 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points 
This example is similar to the first example except that the spacing has been set to 6 
inches for the Z axis in the Array frame. This has resulted in a series of connection points 
rather than a connection line. 

 

Connection Lines for a Slatwall 

Note: Please refer to the worked example for connection 
points for a shelf before attempting this example. 

Varying shelf objects such as rods and pegs might be attached to a slatwall. This worked 
example is for a slatwall 36 x 1 x 72 inches in size. 
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Settings 

Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Female - this means that the connection point on the 

corresponding rod will be set to male to make the connection compatible. 

 The shape is set to slot/shelf. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database). 

 The Size has been set to 20 and the Match option selected. (This differs from the 
setting for Shelves to enable filtering options to work). 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be three inches in the left edge of the back panel, so the X 
coordinate is set to 3. 

 The connection will be in the front face of the back panel, so the Y coordinate is 
set to -1 (bring it forward by one unit). 

 The shelves will start 6 inches up from floor level, so the Z coordinate is set to 6. 

Array Frame 
This connection lines are being configured in the horizontal (X) and vertical (Z) planes.   

 The Z spacing is set to 6 so the lines will be 6 inches apart in the vertical plane. 

 The X spacing is set to 0 so this will be a continuous line. 

 The Max X extent is set to 30. This is calculated as follows: 

– The width of the fixture is 36 inches. 
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– The connection line will start 3 inches from the left hand edge. 

– The connection line should stop 3 inches from the right hand edge. 

– 36 inches - (3 inches + 3 inches) = 30 inches. 

 The Max extent is set to 60. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection lines will start 6 inches from the base 

– The connection lines should stop 6 inches from the top. 

– 72 inches - (6 inches + 6 inches) = 60 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points for a Pegboard 

Note: Please refer to the worked example for connection 
points for a shelf before attempting this example. 

Varying shelf objects such as pegs might be attached to a peg board. This worked 
example is for a peg board 36 x 1 x 72 inches in size. 

 

Settings 

Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Male - this means that the connection point on the 

corresponding rod will be set to female to make the connection compatible. 

 The shape is set to peg/pegboard. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database). 
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 The Size has been set to 5 and the Match option selected. (This differs from the 
setting for Shelves to enable filtering options to work). 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be three inches in the left edge of the back panel, so the X 
coordinate is set to 3. 

 The connection will be in the front face of the back panel, so the Y coordinate is 
set to -1 (bring it forward by one unit). 

 The shelves will start 18 inches up from floor level, so the Z coordinate is set to 
18. 

Array Frame 
This connection lines are being configured in the horizontal (X) and vertical (Z) planes.   

 The X spacing is set to 6 so the lines will be 6 inches apart in the horizontal plane. 

 The Y spacing is set to 6 so the lines will be 6 inches apart in the vertical plane. 

 The Max X extent is set to 30. This is calculated as follows: 

– The width of the fixture is 36 inches. 

– The connection points start 3 inches from the left hand edge. 

– The connection points should stop 3 inches from the right hand edge. 

– 36 inches - (3 inches + 3 inches) = 30 inches. 

 The Max extent is set to 48. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection lines will start 18 inches from the base 

– The connection lines should stop 6 inches from the top. 

– 72 inches - (18 inches + 6 inches) = 48 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 
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Parts Tab 

The Parts Tab 
The Parts Tab is used to improve the accuracy of reporting. A fixture can be represented 
by a single block in a floor plan. However the real life fixture may be more complex and 
made up from a number of parts such as uprights, cross-bars, castors and securing bolts. 
It is therefore possible to create a block and associate parts with it. When a report (such 
as a bill of materials) is run on a floor plan, that report can then be expanded from a list 
of parts to a list of required sub-components. 

 

Note: Part blocks do not need graphics files - they will not be 
inserted into a floor plan. 

Options 

Available Parts 
The Available Parts Frame contains a list of all blocks held in the database. This will 
include (for example) fixtures and fittings as well as blocks of type 'part'. 
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Associated Parts 
The Associated Parts Frame contains a list of all parts and part quantities associated with 
that particular block. 

Creating Part Blocks 
Part Blocks are specialized type of block that have no graphics and exist only within the 
Macro Space Management database. Their only use is for reporting purposes. 

Note: It is recommended that Part Blocks are kept in specific 
and separate Groups within the Fixture Studio Hierarchy. 

Only a few basic parameters need to be defined - although more can be set if needed for 
detailed reporting purposes. 

Steps to Create 

Category Tab 

 

After inputting an appropriate block name and description, for the Category Tab, set the 
following: 

 Set Equipment type to Part 

 Ensure Effective and Expiry dates are set appropriately. 

 Select the Part Icon. 
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Insertion Tab 

 

For the Insertion Tab, select a nominal layer. 

Note: A layer is not necessary for a block that is to be used 
purely for reporting purposes, but Macro Space 
Management will not allow the block to be saved until one 
has been set. 
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Size Tab 

 

Unless it is necessary to have accurate dimensions, set nominal values in the Actual size 
frame. 
The block can then be saved to the database. 
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Building up a Parts List 
The Parts List can be added to and edited using the arrows in the center of the Parts Tab. 

 

Steps to Build Up List 

Available Parts 
The Available Parts Frame contains a list of all available parts. Block Names, and 
Description can be sorted in ascending or descending order by clicking on the column 
header. 

Associated Parts 
The Associated Parts Frame contains a list of all parts associated with that particular 
block. In the above example, the Podium is made up of a Top and Frame. 

Quantities, Block Names, and Description can be sorted in ascending or descending 
order by clicking on the column header. 

Building and Editing a Parts List 
To add a part to the Associated Parts list, highlight the part in the Available Parts frame 
and use the Add arrow. 

 
Alternatively highlight and double click on the part in the Available Parts frame. 
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To remove a part from the Associated Parts list, highlight the part in the Associated Parts 
frame and use the Add arrow. 

 
Alternatively highlight and double click on the part in the Associated Parts frame. 

Changing the number of a specific part 
To change the number of a specific part in the associated parts list, highlight the required 
part then left click on the number itself in the Qty column. 

 

The number can then be edited. Press <Return> to store the number. 

 
 
 
 
 
 

148 



 

20 
Fixture Tab 

The Fixture Tab 
The Fixture Tab is used to specify the behavior of shelving and the Product Block for a 
fixture. 

 

The Fixture Frame 
The Fixture Frame allows some details of how the fixture is to be merchandised to be 
specified. 
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Note: Vertical Category and Tierage have been largely 
superseded by Styles in Macro Space Management. 

Options 

Vertical Category 
Vertical Category allows the aliased layer to be occupied by the fixture to be further sub-
divided. The default is 0, but fixtures can be assigned to further vertical categories within 
the aliased layer. For example, TV’s could be assigned to Vertical Category 1; CD Players 
to Vertical Category 2... 
Setting the Vertical Category affects Adjacency calculations – fixtures in different Vertical 
Categories will not be shown as adjacent. Setting the Vertical Category also affects 
annotation – if Vertical Categories are set, each category will receive its own separate 
annotation. Finally, setting Vertical Categories affects the reporting options – material in 
different categories can be reported separately. 

Tierage 
Tierage is used when the fixture has distinct merchandisable levels rather than shelves. 

 

Examples of fixtures that have tiers are those used to display magazines or perfumes. 

If the Fixture has shelves, the Tierage value should be left set to 0. 
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If the fixture has tiers rather than shelves, then the number of tiers should be specified. 

Note: There are two ways of assigning a Product Base to a 
tiered fixture. 

The product base can be designed such that a single product base fits the tier structure. In 
this case the entire fixture can be merchandised, but only with a placeholder indicating a 
class of product, for example cards or lipsticks. 

Alternatively, each tier can be defined as a Merchandisable Area in the Merchandisable 
Areas tab. Each tier can then have a product base assigned to it. This would allow more 
specific placeholders to be used. For example CD’s with artist's names beginning with A 
& B would be placed on the upper tier. 

The Product Block Frame 
The Product Block Frame allows the details of the Product Block to be assigned to the 
Fixture. 

 

Note: If a product block has not been specified for a fixture 
or shelf, it will not be possible to merchandise that item of 
equipment with a placeholder. 

Product Blocks assigned in this frame are used to act as indications of the dimensions 
that can be merchandised when placeholders for a general class of product (for example 
shoes or canned goods) are assigned to the fixture. 

The default Product Block is BASE, which is a simple rectangular block but other product 
blocks can assigned. For example a round product block would be assigned to a table 
top, and a stepped product base would be assigned to a display cabinet with tiers. 

The Shelving Frame 
The Shelving Frame is used to set parameters affecting the behavior of shelves on a 
fixture. 
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Note: This functionality has now been largely superseded by 
connections. If specified, connection lines will overwrite this 
spacing. 

Slot Spacing gives the distance between successive shelves. 

First Slot Number gives the height of the initial shelves. 
Measure from Bottom and Include First Shelf are not active in this implementation of 
Macro Space Management. 

About Merchandisable Areas, Product Blocks and Display Styles 

Options 

Merchandisable Areas 
A merchandisable area is an irregular cube shaped space associated with a specific 
fixture or shelf object. It delineates the volume relative to the dimensions of that object 
that can be filled with product. 

Note: Merchandisable areas are defined within the 
Merchandisable Areas Tab in the Block Definitions dialogue 
box. 

The merchandisable area is defined by specifying the two points that represent opposing 
corners of the cuboid. Accordingly, the geometry is simple and inflexible. 

Placeholders and Display Styles 
In the AutoCAD environment, all merchandise is displayed using placeholders. 

In the Virtual Reality environment, there are two forms in which merchandise can be 
displayed. 
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At Article (SKU) level and above, they are displayed in the form of placeholders, which 
indicate that a particular form of merchandise has been used to populate that section of 
the store. 

Placeholders are simple geometrical shapes (such as cubes and cylinders) and have no 
surface detail. 

At Display Level, a product block containing a more detailed physical representation of 
the product is placed, the amount of detail depending on local settings. 

 

In the above example, the lower shelf is populated with a placeholder; while the upper 
shelf has products displayed using three types of display style product blocks. 
(The plates are shown as graphical style product blocks, the boxes on the left as simple 
boxes and the boxes on the right as textured boxes. 

Product blocks for Fixtures and Shelf Objects 
Because the merchandisable area is of simple geometry, fixtures and shelf objects need to 
have default product blocks associated with them in their block definitions. 

These default product blocks can be of more complex shapes, for example cylinders, 
hemispheres, hexagons, etc. Only a single design of each class of product block is 
required as their dimensions are scaleable. 

When placed on a fixture or shelf object product blocks expand to the maximum 
dimensions permitted by the merchandisable area. Thus a single cylindrical product 
block can be used for wide range of fixtures and shelf objects. 

The Product Block will subsequently be used to define the volume occupied by a 
placeholder. 

For example, a circular table must still have a cubic merchandisable area defined, as all 
merchandisable areas have to be simple cuboids. 
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In the above diagram, the merchandisable area is represented by the cuboid with the 
heavy black outline. 

However, if this cuboid was merchandised directly with a placeholder, it would result in 
product being shown beyond the actual surface of the fixture. Accordingly, a cylindrical 
Product Block is associated with the fixture. This expands to the limits set by the 
merchandisable area and represents the limits that will be shown as occupied by a 
placeholder. 

Merchandising with Product Blocks and Placeholders/Display Styles 
1. Placeholders 

If a fixture or shelf object is merchandised with a placeholder, it will occupy the 
extents defined by the Merchandisable Area defined in block definitions. 

In the example below, the fixture on the left has a default Product Block assigned 
(green cylinder). It will not be required unless the fixture is merchandised by a 
placeholder. 

Because the default Product Block is scalable, it will take up the size determined by 
the merchandisable area of the fixture. When the placeholder is then shown (yellow 
cylinder), it takes up the volume defined by the product block, which has itself 
expanded to the extents determined by the merchandisable area. 

Note: If the specified Product Block had been hexagonal, 
then the placeholder would have been shown as a hexagonal 
shape, scales to the extents of the merchandisable area. 

A similar logic applies to other shapes of Product Block – they allow placeholders to 
be displayed in a number of geometries. 

 

2. Display Style Product Blocks 
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If the same fixture is merchandised with a Display Style Product Block (the blue box 
in the right hand diagram) the display style product block will be placed within the 
limits set by the merchandisable area (the cuboid outlined in black). 

The display style product block then has to be moved within the limits of the actual 
merchandisable surface of the fixture using the alignment options available within 
Merchandiser. 

Note: The display style product block represents the actual 
dimensions of an instance of the merchandise being placed 
on a fixture. This means multiple instances of display style 
product blocks can be placed until the available volume 
defined by the merchandisable area is filled. 

If a placeholder is used to represent merchandise, only a single instance is required, 
as this represents the volume occupied by a class of product, not individual items. 
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UDA (User Defined Attributes) Tab 

The UDA Tab 
The User Defined Attributes Tab is used to specify customized information for a block. 
This information can then be used for filtering or reporting purposes. 

 

There are two forms of attribute: 

Attribute Forms 

Fixed Attributes 
Fixed attributes are 'definition data' assigned to a specific block definition in Fixture. 
They are configured in the Administration module (General menu). Options can then be 
set on a block-by-block basis in the Fixed Attributes frame in Fixture Studio. 

Variable Attributes 
Variable attributes are 'instance data' that can be individually set for each instance of a 
block within a floor plan. This enables data to be assigned to a specific fixture within a 
specific store. This information can then be used for reporting or compliance purposes. 
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Variable attributes are configured using the Edit Attribute Definitions option from the 
Edit menu in Fixture Studio. A list of possible options is assigned in the UDA tab of the 
Block Details dialog box. After an instance of the block has been placed in a floor plan, 
users can set individual values for each of the variable attributes by selecting the 
fixture/block and using the Show Attribute on the Fixturing Toolbar of the Object 
Browser. 

Note: Variable attributes can also be set for individual 
fixtures in In-Store Space Collaboration. 

Configuring Fixed UDAs 
Setting up Fixed User Defined Attributes takes place in two stages. 

1. The User Defined attributes are configured in the Administration Module. 

2. The values for the User Defined Attribute are assigned on a case-by-case 
business to each block definition in Fixture Studio. 

Configuring UDAs in the Admin Module 
UDAs are configured in the Admin Module via the User Defined Attribute option from 
the General Module. 

 

See the Administration Module Help File for more information on how to accomplish 
this. 

Note: Only users with Administrator's privileges can access 
the Admin Module 

Setting Values for Individual Block Definitions 
Once the User Defined Attributes have been configured in the Administration module, 
values can be set for individual block definitions. 
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The list of User Defined Attributes will appear in the left. The value can then be set on 
the right. It could be a text, date or Boolean value. Depending on settings in the Admin 
module, a default could already be assigned, or the numeric or text value confined to 
ones specified in a drop down list. 

Once assigned, the UDA could be used for filtering purposes - for example in refining a 
list of available fixtures in the Object Browser in the Planner or Merchandiser module. 
The UDA could also be used for filtering purposes in a report, for example in restricting 
data to a list of fixtures with a common characteristic. 

Note: the display of information in the object browser is 
controlled by data in the Custom SQL table in the database. 
This can only be modified by users with access rights to the 
database. 

Configuring Variable Attributes 
Setting up Variable Attributes takes place in two stages. 

1. The Variable Attributes are configured using the Edit Attribute Definitions option on 
the Edit menu. 

2. The variable attributes that can be set are then assigned to individual blocks. 

When an instance of that block is placed in a floor plan then the values of the variable 
attributes that have been assigned to that block can be set in the Planner and 
Merchandiser modules. These values can also be set in In-Store Space Collaboration - this 
enables tasks such as store survey or compliance to be carried out. 

Configuring Variable Attributes 
Variable Attributes are configured using the Edit Attribute Definitions option on the Edit 
menu. This will bring up the Attribute Definitions dialog box. Variable Attribute 
definitions can then be added, edited or deleted by means of the options on the toolbar. 

Configuring Variable Attributes 159 



UDA (User Defined Attributes) Tab 

 

Date set in this dialog box will appear in the UDA tab of the Block Details dialog box and 
in the Attributes dialog box in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. 

 ID - this cannot be edited and is automatically assigned by the software. 

 Name - this is the name given to the Variable Attribute. 

 Data Type - this is set from a drop down list and is determined by the type of 
information to be stored. The options are as follows: 

Data Type Description 

String Used for text values. 

Integer Used for whole numbers: 1, 2, 3, etc. 

Long Used for fractional numbers1123.456, etc. 

Single Can be used as a substitute for Long. 

Double Can be used as a substitute for Long. 

Boolean Used for Yes/No options (with check boxes). 

Currency Used for financial values. 

Image Not in use. 

 Control type - this specifies the type of control to be used in the Attributes dialog 
box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration. 

Control 
Type 

Description 

Text Box A box for text, numbers or monetary values to be entered. 

Drop Down 
List 

Drop down list of preset values, normally used in conjunction with options in the 
Lookup field. Text can also be typed in. 

Check Box A checkbox for Yes/No options, normally used with the Boolean option. 

 Mandatory - if checked, this will force the user to assign a value in the Attributes 
dialog box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration before that dialog box can be closed. 
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 Sequence - this determines the order the options will be displayed in the 
Attributes dialog box in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. 

 Tab - this option is not currently in use. 
 Lookups - this enables the user to populate a predefined list of options for drop 

down lists. Each options is separated from the next by a 'pipe' - for example 
Value 1|Value 2|Value 3. 

Note: in order to ensure the value is stored, press Return 
after entering it. 

Once all values have been assigned, they can be saved back to the database by using the 
Exit option. 

Assigning Variable Attributes to Individual Blocks 
After configuration in the Attribute Definitions dialog box, the list of Variable Attributes 
will appear in the left hand side of the Variable Attributes frame of the UDA tab on the 
block details dialog box. 

 

 The '>' button can be used to add Variable Attributes to the list on the right hand 
side. This list will be displayed when the Attributes dialog box is invoked in the 
Planner and Merchandiser modules and in In-Store Space Collaboration. 

 The '<' button can be used to remove Variable Attributes from the list on the 
right hand side. 

Using Variable UDAs 
Within the Planner and Merchandiser modules (and in In-Store Space Collaboration) 
Variable Attributes can be set for individual fixtures by selecting a fixture, then clicking 
the Show Attribute option on the toolbar. 

 

This will bring up the Attributes dialog box. 
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This will contain a list of attributes specific to that block in that floor plan that were 
assigned in the UDA tab of the Block Details dialog box in Fixture Studio. The values for 
that instance of the block can then be set accordingly. In the above example, the variable 
attributes allow an In-Store Space Collaboration user to set values based on a Store 
Survey or Compliance Check. 

Once set, the values can then be read in Macro Space Management if the floor plan is 
opened in the Planner or Merchandiser modules and the attributes displayed for the 
appropriate fixtures. Alternatively, the assigned attributes can be used for reporting 
purposes. 
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Styles/Ranges Tab 

The Styles/Ranges Tab 
The Styles/Ranges Tab has two purposes: to set the styles for items of equipment, and to 
specify any ranges for physical parameters limiting the products than can be placed on 
that equipment. They are assigned to both fixtures and shelves. 

Equipment Styles Apply To 

Fixtures 
Fixtures only require a fixture style. This determines what items of equipment and 
merchandiser can be placed on it. 

 

Shelves 
Shelves require both a fixture and a shelf style. The fixture style must be compatible with 
the fixture style of the item of equipment that is being placed on it. The shelf style 
determines what products can be accepted. 
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Both Styles and ranges are configured in the Administration module - as are the 
relationships between different types of styles. The styles are then assigned to blocks in 
Fixture Studio. Once assigned to blocks, they are used to control actions in the 
Merchandiser module. 

Note: Styles and ranges are also used as filters for 
planogram placement in In-Store Space Collaboration. 

The Available Styles Tab 
The Available Styles Tab contains a list of styles that have been defined in the 
Administration Module. If a fixture, the list will only contain Fixture styles. If a shelf, the 
list will contain both fixture and shelf styles. 
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Steps 

Building a Styles List 
To add a style to the Selected Styles list, highlight the part in the Available Styles frame 
and use the Add arrow. 

 
Alternatively highlight and double click on the style in the Available Styles frame. 

Selected Styles 
The Selected Styles Tab contains a list of styles that have been chosen from the Available 
Styles frame. 
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Depending on the block, the styles will define the type of equipment it can connect with, 
and (if a shelf or fixture) the type of merchandise it can accept. 

Removing from the Selected Styles List 
To remove a part from the Selected Styles list, highlight the part in the Selected Styles 
frame and use the Remove arrow. 

 
Alternatively highlight and double click on the part in the Selected Styles frame. 

Configuration Module 
Whether Styles are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only affect the user making them. 
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Planner Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 

Merchandiser Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 

It will also trigger a warning if the styles on equipment and merchandise do not match 
when placing products at display style level. 

 

In-Store Space Collaboration 
Styles can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 
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Range Options 
The Range Options frame allows the user to set a permissible temperature range for the 
fixture/shelf. This is compared with the temperature range for any display style level 
merchandise placed in Merchandiser. The merchandise can be placed if the temperature 
ranges match, but will be rejected if they do not. 

Note: Temperature Ranges can also be used as a filter when 
placing planograms in In-Store Space Collaboration. 

 

Temperature ranges are configured in the Administration module (Merchandising Menu 
> Ranges). They are then assigned to Fixtures and Shelf Objects in Fixture Studio. 
Temperature ranges can also be assigned to Products in Product Studio and to 
Planograms in Merchandiser (or can be imported with product or planogram 
information). 

Options 

Configuration Module 
Whether Ranges are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only affect the user making them. 

 

Planner Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 
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Merchandiser Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 

It will also trigger a warning if the ranges on equipment and merchandise do not match 
when placing products at display style level. 

 

In-Store Space Collaboration 
Range can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 
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About Styles 

Overview of Styles 
Styles are used in the Merchandiser Module as filters, primarily to ensure that products 
are placed on the correct fixture or shelf. There are a variety of styles and style 
relationships. 

 

Use of Styles 

Fixtures and Shelf Objects 
Fixtures have to be assigned a Fixture style in Fixture Studio. Similarly Shelf Objects 
(shelves, pegs, etc) have to be assigned both a Fixture and a Shelf style in Fixture Studio. 
When shelving is placed in a fixture in Merchandiser, the Fixture Style assigned to the 
Fixture must match the Fixture Style assigned to the shelf to allow the shelf to be placed. 

Shelf Objects and Products 
Shelves have to be assigned a Shelf style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Shelf and Product Style has been defined in the Administration Module, the Product can 
be placed on the shelf. If a relationship has not been defined, the product cannot be 
placed in the Merchandiser Module. (Display styles cannot be placed in the Planner 
Module). 

Fixtures and Products 
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Fixtures have to be assigned a Fixture style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Fixture and Product Style has been defined in the Administration Module, the Product 
can be placed directly onto the fixture. If a relationship has not been defined, the product 
cannot be placed in the Merchandiser Module. (Display styles cannot be placed in the 
Planner Module). 

Joints 
Some products cannot be placed directly onto fixtures, but must be placed into shelf 
objects such as pegs. There are two ways of achieving this: 

1. Place the shelf object (i.e. peg) first, then place the product 

2. Place the product and shelf object simultaneously - joints 

Planograms 
Fixtures have to be assigned a Fixture style in Fixture Studio. Planograms are assigned a 
Fixture Style in the Planogram Design dialog box in the Merchandiser Module. If the 
Fixture Style of the Planogram being placed does not match the Fixture Style of the first 
of the selected fixtures, a warning will be given. The user can then accept the warning, or 
override it and place the planogram. 

Other Modules 
Styles and style relationships can also be configured in the Fixture Studio and Product 
Studio Modules. 

Where Styles are Assigned 
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms. 

Assigning Styles 

Fixtures 
Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block 
Details dialog box. 
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A Fixture is required to have a Fixture style assigned. Only Fixture Styles will be 
available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a fixture is set in 
the Categories tab. 

Shelf Objects 
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab 
of the Block Details dialog box. 
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A Shelf Object is required to have both Fixture and Shelf styles assigned. Both Fixture 
and Shelf Styles will be available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a Shelf Object is set 
in the Categories tab. 

Products 
Only Products at Display Style Level can be assigned Styles. This is done in the Styles 
Tab of the Display Style dialog box in Product Studio 
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Only Product Styles will be available for Selection. 

Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Only Fixture Styles will be displayed. 

Styles and Style Relationships 
Style Relationships are set up within the Styles option in the Administration module. 
They control: 

1. What products can be placed on what fixture 

2. What products can be placed on what shelf 

3. What products can be placed on what fixture using a specified shelf object (joints) 
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Style relationships must be set up before products are placed in Merchandiser. 

Preferred Styles 
Preferred Styles are used on Shelf Objects. They enable automatic switching of display 
styles for a SKU so that the preferred Display Style is placed on a shelf object. 
An example would be if electric kettles were available in two display styles: Boxed and 
Presentation. The Presentation Display Style would typically be for an electric kettle that 
has been taken out of its box and was being displayed on a shelf above the boxed electric 
kettles. The 'presentation' electric kettle would be used to show customers what the 
electric kettle looked like, the boxed' electric kettles would be purchased by customers 

An example of this would be a fixture with five shelves on it. The top shelf might contain 
examples of 'presentation' goods such as electric kettles, electric toasters, bread makers 
and toasters. The four shelves below would contain respectively boxed electric kettles, 
electric toasters, bread makers and toasters for purchase. 

By setting the preferred style of the top shelf to accept 'Presentation' Display Styles and 
the preferred styles of the shelves below to accept 'Boxed' Display Styles, the user can 
ensure that the correct form of the merchandise goes onto the shelves. If an attempt is 
made to put 'Presentation' Display Styles onto a shelf that prefers 'Boxed' Display Styles, 
then the Display Style will automatically be switched to the correct one. 

The full process for using preferred styles is 

1. Add Appropriate Styles in the Administration Module 

2. Set up Style Relationships in the Administration Module 

3. Assign Styles to Shelf Objects in Fixture Studio 
4. Assign Styles to Display Style level products in Product Studio 

5. Set up Preferences for Shelves 
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6. Drag and drop Display Style products onto shelf - preferred style should be chosen if 
not correct 

Steps 

Add Appropriate Styles in Admin 
The appropriate styles have to exist in the Style tab of the Styles dialog box in the 
Administration module 

 

Set up Style Relationships in the Administration Module 
The appropriate style relationships have to exist in the Style Relationship tab of the Styles 
dialog box in the Administration module 
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Assign Styles to Shelf Objects in Fixture Studio 
Shelf styles have to be assigned to the shelf object in Fixture Studio. A minimum of two 
shelf styles are required for Preferred Styles to work. 
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Assign Styles to Display Style level products in Product Studio 
Product Styles are assigned in Styles Tab of the Product Display Style dialog box in 
Product Studio. 
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Set up Preferences for Shelves 
The preferences for shelves are set in the Merchandiser module. There are two ways of 
doing this: on adding the shelves to a fixture, or by editing a specific shelf. 

When adding shelves to a fixture, the preferred style can be set using the drop down list 
in the Add Shelves dialog box. 
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Once shelves have been added, the Preferred Style can be edited using the Preferred Style 
drop down list in the Edit Shelf dialog box. 

 

Drag and Drop Display Style products onto shelf - preferred style should be chosen if not correct 
Once preferred styles have been set for a shelf, they can be used to determine what 
display style for a specific SKU is placed. If there are several alternatives, dragging and 
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dropping any display style onto a shelf from that SKU will result in the type of display 
style being checked, and if necessary changed to the preferred style. 

About Joints 
Joints are a special type of Style Relationship. They allow a product to be placed directly 
onto a compatible fixture at the same time as the associated shelf object that the product 
will be placed on is added.   

 

In the example above products have been directly placed into a slatwall using pegs. 
Without a joint, the pegs would have to have been placed first and then merchandised 
with product in a second operation. 

Prior to products being added via joints, the following must be true: 

1. The Fixture that will support the shelf objects the products are being added to must 
have a Fixture Style assigned in Fixture Studio 

2. The Shelf Object the product will be added to must have a Shelf Style assigned in 
Fixture Studio 

3. The Product must have a Product Style assigned in Product Studio 

4. The appropriate Joint (Style Relationship) must be set up in the Styles option within 
the Administration Module 

To add a product using joints requires the following steps: 

1. Drag the product from the Object Browser or Object Grid and drop onto the required 
Fixture. 
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2. The Add Shelves dialog box will appear allowing users to specify details of the shelf 
objects to be added. 

 

Note: this dialogue box will not appear if the Add Products 
Silently option is on in the Edit Menu in Merchandiser. 

3. After the Shelf Object details have been specified and the OK button clicked, the Add 
Products dialog box will appear. 
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4. After specifying the quantity, alignment, etc, and clicking the OK button, the 
products and shelf objects will simultaneously place on the selected fixture. 

About Styles and Ranges 
Styles and Ranges can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects. 

 

Styles 
If styles have been assigned to: 

1. Fixtures and Products 

2. Shelf Objects and Products 
and the requisite Style Relationships exist, then styles can be used to determine whether 
a product can be placed on either a fixture or a shelf object. 

Ranges 
Ranges can be been assigned to: 

1. Fixtures and Products 

2. Shelf Objects and Products 

If the ranges are compatible then they can be used to determine whether a product can be 
placed on either a fixture or a shelf object. 

Example 
1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 

styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to determine 
whether products could or could not be placed. 

It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles that 
could be assigned to all Fixtures, Shelf Objects and Products. The pertinent Fixtures, Shelf 
Objects and Products could then be assigned the 'Frozen' temperature range. In this 
example, the Range would serve to determine whether products could or could not be 
placed.  
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Merchandisable Areas Tab 

The Merchandisable Areas Tab 
The Merchandisable Areas Tab is used to indicate the extents of the space that 
merchandise can take up on the fixture or shelf object. 

 

There are two types of merchandisable areas - Primary Area or Further Area. The two are 
mutually exclusive - you can have a Primary Area or Further Areas, but not both. 

Types of Merchandisable Areas 

Primary Area 
This option is used when there only one merchandisable area is required on a fixture or 
shelf object. In the example below, a single merchandisable area has been assigned to a 
chiller unit. Primary areas can be used with both fixed size and stretchable blocks. 
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Further Area 
Further Areas are used when multiple merchandisable areas are required. In the example 
below, the freezer has a permanent internal divider and thus has been assigned 'left' and 
'right' merchandisable areas. Further areas are normally only used for fixed size blocks. 

 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 

The Primary Areas Frame 
The Primary Area Frame allows the user to specify the Primary Merchandisable Area. 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 

Primary Merchandisable Areas can be used in conjunction with stretchable fixtures. 
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They are defined as a cuboid with reference to the extents of the fixture. Offset 1 defines 
the starting point of the Primary Area relative to the bottom-back-left corner of the 
fixture. Offset 2 defines the diagonally opposite corner of the Primary Area. This is 
relative to the top-front-right corner of the fixture 

 

The offsets work relative to the extents of the block. A positive value brings the corner of 
the cuboid inside of the extents of the fixture, while a negative value moves it outside. 
This can be seen in the diagram below. 

 

The position of the Merchandisable area is also affected by the Child Insertion Position 
set in the Insertion tab. 
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 If the Child Insertion position is set to bottom, the bottom-back-left corner of the 
merchandisable area will be aligned relative to the AutoCAD insertion pint of 
the fixture. 

 If the Child Insertion position is set to middle, the centre of the back-left-side of 
the merchandisable area will be aligned relative to the AutoCAD insertion pint 
of the fixture. 

 If the Child Insertion position is set to top, the top back-left corner of the 
merchandisable area will be aligned relative to the AutoCAD insertion pint of 
the fixture. 

Normally, the Child Insertion Point would be set to bottom for fixtures that are to have 
merchandise stacked on them and to top for pegs or other shelf objects, where 
merchandise will hang. 

 

In the above example, the fixture has the Child Insertion Position set to Bottom, and the 
Rod has the Child Insertion Position set to Top. Setting up the merchandisable areas for 
the two types of object requires slightly different techniques. These are explained in the 
worked examples that follow: 
The size of the defined Primary area is shown towards the right of the frame, while the 
unconstrained check boxes allow merchandise to extend for any distance in that 
direction. If unconstrained areas are specified, these will be indicated by 'plus' or minus' 
symbols in the preview tab. 
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Note: the unconstrained check boxes are normally only used 
with pegs and rods. 

Additional Fixture Height 
The height of a primary merchandisable area can also be affected by the 
ADDITIONAL_FIXTURE_HEIGHT system variable.  This global setting can add a 
specified additional height to all Primary Areas. It is configured in the Administration 
module. 

Configuring a Primary Merchandisable Area for a Fixture 
Primary Merchandisable Areas are configured in the Primary Areas frame. 

 

In the specially created example fixture below, the fixture has a base and back. The 
merchandisable area has to take those into account. This example will show how to 
create that merchandisable area. 
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Configuration 

AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 

 

Position the fixture which is having its merchandisable areas configured with its 
insertion point at 0,0,0. When OSNAP is turned on, the ID command will return the 
coordinates of any selected point. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. In this case both have been set to bottom-back-left. 

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. Offset 1 defines the 
starting point of the Primary Area relative to the bottom-back-left corner of the fixture. 
Offset 2 defines the diagonally opposite corner of the Primary Area. This is relative to the 
top-front-right corner of the fixture 
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For the bottom-back-left corner, it is necessary to allow for the thickness of the back and 
the base of the fixture. Positive coordinates move the positions of the merchandisable 
areas inside the fixture, so coordinates of 0,6,6 are required. This leaves the position of 
the corner relative to the X Axis unchanged, but moves it up 6 units and forward 6 units. 
For the top-front-right corner, there is no need to change the coordinates. Accordingly, 
the defaults of 0,0,0 can be left unchanged. 

The settings look as follows - the size of the merchandisable area is shown towards the 
right. 

 

And the end result looks as follows: 

 

If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for Circular Fixtures 
Primary Merchandisable Areas for Circular Fixtures are configured in the Primary Areas 
frame. 
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There are two 'special cases' provided for in the Category Tab. These are selected by 
setting the drop down list in the Graphics frame to Circular or Semi-Circular. 

 

 

This example will show how to create a primary merchandisable area for a circular 
fixture - a semi-circular fixture follows exactly the same principles. 

Note: the shape must previously have been set to Circular in 
the Category tab. 

Settings 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 
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Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. 

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2 defines the 
diameter of the primary area relative to that of the block. Entering a pair of values for the 
X and Y values will alter that diameter. The settings look as follows - the size of the 
merchandisable area is shown towards the right. 

 

Offset 1 is set to a value of 6 for the Z axis. Positive offsets move the starting point of the 
merchandisable area inside the fixture. In this case the value of the offset moves the start 
of the merchandisable area to the top face of the block. 
Offset 2 is set to a Z value of -36. Negative offsets move the starting point of the 
merchandisable area outside of the fixture - in this case 36 inches above the top face of 
the block. The X and Y offsets are set to 6. Positive offsets move the starting point of the 
merchandisable area inside the fixture - in this case making the merchandisable area 6 
inches less in diameter than the diameter of the block. 

The end result looks as follows: 

 

If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for a Peg or a Rod 
Primary Merchandisable Areas are configured in the Primary Areas frame. 
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In the specially created example fixture below, a rod is represented by a simple cylinder. 
The merchandisable area has to take those into account. This example will show how to 
create that merchandisable area. 

 

Settings 

Setting the Child Insertion Position 
The first stage is to set the Child Insertion position. 

 

This must be set to Top for a Peg or Rod. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point is appropriately set. For most pegs and rods, this will be 
middle-back-centre. 
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Offset 1 and Offset 2 
The positions of the two offset points have changed slightly. Offset 1 is now top-back-left 
and Offset 2 is bottom-front-right. 

 

Negative values take the merchandisable area outside the extents of the rod. In this case 
we want the merchandisable area to extend three units to the side. Offset 1 is thus set to -
3,0,0. We also want the merchandisable area to extend three units to the other side and 
twelve units down. Offset 2 is thus set to -3, 0,-12. 

The settings look as follows - the size of the merchandisable area is shown towards the 
right. 

 

And the end result looks as follows: 

 

The size is shown towards the right of the frame. Although the height of the 
merchandisable area has been set to 12 units, this has been overridden by the software 
and any height of package can be hung from the rod (subject to not sharing the same 
space with other merchandise). 

At present the maximum width of packaging that can be hung from the rod is six inches. 
This can be overridden by ticking the 'Y' unconstrained check boxes. 

Configuring a Primary Merchandisable Area for a Peg or a Rod 195 



Merchandisable Areas Tab 

Note: using the unconstrained option should only be used if 
the working axis (Category tab) is set to 'Y' and there are no 
stacking axes set. 

Configuring a Primary Merchandisable Area for a Non-Rectangular Area 
There is an option in the Category tab to set the shape of the block to Triangular. This 
enables the user to configure the horizontal outline of a non-rectangular merchandisable 
area. 

 

Note: details on how to configure this outline are in the 
section on the Category tab. 

Once the horizontal outline has been configured, this can be used as the basis for a 
primary area. 

Note: the shape must previously have been set to Triangular 
in the Category tab. 

Settings 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. 

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2can be used 
to specify the height of the primary area relative to the top of the block. This necessitates 
entering a value for the Z (vertical) axis. The settings look as follows - the size of the 
merchandisable area is shown towards the right. 
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Offset 1 is set to a value of 3 for the Z axis. Positive offsets move the starting point of the 
merchandisable area inside the fixture. In this case the value of the offset moves the start 
of the merchandisable area to the top face of the base of the block. 

Offset 2 has no settings. This is because the top of the merchandisable area is already 
correctly positioned at the top-front-right corner of the block. 

There is no need to enter X or Y coordinates for the primary area. This is read from data 
stored when the 'triangular' area was defined in the Category tab. 

The end result looks as follows: 

 

If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

The Further Areas Frame 
The Further Areas frame allows other merchandisable areas to be specified. Further 
Areas are of fixed size and are not normally used with stretchable blocks. 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 
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Settings 

Names 
Entering data into the text box and pressing Return will enter the name of a Further Area 
into the grid below. Highlighting a Further Area and pressing Delete will remove it. 
Highlighting a Further Area in the list will populate the right hand side with any data 
associated with that Further Area. 

Dimensions 
The pair of X, Y, Z coordinates is used to specify the bounds of the Further 
Merchandisable area. The left hand set of X, Y and Z coordinates is used to specify the 
bottom-back-left corner of a cuboid. The right hand set of X, Y and Z coordinates is used 
to specify the top-front-right corner of a cuboid - the dimensions of this cuboid are 
relative to the first set of points. For example the two sets of points 6,6,6 and 12,18,24 
describe a cuboid with its origin at 6,6,6. It has a length of 12 units, a depth of 18 and a 
height of 24. 

The Pick buttons can be used to toggle the user to the currently active drawing in 
Planner. If an instance of the block is present, the user can pick the required points rather 
than manually enter them. 

Note: The pick buttons are currently not working correctly. 

The dimensions obey a standard Cartesian coordinate system drawn relative to the 
insertion point of the block as defined in AutoCAD (Planner). The directions of the axes 
in this coordinate system are shown below. The specified coordinates are drawn relative 
to the insertion point of the AutoCAD (Planner) block. 

 

Horizontal And Vertical Angle 
These options determine the orientation of the cuboid defined by the directions. This 
orientation can be changed by means of the Horizontal Angle and Vertical Angle 
controls. The effects of these controls are shown in the diagram below. 
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Note: the Horizontal Angle is often set to correspond with 
the Front direction of the fixture (Insertion tab). 

Origin of Further Area 
The origin of the further area (the first set of X, Y, Z coordinates) is indicated by an 'X'. 
This has been exaggerated in size in the diagram below for clarity - it is normally 
significantly smaller. 

 

Configuring Further Merchandisable Areas 
Further Merchandisable Areas are configured in the Further Areas frame. 

 

In the specially created example fixture below, the fixture has two merchandisable area; 
left (green) and right (blue). This allows merchandise to be placed taking into account the 
thickness of the base, rear and internal dividing wall. This example will show how to 
create those merchandisable areas 
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Settings 

AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 

 

Position the fixture which is having its merchandisable areas configured with its 
insertion point at 0,0,0. When OSNAP is turned on, the ID command will return the 
coordinates of any selected point. 

Starting Condition of the Further Areas Frame 
For a new block (fixture) the frame will be blank with no Further Areas added. 
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Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. In this case both have been set to bottom-back-left. 

Creating the Left Hand Area 
The first stage is to enter the name of the Further Merchandisable Area in the text box 
and press Return - in this case 'Left'. The name will appear in the list of available names. 
Highlighting it will activate the rest of the frame, which until now will have been greyed 
out.  The next stage is to set the dimensions. We need to set them for the bottom-back-left 
and top-front-right corners of a cuboid. The coordinates for the bottom-back-left point 
are 0,-6, 6. These define the starting point of the cuboid. The next set of coordinates 
(12,18,24) define the volume of the cuboid - 12 units in positive X, 18 units in positive Y, 
24 units in positive Z. 

 

The Horizontal angle is set to 270 degrees. This matches the front direction of the fixture. 
The Vertical Angle is set to 0 degrees as the Further Area is parallel to the ground. 
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The settings look as follows: 

 

And the end result looks as follows: 

 

Creating the Right Hand Area 
The right hand is created in the same way as the left, except the first set of coordinates is 
set to 18, -6, 6 because this Further Area starts in a different place. The second set of 
coordinates is the same because the Further Area is the same physical size. The settlings 
are as follows: 
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The result is as follows (with the Left Further Area colored green, and the Right Further 
Area colored blue). 

 

Constrained and Unconstrained Merchandisable Areas 
Primary Merchandisable Areas can either be constrained or unconstrained. 

 Constrained Areas are areas that stay within the specified coordinates. 

 Unconstrained Areas may take up any volume in the specified direction. 
These options are set by checking the check boxes in the primary areas frame. 

 

Unconstrained axes are shown visually in the Preview tab. 
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Any unconstrained axis will have a '+' or a '-' sign by it. 
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Shelf Tab 

The Shelf Tab 
The Shelf Tab can be used to define the permissible angles for shelves to be set at when 
placed on a fixture. 

 

Currently defined Angle Categories can be seen from the drop down list. 
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These Angles can then be used as predefined values when assigning shelves in the 
Merchandiser module. 

  

Specifying Permissible Shelf Angles 
Angle categories many be created, edited or deleted. 

Creating an Angle Category 
To create an Angle Category, click on the Create button in the Angle Category frame. 

 

This will bring up the Shelf Angles dialogue box. 
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Type in the required Angle Category name then left click into the Angles box. (Do not 
press <Return> at this stage or it will close the dialogue box). 

Type the required angle in and press <Return>. Continue to type in the required angles 
and pressing return until the desired list of angles has been built up. 

 

When the required Angles have been entered, click on OK to save the information to the 
database and close the dialogue box. 

Editing an Angle Category 
To Edit an Angle Category, click on the Edit button in the Angle Category frame. This 
will bring up the Shelf Angles dialogue box. 

 

The Shelf Group Name cannot be edited. 
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The Angles can be edited by typing in the required angle and pressing return. 

When the required changes have been made, click on OK to save the information to the 
database and close the dialogue box. 

Deleting an Angle Category 
To delete an Angle Category, click on the Delete button in the Angle Category frame. The 
selected category will be deleted without further confirmation. 
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Overview of the Preview Tab 
The Preview Tab allows users to visually see merchandisable areas, connection points, 
the origin (insertion point) and the position of the first product placed on a fixture. 

 

Note: In order to display an image in the preview frame, a 
3DS file of that block must be present in the directory 
specified in the Category tab. 

In the above image, the shelf is enclosed by a red selection frame. 

 While the selection frame is present the fixture can be rotated by holding down 
the left mouse key and moving the mouse cursor around the fixture. 
Alternatively, different viewpoints can be adopted by clicking the icons in the 
Preview toolbar. 

 The selection frame can be removed by holding down the Control key and left 
clicking with the mouse on the fixture. (Alternatively use the <Escape Key>). 
While the selection frame is removed, the fixture can be moved on zoomed in 
and out on by holding down either the left or right mouse buttons and moving 
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the mouse cursor around the fixture. Alternatively, different viewpoints can be 
adopted by clicking the icons in the Preview toolbar. 

 The selection frame can be restored by holding down the Control key and left 
clicking with the mouse on the fixture. 

The Preview Tab Toolbar allows users to select the point of view for the displayed 
preview. 

 

Click on the relevant icon to see the viewpoint. 

Icon Description 

 

  

Front view of selected object 

 

  

Back view of selected object 

 

  

Top view of selected object 

 

  

Bottom view of selected object 

 

  

Left view of selected object 

 

  

Right view of selected object 

 

  

NW isometric view of selected object 

 

  

NE isometric view of selected object 

 

  

SE isometric view of selected object 

 

  

SW isometric view of selected object 
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Merchandisable Areas Option 
The Merchandisable Areas option allows users to see the assigned merchandisable areas 
for a fixture. Activate it by ticking the checkbox. 

 

Note: Merchandisable Areas are configured in the 
Merchandisable Areas tab. 

Individual Users can set their preferred color for the primary merchandisable area in the 
Fixturing tab of the Configuration Module. 

 

If there is a single merchandisable area on the fixture, it will be displayed as that single 
color. If there are multiple merchandisable areas on a fixture or shelf object, they will be 
displayed as different colors. 
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In the above example, the Chiller Unit on the left has a single merchandisable area; the 
Freezer unit of the right has Left and Right merchandisable areas. 

Connection Points Option 
The Connection Points option allows users to see the assigned connection points for a 
fixture, fitting or shelf object. Activate it by ticking the checkbox. 

 

Note: Connection Points are configured in the Connections 
tab. 

Individual Users can set their preferred display size and colors for the connection points 
in the Fixturing tab of the Configuration Module. 
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The connection points will then be displayed as small triangles of the specified size and 
color. 

 

Origin Option 
The Origin option allows users to see the assigned origin (set in the Insertion tab) for a 
fixture, fitting or shelf object. Activate it by ticking the checkbox. 
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In the example below, the origin can be seen as a set of red, green and blue lines set at 90 
degrees to each other. 

 

Blue Line Direction of X 
Axis 

Green 
Line 

Direction of Y 
Axis 

Red Line Direction of Z 
Axis 

  

Note: this origin point corresponds to that set in the 
Insertion tab. It does not correspond to the AutoCAD DWG 
file insertion point. 

First Product Option 
The Origin option allows users to see where the first product will place on a fixture or 
shelf object. It is determined by the Child Insertion Position in the Insertion tab. Activate 
it by ticking the checkbox. 

 

In the example below, the child Insertion Position has been set to Bottom-Back-Left and 
the first product is shown as placing accordingly within the bounds of the 
merchandisable area. 
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Overview of Dragging Option 
The dragging option allows users to manually change the positions of connection points 
or change the size and position of the merchandisable areas. The option is selected by 
ticking the Enable Dragging check box. It will also be necessary to check a second option 
for either Merchandisable Areas 

 

Before any dragging operations can be carried out, the fixture must first be removed from 
its selection box by left clicking on it. 

 

In the above example, the fixture on the left has a selection box, and the one on the right 
has it removed.  

Once the selection box has been removed from the fixture, either merchandisable areas or 
connection points can be selected by left clicking on them.   

 

In the example above, the left hand connection point has been selected by left clicking on 
it and is now enclosed by a red selection box. 
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Dragging or Rotating Connection Points 

Dragging Connection Points 
To drag a connection point, select a fixture that has had connection points assigned. 
Check the Connection Points and Enable Dragging check boxes. 

 

Ensure the fixture selection box is de-selected by left clicking on it (as per the fixture on 
the right). 

 

Select a connection point by left clicking on it. It will be enclosed in a red selection box. 

 

Move the mouse pointer over the selected connection point and hold down the left 
mouse key. The connection point can now be dragged to its new position. 

 

Rotating a Connection Point 
Select a connection point by left clicking on it. It will be enclosed in a red selection box. 
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Move the mouse pointer over the selected connection point and hold down the right 
mouse key. The connection point can now be rotated to its new position. 

 

Connections Tab 
Changes made to connection points by dragging or rotating will be reflected in the 
Connections tab. Similarly, small changes in position can be made by changing the 
coordinates in the Connections tab, then confirming in the preview tab. 

Dragging Merchandisable Areas 

Dragging Merchandisable Areas 
To drag a Merchandisable Area, select a fixture that has had one or more merchandisable 
areas assigned. Check the Merchandisable Areas and Enable Dragging check boxes. 

 

Next ensure that the fixture is de-selected and the merchandisable area selected. This can 
be done by holding down the Control key, then left clicking on the fixture to de-select it. 
The merchandisable area can then be selected by holding down the Control key, then left 
clicking on the merchandisable area to select it. 
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In the example above, the fixture is shown as selected on the left, while the 
merchandisable area is shown as selected on the right. 

The merchandisable area can then be dragged by the mouse. 

Move the mouse pointer over the merchandisable area and hold down the left mouse 
key. The merchandisable area can now be dragged to its new size. 

 

Merchandisable Areas Tab 
Changes made to merchandisable areas by dragging will be reflected in the 
Merchandisable Areas tab. Similarly, small changes in position can be made by changing 
the coordinates in the Merchandisable Areas tab, then confirming in the preview tab. 
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Composite Blocks 
Composite blocks are 'super-blocks' made up of a number of individual AutoCAD 
blocks. In the example below the composite at the rear represents a combination of 
fixtures that might form a checkout installation. These include the checkout itself, a 
cupboard for storing bags, racking for holding products for last minute impulse buys and 
a chair for the checkout operator. These are shown in expanded form at the front of the 
diagram. 

 

Composites provide a simple way of repetitively placing combinations of objects. 
Examples of how composites could be used include: 

 Combinations of equipment - such as checkout complexes. 

 Entire departments of equipment. 

 Custom arrangements of equipment such as storage racking 

Composites are made by first creating the individual blocks, placing then into the correct 
alignment then making them into a composite block. Both the individual blocks and the 
composite block have to be registered in Fixture Studio. 

Composite Blocks and Merchandiser 
Composite blocks are not visible in the Fixture Hierarchy in Merchandiser. If unexploded 
composites are present in a floor plan, they will not be visible in the Merchandiser floor 
plan. 

Configuring Composite Blocks 
Composite blocks are 'super-blocks' made up of a number of individual AutoCAD 
blocks. In the example below a desk, chair and filing cabinet are going to be made into a 
composite for placing into offices in superstores. These are shown in composite form on 
the left and separated into their individual components on the right. 
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To make a composite block, the individual blocks must first have been created and 
registered in Fixture Studio. 

 

Next the individual blocks are inserted into a Planner drawing and put into the required 
alignment. 

 

There are then selected and the AutoCAD Block command used. 
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Once the composite block has been created, it can be registered in Fixture Studio using 
standard methods. The settings specific to a composite block in the Block Details dialog 
box are as follows: 

Category Tab 

 

 Set Retail type to Composite. This acts as a flag for some of the Macro Space 
Planning functionality, meaning that the composite block will be treated in a 
specific way. For example the composite block will not be visible in the Fixture 
Hierarchy in Merchandiser. 

 Set the Icon to Composite. This will indicate to users in Planner that this 
particular block is a composite. 

Insertion Tab 
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The Explode Block on Insert option must be checked. This will cause the composite to 
break up into its component parts when inserted into a floor plan. This is important 
because composite blocks are not visible in Merchandiser. 

Product Blocks 
Product blocks are used to represent the volume taken up by products. 

Overview of Product Blocks 

Planner 
In the Planner module product blocks are used as placeholders. They show the volume 
that products may occupy but give no information on product quantities. 

 

A different product block has to be created for each shape of fixture. In the above 
example, three different forms of product block are required to suit the three different 
shapes of fixtures. 

Merchandiser 
In the Merchandiser module, product blocks can be used to represent the shape of the 
product at display style level. 

 

In the above example, the left hand set of products is displayed as a Textured Box, the 
right hand set of products as a Graphical display using a product block to represent the 
shape of the products. 

Note: individual products have been given different colors 
for the purpose of this illustration. 

Creating the Product Block 
Product blocks are created in two stages: 

1. The Product Block is drawn in the Planner module. 
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2. The Product Block is registered in Fixture Studio. 

Product Blocks can be used in the Planner module, the Merchandiser module, or 
both.  Depending on where they are used, they may require slightly different 
properties. 

 For the Planner module, the product block needs to be hatched so that it will 
stand out in a wire frame drawing 

 For the Merchandiser module, the DWG file for the product block needs to be 
converted into 3DS format so it can be displayed. If the product block is to be 
display in Merchandiser only, it does not require hatching. 

Drawing the Product Block 
The product block should be drawn in the planner module. If the product block is being 
drawn for the Planner module, its faces should be hatched. As hatching can only be 
carried out on flat surfaces, this restricts the form of the product block. The example 
below shows a triangular product block and (on the right) a partially exploded form 
showing how it was constructed. 

 

Curved surfaces can be approximated by many sided polygons. In the example below a 
circular product block has been created from a 32 sided polygon. (The right hand side 
shows a partially exploded 

 

Alternatively more complex product blocks can be drawn purely for Merchandiser. In 
the example below, a desk shaped product block has been created in Planner (left side). 
When appropriately configured, this can be used to represent desks at Display Style level 
in the Merchandiser module. 
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Once the product block has been drawn it can be made into an AutoCAD block and 
imported into Fixture Studio. 

Registering Product Blocks 
Product blocks are created in Planner and then designated as such in Fixture Studio. This 
is done by setting the Retail Type in the Equipment Type frame in Categories tab of the 
Block details dialog box to Product. 

 

Assigning Product Blocks to Fixtures 
Product blocks are assigned to Fixtures in the Fixture tab of the Block Details dialog box 
in Fixture Studio. 
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The assigned product block will then be used to display product placeholders when a 
product is placed in the Planner module. 

Assigning Product Blocks to Display Styles 
Product blocks are assigned to display styles in the Shape drop down list of the Size and 
Shape tab of the Display Style dialog box in Product Studio. 

 

This product will be used when the 'Draw Products as option (right click menu) is set to 
Graphical in Product Studio. 

Reference Blocks 
Reference blocks are used for Bay and Aisle numbering. 

 

In the example above, the fixtures have been allocated bay numbers using a circular 
reference block, while the same reference block has been used to add the aisle number. 
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Reference blocks are supplied with the application and there is not usually any need to 
change them. 

Overview of Title Blocks 
Title Blocks are used to put a frame round a drawing in preparation for printing it. Title 
Blocks can also contain information on the drawing. 

 

The Title Block is an AutoCAD DWG file that overlays the store plan on model space. It 
contains information on the drawing and one or more ViewPorts to display the drawing. 

The Viewport is a specified area within the Title block where the drawing appears. 
ViewPorts can be set to precise scales. 
The Title Block Information is a specific part of the Title Block. It contains fields that 
populate with data about the drawing. In the above example the fields include the store 
name and store code. The data to populate these fields is read from two sources: 

1. From information imbedded into the drawing by the software 

2. From the database by using custom SQL   

Each Title Block is designed for a specific size of paper, so if drawings are to be printed 
off in a range of sizes, title blocks should be created for each size. A metric 
implementation of Macro Space Management may contain title blocks for A0, A1, A2, A3 
and A4 size paper, while an imperial one may contain title blocks for ANSI A, ANSI B, 
ANSI C, ANSI D and ANSI E size paper. 
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Creating the Title Block in Planner 
Creating the Title Block in the Planner Module requires a series of actions to be carried 
out. 

 

Steps to Create 

Establishing Required Dimensions 
Title Block Size has to take into account the printable area on the selected paper size. For 
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of 
all that area and a border (called the non-printable area) that cannot contain any lines or 
text exists around the edges of the paper. 

 

The size of the title block needs to take into account the non-printable area. For example, 
if A3 paper is used, and the non-printable area is 6 mm wide, then the title block needs to 
be drawn at 285 x 408 mm to fit exactly into the printable area of the paper. The insertion 
point of the title block is normally set at 0,0 as 0,0 in the paper space layout is defined as 
the lower left corner of the printable area. 

Note: the size of the printable area is printer/plotter specific. 
It is helpful to allow a small margin for these differences. 

Draw Frame and Text Boxes 
After the size has been established a frame can be drawn in planner, and text boxes 
added. 
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The Title block is usually drawn with the origin at 0,0. 

Add Attribute Definitions 
Attribute Definitions are used to set up the 'template' Attributes for the text boxes. They 
are invoked by typing the ATTDEF command into the AutoCAD command line in 
Planner. 

 

This will bring up the Attribute Definition dialogue box. 

 

The Attribute Definitions can then be put into the drawing. 
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Attribute Tags should always be continuous text. If necessary, join two words with an 
underscore: WORD1_WORD2. 

The Attribute Tags should either match the names of the data 'stamped' into the drawing 
(More Info) or the Column Aliases in the Custom SQL (More Info). 

Turn into Block 
The Title Block can then be turned into a block with the 'block' command. This can either 
be initiated from the Draw toolbar, or from the command line. 

 

The individual components of the Title Block will then be combined to make a single 
object. This block definition is stored in the current drawing and is not yet globally 
available. 
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Write Block (WBlock) to Make Externally Available 
The Write Block (WBlock) command is used to write the block definition to an external 
directory where it can be used in any Macro Space Management drawing. The command 
is invoked by typing WBlock into the command line. 

 

The destination should be a directory specified in the Directories Tab of the 
Configuration Module.   

Registering the Title Block in Fixture Studio 
Registering the Title Block in Fixture Studio requires the following steps. 

 

Steps to Register 

Selecting the Parent Fixture Group 
All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy 
contains a Fixture Group called Title Blocks. This is the usual location for title blocks. 

230 



Fixture Studio User Guide 13.3.2 

 

Create a Block and Enter the Block Name 
Create a block by invoking the Add Block option from the Edit menu or the toolbar. This 
will bring up the New block name dialogue box.   

 

Ensure that the block name entered exactly matches the block name specified in the 
WBlock command used in planner. On clicking OK, the Block Details dialogue box will 
appear for editing. 

Enter Settings in the Block Details Dialogue Box 
The Block Details dialogue box allows custom properties to be assigned to the title block. 
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Full details of how to use this dialogue box can be found in the Fixture Studio help file. 
The principal settings pertinent to title blocks are: 

Category Tab 
1. Set the Retail Type to Title Block. 

2. Set the Directory to match that specified in the WBlock command when the block 
was saved in Planner. 

3. Set the Units as appropriate. 

4. Set the Icon to Title Block. 

Insertion Tab 
1. Set the Layer to Other > TITLEBLOCK. 

2. Level can be left as 'Undefined'. 

Size Tab 
1. Use the 'Calculate' option to bring in the size for the Title Block. 

Adding Title Block Information in the Admin Module 
Adding Title Block Information in the Administration Module is in two stages: 

 

Administration Module Tasks 

Specifying Title Block Details 
Title Blocks are Added, Edited or Deleted using the Title Blocks option from the Planning 
menu. This will bring up the Title Blocks dialogue box.   

 

Name is the nominal name of the title block. 

Blockname is the name of the block for the title. It can be selected from a drop down list. 
This list contains the name of all blocks of type 'Title Block' is Fixture Studio. 
Width is the nominal with of the paper the title block is designed for. It is for display 
purposes only 
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Height is the nominal height of the paper the title block is designed for. It is for display 
purposes only. 

Width Offset is the offset of the insertion point of the title block in the 'X' plane relative 
to the lower left corner of the printable area on the paper the title block is designed for. 
Height Offset is the offset of the insertion point of the title block in the 'Y' plane relative 
to the lower left corner of the printable area on the paper the title block is designed for. 

Default Scale is the default scale that will be applied to the ViewPorts when they are first 
defined in the Title Block dialogue box. 

Note: this option is currently not setting the default in the Title Block dialogue box. 

Canonical Media is selected from a drop down list. It should be set to the size of paper 
the title block is designed for. 

Note: Any entries will only be added when the [Return] key 
is pressed. 

Title Blocks can be added or deleted using the appropriate options on the Edit menu or 
the toolbar. Selecting the edit option on the edit menu or the toolbar will bring up the 
Title Block dialogue box. 

Specifying Viewport Details 
The Title Block dialogue box is used to specify the details of the ViewPorts in the Title 
Block. It is invoked by the edit option in the Title Blocks dialogue box. 

 

The information to the left of the dialogue box mirrors that of the Title Blocks dialogue 
box. The information on the right of the dialogue box is used to set up ViewPorts. Title 
blocks may have multiple ViewPorts. 
Width is the dimension of the viewport in the 'X' plane. 

Height is the dimension of the viewport in the 'Y' plane. 

Width Offset is the offset of the viewport in the 'X' plane relative to the insertion point of 
the title block. 

Height Offset is the offset of the viewport in the 'Y' plane relative to the insertion point 
of the title block. 
Scale is the scaling factor applied to the viewport. 

Note: Scaling is not working correctly at present. 

View is the direction the drawing will be presented in the viewport. Options include 
Plan and a number of isometric projection directions. 
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Note: View is not working correctly at present. 

Note: Any entries will only be added when the [Return] key 
is pressed. 
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Fixture Hierarchies 

Overview of Fixture Hierarchies 
Fixtures are arranged into a Fixture Hierarchy by means of Fixture Groups. Fixture 
Groups are a way of arranging large numbers of fixtures into sub-sets sharing a common 
characteristic. For example, one group could hold all fittings and fixtures used for 
clothing, another all those used for chilled or frozen foods. The example below shows the 
Fixture Hierarchy in Fixture Studio. 

 

Fixture Hierarchies have a number of uses within Macro Space Planning: 
1. They make it easier to manually navigate to the required fixture in Fixture Studio. 

2. The same hierarchy also appears in the Object Browser in the Planner and 
Merchandiser modules and in In-Store Space Collaboration. Again, a well designed 
hierarchy makes it easier to manually navigate to the required fixture. 

3. Fixture Groups can be used to pre-filter the data that shows in the Object Grid. For 
example, clicking on the appropriate Fixture Group will populate the Object Grid 
with all fittings and fixtures used for clothing. 

4. Fixture groups can be used as filters for data in reports - for example from BI 
Publisher. 

Adding, Editing and Deleting Fixture Groups 
Fixture Groups are used to arrange fixture definitions into logical sub-sets. The resulting 
hierarchy is used in Fixture Studio for maintaining information on the equipment used in 
Macro Space Planning. The hierarchy also appears in the Object Browser in the Planner 
and Merchandiser modules and in In-Store Space Collaboration. Groups can be Added, 
Edited and Deleted using the options on the toolbar. (They may also be added using the 
options on the right click menu). 
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Fixture Group Operations 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click the 
Add Group Icon. The Group dialogue box will appear. 

 

Enter a description and select an icon from the drop down list. Click on OK to conform. 
The group to be added is a child of its selected parent group. 

Edit Group 
To add a group, highlight the group which is to be edited. Click the Edit Group Icon. The 
Group dialogue box will appear. 

 

Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details will now be updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click the Delete Group Icon. If the 
Group to be deleted has child groups or block definitions, a warning dialogue will 
appear. 
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If there are no child objects, the group will be deleted without any requirement for 
confirmation. 
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Overview of AutoCAD Blocks 
Note: This section is intended for new users of AutoCAD - it 
can be skipped by experienced users. Some of the details 
have been simplified for purposes of explanation. 

New users often struggle to understand the concept of an AutoCAD block and how 
Macro Space Management interacts with it. This section of help explains the basic 
concepts of an AutoCAD Block. 

The AutoCAD Drawing 

 

The AutoCAD drawing (floor plan) may be considered to be in two parts: 

1. Model space (or the drawing area) 

This is the part of the drawing that is visible to the user. It is where a fixture (or a 
store plan) is created. 

2. Database 

This part of drawing is not visible to the user. It contains details of all the information 
drawn in the visible part. 

Blocks and their Purpose 
Blocks are a mini-drawing representing a single object that will be placed multiple times. 
Consider a checkout. Each store might contain ten checkouts. If there are three hundred 
stores in the chain, there will be total of three thousand checkouts. Drawing each 
checkout individually would be very labor consuming. Better to draw a single checkout 
and then store it in a form that can be repeatedly reinserted into other drawings. The 
form it is stored in is called a block. 

Blocks can exist in two forms; 

1. Locally within the drawing 

Once a block has been created within a drawing, it can be reused multiple times 
within that drawing. It cannot however be used outside of that drawing. 

2. As an External DWG file 

It is also possible to write the block to an external Windows folder in the form of a 
DWG file. This form of block can be used multiple times in any number of drawings. 

The process can be represented diagrammatically as follows: 
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Note: This description refers to a process using AutoCAD 
functionality. 

 

1. The fixture is drawn in AutoCAD. 

2. The AutoCAD Block command is used to write local block into the database part of 
the drawing. 

3. The AutoCAD Write Block (WBlock) command is used to write a copy of the block to 
a Windows folder 

4. Once in the Windows folder, the AutoCAD Insert command can be used to insert 
multiple copies of the block into other drawings. 

Naming Conventions 

Note: Naming conventions are important to the efficient 
operation of Macro Space Management. Lack of a naming 
convention will often make it more difficult to locate the 
required fixture blocks. Lack of a naming convention may 
also result in the creation of multiple gondolas that could 
have been defined more efficiently using a naming 
convention. 

A naming convention is a pre-thought out and logical way of assigning block names. If 
blocks are given names like Widget-187567 and Gizmo-ADRTYN, it is not obvious what 
the blocks are for, or what their dimensions are. With a well thought out naming 
convention, things are far simpler. 
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In the above example, there are three types of block; Back Panels, L shaped uprights and 
T shaped uprights. It is apparent from the block names that the back panels have widths 
of 600 and 900 mm, and that they have heights of 1400, 1600, 2500 and 2900 mm. 
Similarly, it is obvious that both the L and T shaped uprights come in four heights; 1400, 
1600, 2500 and 2900 mm. Widget-187567 might well be a back panel of width 600 mm 
and height 2500 mm, but the lack of naming convention means this cannot be deduced 
from the block name. 

Drawing the Fixture 
The beginning point for creating a fixture is to create a representative drawing within the 
AutoCAD environment. This would normally be created within a drawing used as a 
Fixture Library. 

 

The drawing should be dimensionally accurate and showing the level of detail required 
for display in the Macro Space Management Planner and Merchandiser environments. 
The following points should be noted. 

1. Do not use unnecessary detail 

The drawing should be representative of the fixture, but drawing too great a level of 
detail is not recommended. This will increase the size of the eventual DWG file (and 
3DS file) that will result. Because a floor plan may contain some thousands of 
fixtures, an over elaborate fixture drawing (and resulting increased file size) will 
result in performance in the floor plan becoming slow. 

2. Ensure the insertion point is appropriately positioned 

It is useful to have a consistent position for the insertion points for the fixtures that 
are drawn. This makes it easier when configuring blocks in Fixture Studio. For 
example, all fixtures could be created with insertion points of bottom, back, left; 
while all pegs could be created with insertion points of middle, centre, back. Another 
point to consider when selecting insertion points is In-Store Space Collaboration. This 
application represents fixtures and fittings as rectangles based on the extents of the 
block. 
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The checkout above (purple outline) is not rectangular in shape. The dotted outline 
indicates the rectangle that will represent the checkout in In-Store Space 
Collaboration. The insertion point for the fixture should be placed where the blue 
square is and set to bottom back left. If the insertion point is placed where the red 
square is, the rectangle representing the checkout will not be drawn in the correct 
position in ISSC. 

3. Ensure that the front direction of the fixture is correct 

Fixtures are assigned a front direction. This indicates the primary direction that a 
customer approaches to get merchandise. 

 

By convention, this is normally 270 degrees (the equivalent of south). The fixture 
should be drawn so that, when converted into a block, it is in this orientation. 

4. Add in 2D/3D Functionality 

If 2D/3D functionality is required, the varying parts of the block must be configured 
accordingly. (See the section on how to create 2D/3D functionality for more 
information). 

5. Ensure the Color and Line Weight are set to 'By Block' 

The ability to change the color and line weights of individual blocks within a 
drawing (floor plan) is used by two specific items of Macro Space Management 
functionality. 

– KPI's depend on the ability to change the color of individual blocks 
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It is possible to color code blocks in a Planner floor plan by specific performance 
criteria. In the example below, fixtures designated as promotional fixtures have 
had their outline changed to red, while standard fixtures have gray outlines. 

 

This functionality will only work if the color properties for the block are set to 
'By Block' in the AutoCAD Properties dialog box when the block is being 
configured. 

 

– The 'Thicken' form of Highlighting requires the line weight of the block to be 
changed. 

Highlighting options for blocks are set in the Fixturing tab of the Configuration 
module. One option is Thicken. If the Highlight in View option is selected on the 
Object Browser in Planner, fixtures selected in the Fixture Hierarchy will have 
their outlines thickened. 
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This functionality will only work if the Line weight properties for the block are 
set to 'By Block' in the AutoCAD Properties dialog box when the block is being 
configured. 

 

2D/3D Functionality 
2D/3D functionality allows users to toggle between an outline at floor level and a full 3D 
representation of a fixture in the Planner module. The function is accessed from the 
Planner module from either the Retail Layers toolbar or the View Menu. 
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This is useful when publishing a store plan as it can be output with the fixtures in a 
simplified form with many of the construction lines omitted. The screen shot below 
shows the fixtures in both 3D (top) and 2D (bottom) form. 

 

This can be achieved as follows: 

Note: If an existing block from a client is being modified, this 
will have to be exploded first and then re-blocked after the 
2D/3D modifications have been made. 
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1. Create a drawing to be used as a Fixture Library 

2. In the drawing create two layers called 2D and 3D. (These precise names must be 
used as the MSM functionality references them). 

3. While on Layer 0, draw an outline representing the outline of the block at floor level. 

Note: The outline is only required if the fixture or fitting 
places directly on the floor. If the object is (for example) a 
shelf, then it only requires a 3D component so that it 
vanished from view when a floor plan is toggled to 2D. 

4. Using the properties dialog box: 

a. Set the Layer to 2D. 

b. Set the Color to ’By Block’ - this will ensure the block colors correctly for KPIs, 
etc. 

c. Set the Line Weight to ’By Block’ - this will ensure that the block thickens 
correctly if ’Thicken’ is a highlight option. 

5. While on Layer 0, draw a 3D representation of the block at floor level. 

6. Using the properties dialog box: 

a. Set the Layer to 3D. 
b. Set the Color to ’By Block’ - this will ensure the block colors correctly for KPIs, 

etc. 

c. Set the Line Weight to ’By Block’ - this will ensure that the block thickens 
correctly if ’Thicken’ is a highlight option. 

7. Use the Block command to turn the 2D and 3D components into a block. 

8. Test that the block toggles between 2D and 3D mode by turning the 2D and 3D layers 
off and on as required. 

Note: Setting Color and Line Weight to By Block enables 
instances of that block placed in floor plans to have the color 
and line weight modified by the application. If the Color and 
Line Weight are set to By Layer, then instances of that block 
will adopt the defaults for that layer when placed and 
cannot be modified by the application. 

Information for AutoCAD Experts 
When converted onto a block later (on Layer 0), the block will contain internal layers 
called 2D and 3D. When the block is placed into floor plan in Macro Space Management, 
this will result in the creation of additional layers called 2D and 3D in that floor plan. 
When the 2D/3D functionality is used, the respective layers will be toggled on/off, 
leaving those parts of the block on either the 2D layer or 3D layer visible.   

Creating and Inserting AutoCAD Blocks 
Note: This section of help shows how to make, save and 
insert blocks using purely AutoCAD tools. It is intended for 
users new to AutoCAD so they can see the basic process 
involved. The procedure for registering blocks in Fixture 
studio is a little more complex and is discussed further on in 
this help material. 
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The stages of creating a block are as follows: 

Required Stages for Block Creation 

Draw fixture 
The fixture is drawn using standard AutoCAD methods. It must be on Layer 0 of the 
drawing. 

 

Convert to a Block 
To convert to a block, type BLOCK into the command line and press Return. The Block 
Definition dialog box will appear. 

 

1. Enter a unique name into the Name text box. 

2. Click Select Object and select the required fixture 
3. If the bottom back left corner of the fixture is at coordinates, 0,0,0, no further action is 

required. If the bottom back left corner of the fixture is not at 0,0,0 then the Pick Point 
button in the Base Point frame should be used to specify the bottom back left corner 
of the fixture. 

Note: the requirement to pick bottom back left is Macro 
Space Planning specific - it is not required in 'raw' 
AutoCAD. 
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4. Set the correct units in the Settings Frame 

5. On clicking OK, the selected fixture will be saved as a block. 

The drawing of the fixture has now been converted into a block. This block may be 
inserted multiple times within the current drawing, but cannot yet be inserted in other 
drawings. 

Write to Windows Folder 
To take an existing block and write it to a Windows folder, Type WBlock (Write Block) 
into the command line and press Return. The Write Block dialog box will appear. 

 

1. Click the Block Radio button 

2. Select the name of the required block from the drop down list. 

3. Select a destination to save the block. This can be done by clicking the button in the 
destination frame. 

4. Ensure the Insert Units are set correctly. 

5. On clicking OK, the block will be saved as a DWG file to the external windows 
folder. 

Inserting a Block 
To take an existing block and reinsert it in a drawing, type INSERT into the command 
line and press Return. The Insert dialog box will appear. 
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1. Select the Name of the block from the drop down list. This will give a list of blocks 
currently inserted in the drawing. If the required block is not in the list, click the 
Browse button, navigate to the appropriate Windows folder and select the required 
DWG file. 

2. If the Specify On-Screen check box is ticked, the block can be inserted at any point in 
the drawing. If it is un-ticked, it will be inserted at the specified coordinates. 

3. On clicking OK, the block will be inserted into the drawing. 

AutoCAD Blocks and Macro Space Management 
In order to ensure optimum performance within Macro Space Planning, blocks must be 
created and defined in a very specific sequence. Failure to follow all steps in this process 
may result in problems when using functionality within Macro Space Planning. 

 

Required Steps 

Create Block in the Planner Module 
The first stage of the process is to create an AutoCAD block in the Planner module. This 
block should be configured so it meets the requirements of Macro Space Planning. 

1. The insertion point should be bottom back left - any other insertion point (except in 
special cases) may cause problems. 

2. If 2D/3D functionality is required, the block should be drawn on 2D and 3D layers as 
required. 

3. Ensure the units are correct for the type of database the block will be used in: 
imperial or metric as required. 

4. Ensure the block is appropriately named - particularly if a naming convention is in 
use. 

5. If possible, ensure the block is stored in a Fixture Library. 

Note: Insertion points, 2D/3D functionality and naming 
conventions are discussed in more detail elsewhere in this 
help file. 
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Import the Block into Fixture Studio 
Importing the block from a Fixture Library into Fixture Studio is good practice. This is 
done as follows: 

1. Ensure both Planner and Fixture Studio are open. Also ensure the Fixture Library is 
the active drawing in Planner. 

2. Select the Connect to AutoCAD option from the File Menu. This will link Fixture 
Studio to the currently Active Drawing in Planner. It also means Fixture Studio can 
access the AutoCAD functionality it will require to save the block. 

 

3. Select the Read Blocks option from the view menu. This will bring up the Read 
Blocks dialog box. Select the Merge option - this will compare the information in the 
database and the currently active Planner drawing. Any blocks that are in the 
drawing, but not the database will be imported into Fixture Studio. 

 

4. The block(s) will then be seen in the Fixture Hierarchy. They can be 'dragged and 
dropped' to the appropriate Fixture Group in the Hierarchy 
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5. The required fixture is then highlighted and the Edit Block option selected. This will 
bring up the Block Details dialog box. 

 

The required details are then configured in each tab. One item of data to set is the 
Directory. This specifies the Windows folder where the copy of the DWG file inserted 
by MSM into the planner drawing will be stored. On clicking OK, the details for the 
block will be stored locally in Fixture Studio - and not yet written back to the Macro 
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Space Planning database. This can be seen in the list of blocks, where the Red icon 
and -1 Block ID indicate that data is not yet saved back to the database. 

 

6. Save the block details back to the database. This is done by selecting the Save blocks 
option from the File Menu. 

 

– Both the Database and Drawing options should be selected - the drawing 
option will ensure that XData is written to the current copy of the block in 
the Fixture Library. 

– Add New Definitions should be selected to ensure the new block's details are 
written back to the database. 

– Only Save Selected blocks should be selected to avoid writing back details of 
all blocks (new or not) to the database. 

– Write Block Files ensures XData is written both to the block in the Fixture 
Library and to the copy of the DWG file stored in the Directory specified in 
the Block Details dialog box. 

It is important to understand how this process works. 
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On clicking OK in the Save Block Definitions dialog box, the following actions take 
place. 

a. The information held in local memory is permanently written to the database. 

b. XData (MSM specific data) is written to the instance of the block in the currently 
active drawing. (An instance of every block being saved must be in the currently 
active drawing). 

c. A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

After saving, a confirmatory dialog box will appear. 
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Note: When first saving blocks, Fixture Studio sometimes 
saves the DWG file to the MSM directory rather than the 
directory specified in the block details dialog box. This 
problem can be solved by 'cutting and pasting' the DWG 
Files to the correct directory. 

7. Create a 3DS File 

To create a 3DS file, highlight the required block(s) in the Fixture Hierarchy and then 
select the Create 3DS file(s) option from the File menu. (You must be connected to 
AutoCAD [Planner] to access this option). 

 

On clicking the option, the 3DS files will be created and a confirmatory message will 
appear. 

 

Note: Creating a Lightwave file is outside the scope of this 
part of help. 

Tips and Tricks 
The following tips and tricks are useful when creating blocks. 

Fixture Library 
It is recommended all blocks be manipulated in fixture libraries. These are drawings that 
hold ’master copies’ of specific types of blocks. Blocks are often organized using a grid - 
enabling them to be stored in a manner that facilitates locating any block that is to be 
modified. 
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There are often multiple fixture libraries. Each contains a specific class of block - for 
example racking or freezer/chiller units. 

Note: The combination of Fixture Studio and fixture libraries 
provides an alternative to the Design Centre that pure 
AutoCAD users may be familiar with. 

Having all blocks of a certain type grouped together in a drawing makes editing of the 
blocks easier, should it be required in the future. 

XData 
Some data is stored in a specialized attribute called BSLINK-ATT. This attribute is 
produced when the Write Block command is used when saving blocks in Fixture Studio. 
It is located at the insertion point of the block, is of very small size and only becomes 
visible after the block is exploded in an AutoCAD floor plan. 

 

This data is used for a number of actions including: 
 Connection Points 

 Fixture Manipulation 

If the XData is absent, this will affect the operation of this functionality in Planner. 

Viewing the XData 
Occasionally it is useful to view the XData (for example when liaising with Oracle 
Support). This can be done as follows in AutoCAD: 

Enter SEQ into the AutoCAD command line. 
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The Command Line will instruct the user to select a block. 

 

On clicking a block, the command line dialog box will appear with the XData visible. 

 

Pressing Return returns the user to the AutoCAD floor plan. 

Using Composites to Rename Blocks 
It is possible to create a composite block that will result in a renamed block being 
inserted into an existing drawing (floor plan) as part of the process required to. This is 
done as follows within AutoCAD: 
1. Within a fixture library take a specific block from the client and explode it. 

2. Select the exploded sub-entities and remake the (child) block with the required 
modified name. 

Note: See the section on repositioning insertion points using 
composites - this task can be carried out at the same time as 
the block is renamed. 

3. Select the recently created block and remake it as another block with the original 
block name. This is the composite (parent) block. 

– The inner (child) block has the modified name. 

– The outer (parent) composite block has the original name. 

This should have resulted in a composite with the following properties that can be seen 
in the schematic diagram below: 
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The block with the red outline is the inner (child) block with the new name. The block 
with the blue outline is the (parent) composite block with the original name. 

As will be described in a later chapter, the child block and parent composite block can 
then both be registered in Fixture Studio. An existing floor plan can then be opened 
(using Store Planner) in the Planner module. The Restructure Drawing facility can then 
be used to: 

1. Redefine Blocks from Disc 

This action will result in the recently created composite (parent) block replacing the 
older client designed block of the same name in the drawing. As the composite block 
has exactly the same insertion point as the older block it is replacing, it will occupy 
exactly the same position in the drawing. 

2. Explode Composites 

This action will result in the composite (parent) block exploding and disappearing. It 
will leave behind (in exactly the same position) the inner (child) block. This block will 
have the modified name. 

Note: For the Explode Composite option to work in 
Restructure Drawing, the block must be set to type 
’Composite’ in the Retail Type drop down list in the 
Category Tab of the Block Details dialog box in Fixture 
Studio. 

After the composite has been exploded, the Synchronization option can be used to 
write the changes back to the database. 

Note: Restructure Drawing and Synchronization are covered 
in more detail in the chapter on converting the client’s 
existing drawings for use in Macro Space Management. 

Correcting Insertion Points using Composite Blocks 

Note: this section will only be of assistance to an experienced 
AutoCAD user. 
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All DWG files have an insertion point. This serves as a datum for when blocks are 
inserted and manipulated within a floor plan. In the example below, the insertion point 
can be seen at bottom, back, left for the fixture block. This is the default position assumed 
by much of the functionality in Macro Space Management and In-Store Space 
Collaboration. 

 

If the insertion point is in another position, for example bottom, front, left, then there 
may be problems with functionality within Macro Space Management and In-Store Space 
Collaboration. For example: 

 Area Calculations may not give the correct results. 

 Product blocks may not place correctly in the Planner module. 
 Shelves may not place correctly in the Merchandiser module without the aid of 

connection points. 

This problem may be corrected as follows: 

1. Within a fixture library take a specific block from the client and explode it. 

2. Select the exploded sub-entities and remake the (child) block with the insertion point 
in the bottom, back, left position using an appropriate block name. 

Note: See the section on renaming blocks using composites - 
this task can be carried out at the same time as insertion 
points are repositioned. 

3. Select the recently created block and remake it as another block with the original 
insertion point and original block name. This is the composite (parent) block. 

This should have resulted in a composite with the following properties: 

– The inner (child) block has an appropriate bottom, back, left insertion point 
and suitable name. 

– The outer (parent) composite block has the original name and insertion 
point. 

This can be seen in the schematic diagram below: 
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The block with the red dotted outline is the inner (child) block with the bottom, back, 
left insertion point. The block with the blue dotted outline is the (parent) composite 
block with a bottom, back, right insertion point. The child block and parent 
composite block can then both be registered in Fixture Studio. An existing floor plan 
can then be opened (using Store Planner) in the Planner module. The Restructure 
Drawing facility can then be used to: 

1. Redefine Blocks from Disc 

This action will result in the recently created composite (parent) block replacing the 
older client designed block of the same name in the drawing. As the composite block 
has exactly the same insertion point as the older block it is replacing, it will occupy 
exactly the same position in the drawing. 

2. Explode Composites 

This action will result in the composite (parent) block exploding and disappearing. It 
will leave behind (in exactly the same position) the inner (child) block. This block will 
have a bottom, back, left insertion position and possibly a different name (perhaps 
one obeying a naming convention). 

Note: For the Explode Composite option to work in 
Restructure Drawing, the block must be set to type 
’Composite’ in the Retail Type drop down list in the 
Category Tab of the Block Details dialog box in Fixture 
Studio. 

After the composite has been exploded, the Synchronization option can be used to 
write the changes back to the database. 

Note: Restructure Drawing and Synchronization are covered 
in more detail elsewhere in this help file. 
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Gondola Hierarchies 

Overview of Gondola Hierarchies 
Gondolas are arranged into a Gondola Hierarchy by means of Gondola Groups. Gondola 
Groups are a way of arranging individual gondolas into sub-sets sharing a common 
characteristic. For example, one group could hold all the gondolas used for chilled food, 
another all the gondolas used for fruit and vegetables. The example below shows the 
Gondola Hierarchy in Fixture Studio. 

 

Gondola Hierarchies have a number of uses within Macro Space Planning: 

1. They make it easier to manually navigate to the required gondola in Fixture Studio. 

2. The same hierarchy also appears in the Object Browser in the Planner and 
Merchandiser modules and in In-Store Space Collaboration. Again, a well designed 
hierarchy makes it easier to manually navigate to the required gondola. 

3. Gondola groups can be used as filters for data in reports - for example from BI 
Publisher. 

Adding, Editing and Deleting Gondola Groups 
Gondolas Groups are used to arrange gondola definitions into logical sub-sets. The 
resulting hierarchy is used in Fixture Studio for maintaining information on the 
equipment used in Macro Space Planning. The hierarchy also appears in the Object 
Browser in the Planner and Merchandiser modules and in In-Store Space Collaboration. 

Groups can be Added, Edited and Deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu). 
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Gondola Group Options 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click Add 
Group. The Group dialogue box will appear. 

 

Enter a description and select an icon from the drop down list. Click OK to conform. The 
group to be added is a child of its selected parent group. 

Edit Group 
To add a group, highlight the group which is to be edited. Click Edit Group. The Group 
dialogue box will appear. 

 

Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details will now be updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click Delete Group. If the Group to 
be deleted has child groups or block definitions, a warning dialogue will appear. 

 

If there are no child objects, the group will be deleted without any requirement for 
confirmation. 
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Basic Concepts for Gondola Creation 

Overview of Gondola Creation and Use 
Gondolas are predefined arrangements of fixtures and fittings that are aligned to each 
other in a precise spatial relationship. This enables long runs of equipment to be placed 
using just a few commands - saving considerable time when creating store plans. In the 
example below, the run of storage racking is configured as a gondola and can be placed 
in four separate sizes in either two or three tiers. 

 

Gondolas are made up of repeating units called bays. A gondola consists of one or more 
bays. Each bay contains a specific arrangement of fixtures and fittings. A bay could be as 
simple as a simple fixture, for example a Chiller unit. 

 

Equally, a bay could be made up multiple components. In the example below, the 
slatwall gondola consists of a number of bays. The first bay has been exploded to show it 
is made up of three components: a leg, slatwall and base. 
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Gondolas are defined in Fixture Studio using the Gondola definition dialog box. 

 

They can then be placed in the Planner and Merchandiser module (and in In-Store Space 
Collaboration) using the Gondola Run dialog box. 
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This dialog box allows this specific gondola to be: 
 Placed in any combination of six lengths and heights. 

 Have optional start and end caps. 

 Have a specific number of bays. 

 Be placed at a specific angle from a specific starting point. 

This makes laying out equipment in a store plan fast and easy. 

Basic Steps in Gondola Creation 
There are a number of basic steps to gondola creation. Some of these steps must be taken 
at the time the fixtures are created; for example deciding on a naming convention. The 
steps are: 

 Decide on and implement a naming convention 

  Import the blocks into Fixture studio (not covered in this section) 

–  Ensure Insertion points are consistently located 
 Assign Gondola Part Types 

 Assign Gondola Sizes 

 Define Gondola 

– Define name, main length and maximum bays 

– Select and assign dimensions 

– Specify the list of parts 

– Define the part details 

– Define the part size position and rotation 

Naming Conventions 
Note: Naming conventions are vital to the efficient operation 
of Macro Space Management. They must be decided upon 
before any blocks are imported into Fixture Studio. 
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Lack of a naming convention will result in users spending large amounts of time creating 
dozens (if not hundreds) of gondolas that could have been defined far more efficiently 
using a naming convention. 

A naming convention is a pre-thought out and logical way of assigning block names. 
If we give blocks names like Widget-187567 and Gizmo-ADRTYN, it is not obvious what 
the blocks or, or what their dimensions are. 

With a well thought out naming convention, things are far simpler. 

 

In the above example, we can see we have three types of block; Back Panels, L shaped 
uprights and T shaped uprights. 

We can also see that the back panels have widths of 600 and 900 mm, and that they have 
heights of 1400, 1600, 2500 and 2900 mm. 
Similarly we can see that both the L and T shaped uprights come in four heights; 1400, 
1600, 2500 and 2900 mm. 

Widget-187567 might well be a back panel of width 600 mm and height 2500 mm, but we 
cannot tell this from the block name. 

Form of Naming Conventions 
Naming conventions are of the general form: Prefix-parameter-parameter-parameter-
suffix. These can be any combination of numbers and letters, together with several 
separating characters. The separating characters can be either a ‘–’, ‘_’ or an ‘x’, so each of 
the naming conventions below are equally valid: 

 Prefix-Parameter-Parameter-Parameter-Suffix 

 Prefix-ParameterxParameterxParameter-Suffix 

 Prefix_ParameterxParameterxParameterxSuffix 
However, the use of naming conventions must be consistent. 

Naming blocks with a mixture of ‘–’, ‘_’ or ‘x’ will lead to errors. 

For example we will have problems if we name blocks as in the example below: 

 Backpanel-600-1400 

 Backpanel-600x1600 

This is because Macro Space Management expects to find the same separating character 
for blocks within a naming convention. 
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When the program draws a gondola, if it expects to see: 

Prefix-Width-Height 

And some of the blocks are named: 

Prefix-WidthxHeight 
It will find blocks with name like Backpanel-600-1400 because these are in the expected 
form. 

It will fail to find blocks with names like Prefix-widthxheight because there is an ‘x’ 
present where MSM expected to find a ‘–’. 

Similarly we must avoid misspellings: 

If we call a block Backpanal-600-1400 rather than Backpanel-600-1400, MSM will fail to 
find the block because we have misspelt Backpanel. 

Note: Always check naming conventions for errors. If you 
have made an error when naming the block, Macro Space 
Management will not find it when drawing the gondola. 

Example Naming Conventions 
The examples below are all valid examples of naming conventions: 

Prefix-Size 
 Leg-1500 

 Leg-2000 
 Leg-2500 

Prefix-WidthxHeight 
 Backpanel-600x1500 

 Backpanel-900x1500 

 Backpanel-1200x1500 

Prefix-Width-Depth-Height 
 FreezerUnit-600-800-300 

 FreezerUnit-600-800-400 

 FreezerUnit-600-1000-500 

Prefix-Width-Depth-Height-Suffix 
 FreezerUnit-600-800-300-Lozier 

 FreezerUnit-600-800-400-Lozier 
 FreezerUnit-600-1000-500-Lozier 

 FreezerUnit-600-800-300-Hoffmann 

 FreezerUnit-600-800-500-Hoffmann 

 FreezerUnit-600-1000-500-Hoffman 

Prefix-Size 
 Podium-Small 

 Podium-Medium 

 Podium-Large 
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In general naming conventions should be specified such that the block name provides all 
the information required. If we take the example of a naming convention of the form: 

Prefix-Width-Depth-Height-Suffix 
Block names of the form allow us to define gondolas so that at the time of addition into 
the Planner or Merchandiser environments we can choose the: 

 Specific type – for example Freezer Units 
 Specific width – for example 600, 800 and 1000 mm 

 Specific depth – for example 800, 1000 and 1200 mm 

 Specific height – for example 400, 500 and 600 mm 

 Manufacturer – for example Lozier 

Note: One well thought out gondola definition could allow 
us to place dozens of different variants of that gondola in 
Planner or Merchandiser. 

Gondola Parts 
Gondolas can be considered to be made up from a number of components. In the 
example below, the gondola is made up of Freezers of type 'Structure' and Condiment 
Cabinets of type 'Bench Mounted'. This information can then be used for reporting 
purposes. 

 

These reporting types can be defined in the Gondola Parts dialogue box. This is accessed 
from the Gondola Parts icon on the toolbar. 

 

This will bring up the Gondola Parts dialogue box. 
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Gondola parts can be added by typing entries into the top row and pressing Return. 

Note: Entries are only written to the database on pressing 
Return. 

Gondola parts can be deleted by highlight the pertinent entry and pressing Delete. 

These part types will then be available in the Type drop down list of the Details sub-tab 
of the Parts tab of the Gondola Definition dialog box. 

 

Mapping Gondola Parts 
Sometimes a client has an existing fixture library where the block names do not conform 
to a naming convention. Gondolas require blocks with naming conventions. Mapping 
Gondola Parts is initiated from the toolbar. 

 

Alternatively, it can be initiated from the Mapping button of the Details sub-tab of the 
Parts tab of the Gondola Definition dialog box. 
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This will bring up the Gondola Block Mapping dialog box. 

 

If initiated from the toolbar, the naming convention must be typed in. If initiated from 
the Gondola definitions dialog box, the possible naming conventions will already be 
populated. The block name can then be typed in. In addition, if the block needs to be 
given a rotation during insertion of the gondola, this angle can be specified. Press Return 
after each line to ensure the information will be written back to the database. 

Note: This functionality in not currently working correctly.   

Assigning Gondola Sizes 
The parts that make up a gondola run come in specific sizes. The possible sizes for 
specific gondola dimensions are entered in the Gondola Sizes dialogue box. This is 
accessed by clicking on the Gondola Sizes icon on the toolbar. 

 

This will bring up the Gondola Sizes dialogue box. 
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Dimensions can be added on the left hand size by clicking the Add Size icon. Data can 
then be entered on the right. 

 Size is the physical size that will be used for calculation purposes by Macro 
Space Planning when drawing the bay. In the above example, the bays are 6 
inches longer than the size of the main part for the bay. 

 Description is the text that will appear in the Add Gondola dialog box in the 
Planner and Merchandiser module (and in In-Store Space Collaboration). In the 
above example the description is in feet, which is easier for users to select than if 
the dimension were in inches. 

 Name is the text that will be matched to the block name. In the above example 
the '72' name will eventually be matched up to the pertinent part of the 
I_HDR_Beam_72x1-5x4 block name that will be used to draw the gondola. 

Note: Entries are only written to the database on pressing 
Return. 

Once assigned to a gondola definition, Gondola sizes become available for selection in 
the Add Gondola dialog box in the Planner and Merchandiser module (and in In-Store 
Space Collaboration). 
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Gondola Definitions - the Dimensions Tab 
The Dimensions Tab is primarily used to specify the name and the dimensions used in 
the gondola. 

 

Options 

Name and Description 
The Name must be unique within the Macro Space Planning database. The Description 
can be used to give more information as to the gondola definition if required. 

Main Length 
If set to 0, the main length will be set automatically based on the dimension selected 
when the gondola is placed in a floor plan. If the main length is set to any positive value, 
then each bay in the gondola will be that single, fixed length. 

Max Bays 
If set to 0, then the number of bays that can be placed in a floor plan is unlimited. If set to 
a positive number, this will limit the number of bays that can be placed when the 
gondola is added to a floor plan. 

Dimensions 
The list of available dimensions is available in the left hand pane. These are configured in 
the Gondola sizes dialog box that can be accessed from the toolbar. They can be selected 
for use by double clicking in the left hand pane - they will then appear in the right hand 
pane. 

 Size Range is the name of the size range. It cannot be edited. 
 Label is the title given to the dimension in the Add Gondola dialog box that is 

used to place gondolas in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. This enables the dimension name to be modified to make it 
easy for store planners. 
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 Suffix is used in building up the block name when the gondola is placed in a 
store plan. This is discussed in more detail in the section on the Parts tab. 

 Name Order is used in building up the block name when the gondola is placed 
in a store plan. This is discussed in more detail in the section on the Parts tab. 

Note: Because of problems with the way Name Order 
currently works, it is recommended that the dimensions are 
selected in the sequence that will be used. 

 Main is the dimension used to specify the length of the bay when the gondola is 
placed in a store plan. Only one dimension can be designated as main. 

Note: There should always be a 'Main' dimension specified 
unless the Main Length text box has a value specified. 

Defining the Part Details 

Gondola Definitions: Parts Tab - Details 
The Details sub-tab of the Parts tab enables users to set up a list of gondola parts, define 
some rules as to how the blocks used to draw the gondola in a floor plan will be 
identified and specify the gondola bays that part will be used in. 
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Parts 
Names for specific parts within a gondola are entered by typing a name in the text box at 
the top off the Parts frame and pressing Return. 

 

Parts can be deleted by highlighting them in the list then pressing Delete. Highlighting a 
gondola part also makes it available for editing. 

Block Names 
Two part of the Parts Tab/Details sub-tab are used to create a series of rules used to 
determine the name of the block used to create that part of the gondola. 
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 Type - this is selected from a drop down list and is used for reporting purposes. 
The drop down list is configured using the Gondola Parts option on the toolbar. 

 Description - this is the part name. It is echoed across from the left hand pane 
holding the list of part names. 

 Prefix - this will become the first part of the block name used to draw the 
gondola when it is placed in a floor plan. All blocks used to draw this gondola 
part will start I_BR__Slatwall_ 

 Suffix - this will be the concluding part of the block name. Suffixes like _Wood or 
_Red could be used to specify particular types of blocks. 

 Optional - this option allows users to specify whether a part is optional or not. It 
is activated by typing the name of the optional part in to replace the <no> option. 

 

The part can then be selected or de-selected by means of the check boxes in the Add 
Gondola dialog box when the gondola is added in the Planner and Merchandiser 
modules or in In-Store Space Collaboration. 

 

 Bay Group - this functionality has not been implemented. 

 Report Group - this functionality has not been implemented. 

 Name Dependency - this is used to specify the Dimensions to use when 
determining the block name. 

 Mapping Button - this serves two purposes: 
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– It can be used to bring up a list of all possible combinations of block names 
defined for the part. This is useful in seeing if the details have been 
configured properly. 

– It can be used to map names from a naming convention (such as 
I_Backpanel_36x1x72) to non-systematic block names such as ABC123. 

 Include If 

Include if specified which bays the part will be associated with. 

 

 First Bay - if checked, the parts will be drawn in the first bay. 

 Middle Bay - if checked, the part will be placed in all bays except the First and 
Last bays 

 Last Bay - if checked, the parts will be drawn in the last bay. 

 Odd Bay - if checked, there parts will be placed in all odd numbered bays. 

 Even Bay - if checked, there parts will be placed in all even numbered bays. 

These can be used in combination. In the example below, the gondola has been 
configured to place a chiller unit in the odd numbered bays and a freezer unit and 
condiment cabinet in the even numbered bays. 

 

Building Up Block Names 
When a gondola is placed in the Planner or Merchandiser modules, it relies on using a 
DWG or 3DS file to represent the gondola. In order to find the required file Macro Space 
Planning reconstructs the block name from selections made in the Add Gondola dialog 
box and information in the Gondola definitions dialog box. This process will be followed 
for every part in the gondola. 

Steps to Build Up block Names 

Add Gondola dialog box 
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The starting point for placing a gondola is the Add Gondola dialog box. Here the user 
selects the required dimensions. In this example, there are three; Racking Length, 
Racking Depth and Racking Height. Values of 48 inches, 24 inches and 96 inches have 
been selected. On clicking the OK button, the application starts to reference information 
in the Gondola Definitions dialog box. 

 

Gondola Definitions dialog box - Prefix 
The next stage is derived from the Parts sub-tab of the Details tab of the Gondola 
Definitions dialog box. The Prefix (if any) is selected and becomes the first part of the 
block name. In this case it is I_BR_Fixture_. 

  

 

Gondola Definitions dialog box - Name Dependencies 
The next stage in building up the block names depends on the selected Name 
Dependencies. 

 

These Name Dependencies are then used in Name Order sequence. 
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 The starting point for the block name is the suffix: I_BR_Fixture_. 

 The first name dependency is Racking Length. This was selected as being 48 
inches, so a value of 48 is added to the suffix, together with the Suffix for Racking 
Length. This modifies the block name to I_BR_Fixture_48x. 

 The next name dependency is Racking Depth. This was selected as being 25 
inches, so a value of 24 is added to the block name, together with the Suffix for 
Racking Depth. This modifies the block name to I_BR_Fixture_48x24x. 

 The final name dependency is Racking Depth. This was selected as being 25 
inches, so a value of 96 is added to the block name. There is no Suffix for Racking 
Depth. This modifies the block name to I_BR_Fixture_48x24x96. 

Note: see the section on Assigning Gondola Sizes for more 
information on how Name dependencies/Dimensions are 
configured. 

Gondola Definitions dialog box - Suffix 
The final part of the block name is derived from the Parts sub-tab of the Details tab of 
the Gondola Definitions dialog box. The Suffix (if any) is selected and becomes the last 
part of the block name. 

 

In this example, there is no suffix - and hence nothing to be added to the block name. (If 
the suffix had been _Steel, the result would have been I_BR_Fixture_48x24x96_Steel). 

Selecting the Block 
The final block name is I_BR_Fixture_48x24x96. The functionality identifies that block 
name in the fixture hierarchy and places it. 
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Note: if the result of the above calculations is a block name 
that does not exist, the gondola will error when an attempt is 
made to place it in the Planner or Merchandiser modules or 
in In-Store Space Collaboration. 

Specifying Part Size, Position and Rotation 

Specifying Size, Position and Rotation 
A gondola can contain a wide variety of parts. These have to be orientated relative to the 
base point of the bay and rotated relative to the initial insertion position of the block. This 
information is entered in the Size, Position and Rotation Tab 

 

Stretchable Blocks 
The top section of the sub-tab specifies the dimensional offsets for stretchable block. 
Blocks are made stretchable by assigning a size to them in the Sizes tab of the Block 
Definition dialog box. 

 

Fixed Size Blocks 
The top section of the sub-tab specifies the dimensional offsets for blocks of fixed size. 
These are blocks that have a single fixed size assigned to them in the Sizes tab of the 
Block Definition dialog box. 
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Block Rotations 
The bottom section of the sub-tab gives the rotation required to orientate each part within 
the gondola. Sections of the gondola such as the back and the start and end caps 
generally require a rotation. 

Note: rotations are normally in the Z (Vertical) plane. It is 
unusual to rotate on the X or Y planes. 

Baselines and Base Points 
When configuring a gondola it can be considered as having fixtures placed along an 
imaginary baseline. Each point along the baseline is the origin for a specific bay. 

 

If there are multiple parts within a bay, all are associated with that base point. 
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In the above plan view, the two 'L' legs and fixture making up the start cap of a gondola, 
together with the 'T' leg and two fixtures are all associated with the first base point. Many 
of the parts have been given differing offsets and rotations so they draw in the correct 
position when the gondola is placed. The start cap and first few bays of the gondola are 
seen below. 

 

All parts are rotated and offset relative to their insertion point. In the example below, the 
insertion point (represented by a red circle) is situated at bottom-back-left of the fixture. 
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Sizes of Gondola Parts 
The distance between base points is determined by the main dimension of the gondola. 

 

If a part to be used in the gondola is a fraction of the distance between base points, this 
can be specified in the Gondola Definition dialogue box. For example, if we wished to 
place a shelf half the length of the bay, we could specify that we would match the main 
dimension and use a size of half of it. 

  

Rotations of Gondola Parts 
All fixtures and fittings have a designated front direction. This is normally set to point 
down the drawing when they are inserted. 
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When a gondola is created, some of the parts (Start Cap, Back and End Cap) need to have 
their components rotated so that the front of those parts is facing in the right direction 
when the gondola is drawn. 

 

 
If we wanted to add a part to the End Cap, we would specify a 90 degree rotation in the 
Gondola Definition dialogue box. 
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Rotation and Offsetting of Gondola Parts 
When a gondola component is rotated to get it into the correct orientation, it is rotated 
around its insertion point. 

 

In the case of a component to be used for the back of the gondola, it is rotated through 
180 degrees. 

Because it rotates around the insertion point its position changes. In the above example, 
we can see that the component to be used for the back of the gondola has been displaced 
to the left during the rotation. 

We therefore have to apply an offset to get it back into its intended position. 

These offsets will vary depending on which part of the gondola is being defined. 
Note that all offsets are relative to the un-rotated orientation of the block. 

 Offsets in the X axis are relative to length 

 Offsets in the Y axis are relative to depth 

 Offsets in the Z axis are relative to height 

Required Offsets 

Side 
The sides of a gondola do not require any rotations or systematic offsets. 

Back 
The Back of the gondola is rotated through 180 degrees to get the front facing in the 
correct direction. 

 

It then needs a positive offset equal to the width of the block. 
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Start Cap 
The Start Cap is rotated through 270 degrees to get the front facing in the correct 
direction. 

 

It then needs a positive offset equal to half of the width of the block. 

 

End Cap 
The End Cap is rotated through 90 degrees to get the front facing in the correct direction. 

 

It then requires two offsets to get it into the correct final position. 
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Firstly, it requires a positive offset equal to the width of the Side component of the 
gondola to move it to the right. 

Then it requires a negative offset of half its width to move it the correct distance down. 
(The negative offset is to move the block down, as opposed to up). 
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Gondola Details 
This worked example will show how to create a simple gondola. 

 

It is made up of four parts: front, back, start cap (optional) and end cap (optional). These 
are defined in the Gondola Definition dialog box in Fixture Studio. 

 

After definition in the Fixture Studio module, it can be placed using any combination of 
two lengths, two depths or three heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration. 
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Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part after it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a temporary floor plan open in the Planner module. The required sequence of 
actions is: 

1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Creating the Gondola Sizes 
In order to create the Gondola Sizes, we must first analyze the dimensions of the fixtures 
and fixtures and fittings that will be used to make up the gondola. In this example, the 
gondola will be formed from metal uprights. These follow a naming convention of Block 
Name_LengthxDepthxHeight, enabling the sizes to be easily determined. 
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Looking at the list, it is possible to identify the dimensions required. 

Dimension Values 

Length 36 and 48 inches 

Depth 24 and 30 inches 

Height 72, 84 and 96 inches. 

The Size option can then be selected from the toolbar. 

 

The values can then be entered into the Gondola Sizes dialog box. 

 

The sizes will then be available for selection in the Add Gondola dialog box when a 
gondola is placed in Planner, Merchandiser or in In-Store Space Collaboration. 
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Creating the Basic Information 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 

 

This will bring up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 
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Gondola Options 

Name and Description 
The name and description are entered as Basic Double Sided Metal upright. This is the 
title that the user will see in the Planner and Merchandiser modules and in In-Store Space 
collaboration. 

Main Length and Max Bays 
These are left at the default of 0. Main length would have been set to a positive value if 
there was only one option for the length of the gondola bay. May Bays would have been 
set to a limiting value if it was desired to set a maximum number for the bays to be 
placed. 

Dimensions 
Dimensions are selected from the list in the left hand pane by double clicking them. They 
are selected in the sequence they will be used in building up the block names when the 
gondola is drawn. The Metal Upright Length has been selected as the main dimensions - 
the value selected when adding a gondola into a floor plan will define the length of the 
bay drawn. As the blocks use a naming convention of Block 
Name_LengthxDepthxHeight suffixes of 'x' have been added for the Length and Depth 
to ensure the block name is calculated correctly. 

Creating the Front 
The first part of the gondola to be created is the front. This is shown in blue in plan and 
perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Gondola Details 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab will become active. 

Type 
Structure has been selected from the predefined drop down list. 
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Description 
This is identical to the text typed into the Parts text box. 

Prefix 
This is the first part of the bock name that will be used to draw this specific part of the 
gondola. The naming convention for the block name is of the form Block 
Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered into the Prefix 
field. 

Include If: 
This option determines which bays the part will be drawn in. It will be drawn in all bays, 
so all options are checked. 

Name Dependency 
This determines what dimensions are going to be used in building up the block name. As 
the block name includes Length, Depth and Height, all three dependencies are checked. 

Mapping Option 
It is good practice to confirm the block names required to draw the gondola will be 
recreated correctly. This can be done by clicking the Mapping button.   

 

 This confirms that the block names generated by the gondola functionality conform to 
those which are present in the database. 

Creating the Back 
The next part of the gondola to be created is the back. This is shown in blue in plan and 
perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Gondola Details 

Part Name 
This is generated by typing Back into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab will become active. 
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Other Settings 
All other settings in the Details sub-tab are the same as for the Front settings. Other 
settings are required in the Size, Position & Rotation sub-tab. 

 

 When the parts for the back are placed, they will initially be placed in the default 
position (green fixture). They then require a combination of a 180o rotation (blue fixture) 
and an offset to move it into position (red fixture) behind the equivalent front fixture. 

 

Rotation 
The rotation is 180o around the Z (vertical) axis. 
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Offset 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Length (X Axis) offset is set to "Offset by Metal Upright Length" 
from the drop down list. If the user selects 3 ft long fixtures, the offset will be three feet, if 
the user selects 4 ft long fixtures, the offset will be four feet. 

Creating the Start Cap 
The next part of the gondola to be created is the start cap. This is shown in blue in plan 
and perspective in the diagram below. 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 
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Gondola Details 

Part Name 
This is generated by typing Start Cap into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab will become active. 

Include If 
The Start Cap is only present in the first bay. Accordingly only the First Bay option is 
checked. 

Optional 
Because the Start Cap does not have to be present, it can be made option by typing Start 
Cap in place of the default <no> in the Optional text box. 

Other Settings 
All other settings in the Details sub-tab are the same as for the Front settings. Other 
settings are required in the Size, Position & Rotation sub-tab. 

 

 When the parts for the start cap are placed, they will initially be placed in the default 
position (green fixture). They then require a combination of a 270o rotation (blue fixture) 
and an offset to move it into position (red fixture) relative to the front fixture in the first 
bay. 
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Rotation 
The rotation is 270o around the Z (vertical) axis. 

Offset 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Depth offset (Y Axis) is set to "Offset by Metal Upright Length" 
from the drop down list. The Scale Factor is set to 0.5. This means the fixture will be 
moved along by a distance equivalent to half its length. If the user selects 3 ft long 
fixtures, the offset will be 18 inches; if the user selects 4 ft long fixtures, the offset will be 
two feet. 

Creating the End Cap 
The final part of the gondola to be created is the end cap. This is shown in blue in plan 
and perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Gondola Details 

Part Name 
This is generated by typing End Cap into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab will become active. 

Include If 
The End Cap is only present in the last bay. Accordingly the Last Bay option is checked. 
Because the gondola can contain any number of bays, both the Odd Bay and Even Bay 
check boxes are ticked to ensure the End Bay is present for gondolas with both an odd 
and an even number of bays. 

Optional 
Because the End Cap does not have to be present, it can be made option by typing End 
Cap in place of the default <no> in the Optional text box. 

Other Settings 
All other settings in the Details sub-tab are the same as for the Front settings. Other 
settings are required in the Size, Position & Rotation sub-tab. 
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 When the parts for the end are placed, they will initially be placed in the default position 
(green fixture). They then require a combination of a 90o rotation (blue fixture) and two 
offsets to move it into position (red fixture) relative to the front fixture in the last bay. 

 

Rotation 
The rotation is 90o around the Z (vertical) axis. 
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Offset 
Two offsets are required; one to move the fixture from the beginning of the last bay to the 
other side and one to adjust its position so that it is centered between the front and back 
(not shown) fixtures. 

1. Offset for Length 

Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Length (X Axis) offset is set to "Offset by Metal Upright 
Length" from the drop down list. If the user selects 3 feet long fixtures, the offset will 
be three feet, if the user selects 4 feet long fixtures, the offset will be four feet. 

2. Offset for Depth 

Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Depth offset (Y Axis) is set to "Offset by Metal Upright Length" 
from the drop down list. The Scale Factor is set to -0.5. This means the fixture will be 
moved along by a distance equivalent to half its length - and because the offset is 
negative, the fixture will be moved along the -Y axis. If the user selects 3 feet long 
fixtures, the offset will be 18 inches; if the user selects 4 feet long fixtures, the offset 
will be two feet. 

Saving the Gondola 

Saving the Gondola in Fixture Studio 
The gondola can be saved in Fixture Studio as follows: 
1. Click the OK button on the Gondola Definition dialog box - this saves the 

information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

Updating Gondola Definitions in Planner and Merchandiser 
If either the Planner or Merchandiser modules are open when a Gondola is being defined 
or updated in Fixture Studio, the definition must be updated in the Planner or 
Merchandiser modules before it can be used. The steps are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

Updating Gondola Definitions in In-Store Space Collaboration 
If In-Store Space collaboration is open when a Gondola is being defined or updated in 
Fixture Studio, the definition must be updated in ISSC before it can be used. The steps 
are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Use the Refresh option in the In-Store Space Collaboration toolbar to load the latest 
changes. 
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Stretchable Gondola Details 
Note: Please refer to the worked example on how to create a 
fixed size gondola. It provides information that is necessary 
to understanding this example. 

This worked example will show how to create a stretchable gondola. It uses two parts - a 
stretchable leg and a stretchable fixture. Each bay consists of a leg and a fixture, except 
the end bay which has an additional leg. 

 

These are defined in the Gondola Definition dialog box in Fixture Studio. 
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After definition in the Fixture Studio module, it can be placed using any combination of 
eleven lengths, five depths or nine heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration. This allows a gondola to be place using any one of 495 
combinations of length, depth and height using only two basic fixtures. This makes this 
method economical in terms of creating fixtures, but requires care when reporting bills of 
materials for a floor plan. 

 

Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part after it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a temporary floor plan open in the Planner module. The required sequence of 
actions is: 

1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Assigning Sizes to the Stretchable Blocks 
Stretchable gondolas use blocks that can have their sizes determined upon insertion into 
a floor plan. Sizes are assigned to blocks by selecting the Edit Sizes option from the Edit 
menu. 
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This in turn brings up the Sizes dialog box. 

 

Specific sizes can then be defined in the Size dialog box. 

 

These Sizes can then be assigned to specific blocks in the Sizes tab of the block Details 
dialog box. 
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Creating the Stretchable Gondola Sizes 
In order to create the Gondola Sizes, we must first analyze the dimensions of the fixtures 
and fixtures and fittings that will be used to make up the gondola. In this example, the 
gondola will be formed from stretchable blocks. Because the blocks are stretchable, for 
this gondola, we only need two blocks. 

 

The dimensions required for the Gondola sizes are those defined in the Sizes dialog box 
accessed from the Edit menu. 

 

Once the sizes are known, the Size option can then be selected from the toolbar. 

 

The values can then be entered into the Gondola Sizes dialog box. The options should 
match those in the Size dialog box. 
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This is the same process as for creating sizes for gondolas used for blocks of fixed 
dimensions. The differences arise when the sizes are used in the Gondola Definition 
dialog box. 

Creating the Basic Information for the Stretchable Gondola 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 

 

This will bring up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 
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Gondola Details 

Name and Description 
The name and description are entered as Stretchable Gondola. This is the title that the 
user will see in the Planner and Merchandiser modules and in In-Store Space 
collaboration. 

Main Length and Max Bays 
These are left at the default of 0. Main length must be set to 0 for stretchable gondolas. 
Max Bays would have been set to a limiting value if it was desired to set a maximum 
number for the bays to be placed. 

Dimensions 
Dimensions are selected from the list in the left hand pane by double clicking them. They 
are selected in the sequence they will be used in building up the block names when the 
gondola is drawn. The Stretch Racking Length has been selected as the main dimension - 
the value selected when adding a gondola into a floor plan will define the length of the 
bay drawn. No suffixes are required for stretchable blocks. 

Creating the Stretchable Gondola Leg 
The first part of the gondola to be created is the leg. This will appear at the beginning of 
each bay. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Gondola Details 

Part Name 
This is generated by typing Leg into the Parts text box and pressing Return. On 
highlighting Leg in the list of parts, the Details sub-tab will become active. 

Type 
Leg has been selected from the predefined drop down list. 
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Description 
This is identical to the text typed into the Parts text box. 

Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box 

Include If: 
This option determines which bays the part will be drawn in. It will be drawn in all bays, 
so all options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies - accordingly none of the options 
should be checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. Other settings are required 
in the Size, Position & Rotation sub-tab. 

 

These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 
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 The length (width) of the leg has been specified as one inch. 

 The depth has been specified in increments of 6 inches as variable between 24 
and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

The dimensions the leg may take up are set in the top part of the Size, Position & 
Rotation sub-tab. 

 The length has been fixed at 1 inch, so is not specified. 

 The depth is set to Match Stretchable Racking Depth - this will result in the leg 
being able to take up the dimensions specified for the Stretchable Racking Depth 
dimension. 

 The height is set to Match Stretchable Racking height - this will result in the leg 
being able to take up the dimensions specified for the Stretchable Racking Height 
dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the leg 
into the correct position. The leg is 1 inch in length (width) and the insertion point is set 
to bottom back middle. 
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As we want the bottom-back-left corner of the leg to be the start position of the bay, the 
leg is given a positive offset of 0.5 inches in the X axis. 

Creating the Stretchable Gondola Front 
The first part of the gondola to be created is the front. This will appear in each bay. 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 
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Gondola Details 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab will become active. 

Type 
Leg has been selected from the predefined drop down list. 

Description 
This is identical to the text typed into the Parts text box. 

Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box 

Include If: 
This option determines which bays the part will be drawn in. It will be drawn in all bays, 
so all options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies - accordingly none of the options 
should be checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. Other settings are required 
in the Size, Position & Rotation sub-tab. 
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These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 

 

 The length has been specified in increments of 6 inches as variable between 24 
and 84 inches. 

 The depth has been specified in increments of 6 inches as variable between 24 
and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

The dimensions the leg may take up are set in the top part of the Size, Position & 
Rotation sub-tab. 

– The length is set to Match Stretchable Racking Length - this will result in the 
front being able to take up the dimensions specified for the Stretchable 
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Racking Length dimension. Because the length of the front needs to be 1 inch 
less than the length of the bay (to allow for the leg), a delta value of -1 has 
been entered. 

– The depth is set to Match Stretchable Racking Depth - this will result in the 
front being able to take up the dimensions specified for the Stretchable 
Racking Depth dimension. 

– The height is set to Match Stretchable Racking height - this will result in the 
front being able to take up the dimensions specified for the Stretchable 
Racking Height dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the 
front into the correct position. The leg is 1 inch in length (width). 

 
 The insertion point of the fixture is set to bottom-back-left. As we want the bottom-back-
left corner of the fixture to be alongside the bottom-back-right corner of the left that starts 
the bay, the front is given a positive offset of 1.0 inches in the X axis. 

Creating the Stretchable Gondola End Leg 
The last part of the gondola to be created is the end leg. This will only appear on the end 
of the last bay. 
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 Stretchable Gondola Creation Example 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Gondola Details 

Part Name 
This is generated by typing End Leg into the Parts text box and pressing Return. On 
highlighting End Leg in the list of parts, the Details sub-tab will become active. 

Type 
Leg has been selected from the predefined drop down list. 
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Description 
This is identical to the text typed into the Parts text box. 

Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box 

Include If: 
This option determines which bays the part will be drawn in. It will only be drawn in all 
bays, so the last bay and odd and even bay options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies - accordingly none of the options 
should be checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. Other settings are required 
in the Size, Position & Rotation sub-tab. 

 

These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 
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 Stretchable Gondola Creation Example 

 

 The length (width) of the leg has been specified as one inch. 

 The depth has been specified in increments of 6 inches as variable between 24 
and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

The dimensions the leg may take up are set in the top part of the Size, Position & 
Rotation sub-tab. 

 The length has been fixed at 1 inch, so is not specified. 

 The depth is set to Match Stretchable Racking Depth - this will result in the leg 
being able to take up the dimensions specified for the Stretchable Racking Depth 
dimension. 

 The height is set to Match Stretchable Racking height - this will result in the leg 
being able to take up the dimensions specified for the Stretchable Racking Height 
dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the 
front into the correct position. The leg is 1 inch in length (width). 
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 The end leg has to be moved to the right hand side of the 'front' part of the bay. To do 
this, it is given an offset of 'Offset by Stretch Racking Length'. The insertion point of the 
fixture is set to bottom-back-middle. As we want the bottom-back-left corner of the leg to 
be alongside the bottom-back-right corner of the left that starts the bay, the front is also 
given a positive offset of 0.5 inches in the X axis. 
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